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2 WHAT MAKES YOUR MACINTOSH SPECIAL 

The Apple Macintosh computer is a revolutionary product. It is easier to 
learn to use than other computers, and its application programs can be used 
together more easily and more productively. It is b y far the best modera tely 
priced computer for producing presenta tion-quality printed materials. Your 
Mac lets you directly manipulate information- particularly non- verbal infor
mation- more directly than is possible with any other personal computer. 
These are some of the reasons you bought a Macintosh. This book w ill help 
you get the most from your Mac b y showing you how to use APPLICATIONS
major programs- effec tively. 

SPECIAL FEATURES OF THE MAC 

Some of the characteristics that make the Apple Macintosh special are ob vious 
when you look at the machine. Others become appa rent only when you see it 
being used or, better yet, use it yourself. The Macintosh provides a 
combination of p owerful hardware and software features, carefull y inte
grated to contribute to the productive use of the machine. 

H ARDWA RE is the physical, touchable elements of a com puter, such as the 
central processing unit (CPU )-a single large integra ted circuit that executes 
all the instructions. Other hardware elements include the Random Access 
Memory (RAM) chips and their supporting circuits, as well as the mouse, the 
disk drive, and the screen. SOFTWARE means the programs and data tha t make 
the Mac do everything it does. Some software is always present in the Mac, 
hidden in special chips called ROtvf (Read-Only Memory) chips. The 
software stored in ROM is sometimes called FIRMWA RE to distinguish it from 
the rest of the Mac's software, which is stored on disks. 

The innovative use of RO M in the Macintosh contributes to the Mac's 
success in two w ays. Firs t, it is extremely efficient. This means tha t the 
program code in RO M runs very quickly. This is an important part of the 
reason for the Mac's very good graphics display speed . Second, the lac ROM 
contains a natural and easily learned USER INTERFACE, a set of consistent 
methods for le tting users interact \vith applications programs. The l'vfac's user 
interface includes the use of sim ple pictures to represent user -selectable items, 
descriptive menus for command choices, and simple interactive dialog boxes. 
These methods are natural and easy to learn . Because the user interface is in 
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ROM, virtually a ll Mac applications use it. Macintosh users d on't have to learn 
a completely new style of interacting with their machine when they start using 
a new program . T heir .\tfac -using skills carry over to every a pplication. 

The Macintosh uses ha rdware that is unusually powerful for a modera tely 
p riced personal com p uter, and all its software-including the major applica
tions and the underlying ROM routines-is d esigned to fully exploit tha t 
power. T he Mac's combination of hardware and software power provides 
four benefits to users. 

1. T he graphics basis of the Macintosh makes it possible for the user to 
achieve d etailed control of the screen and the p rintouts in ways that 
were not possible before. With the Mac, you can easily mix text and 
graphics on the screen, just as they will be printed . You can even 
compose tex t d ocuments tha t use many different character sizes and 
fo nts. 

2. It is easy to lea rn to use. T his is tr ue in part because the way users 
interact with applications is very natural, and in part because almost 
all a pplica tions use the same interaction methods. 

3. It le ts experts get the most from the system without being slowed 
down by methods d esigned for beginners. 

4. It p rovides an INTECHATED Ef\:VIHONME!'\T-material created with each 
application can be used in most other applica tions. 

O ne of the most apparent characteristics of the Macintosh is its mouse. T he 
Mac was the first computer in the personal price range to offer a mouse as 
standard equipment. About the size of a b ar of soap, the mouse sits on your 
desk near the com puter. As you slide it around in a small area near the Mac, a 
small symbol called the pointer- usually a slanted arrow- moves corre
spondingly on the screen. You move the mouse to point to elements on the 
screen. 

If you are a Macintosh user, you are probably already familiar with the 
uses of the mouse. If you are new to the Macintosh, turn to the Appendix, 
"J'vl ouse Skills," for an introduction and a few advanced tips on using the 
mouse. 

A second important feature of the Macintosh is its transportability. Some 
other portable computers are signifi cantly smaller and more portable than the 
.VIae. But no portable computer before the Mac offered such a sophistica ted 
w ay of interacting with the user. 
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No other transportable computer offers the powerful internal hardware 
and software that the Mac does. The Mac uses a very advanced central 
processing unit, the Motorola 68000 chip. This processing unit runs more 
quickly than many others, and it can work with larger amounts of data at one 
time. Therefore, the 68000 can do more in the same time than less p owerful 
processors. In practical terms, this means that the Mac's CPU has sufficient 
power to support a sophisticated user interface without running more slowly 
than computers that use more primitive ways of interacting with users. 

A number of other computers use the same 68000 processor in systems 
that support use by more than one user at a time. All the users have separa te 
terminals, which are connected to the computer with cables. In those 
systems-which can cost more than ten times as much as a Macintosh-each 
user must share the single 68000 processor with all the other users on the 
system. The Mac d evotes all the power of the 68000 to one user. 

A personal computer should be portable. People don't ordinarily want to 
do all their computer use at only one location. Normally, achieving the 
smallness and lightness needed for portability can be expected to result in 
sacrifices in performance. The Macintosh has avoided almost all such 
compromises by using one of the most powerful processors available, b y 
providing enough memory-including n OM chips with software that usually 
takes up RAM space in other machines-and by using a smaller and higher
capacity disk drive than normal. 

A single-sided 3}~ - inch Macintosh floppy disk can hold more information 
than most 5~~-inch disks. Yet the Mac's 3J~-inch drive mechanism itself weighs 
only a fraction of the 5J~-inch disk drive. This weight saving helps to make the 
Mac compact and portable. 

The size of the base of a computer is called its "footprint." The Mac's 
small footprint is another bonus. Before the Macintosh, "desktop computers" 
required desks of their own. Adding an ordinary personal computer to an 
office meant adding furniture just for the computer. Because the main case of 
the Mac takes only 10-by-10 inches of desktop, it should fit easily into your 
work space. 

When you turn on the Macintosh, a number of special fea tures b ecome 
obvious. The first such feature is the high-resolution display. The Mac's 
graphic display was a real breakthrough in moderately priced computing. The 
use of a black-on-white display makes the Mac much easier on the eyes than 
other computers that use green-on-black or amber-on-black screens. The 
high resolution of the display was another step forward. The Mac display is 
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512 dots across and 342 vertically. T o ge t an idea of how much m ore resolution 
this provides than a traditional microcomputer, take a look at the Mac's screen 
in the T ransylvania game from Penguin Software (Figure I.l) . 

This game was adapted from one developed for the Apple II line of 
computers. On the Apple II, the entire screen was filled with the picture shown 
in the upper left corner of the Mac's display. The Macintosh provides more 
than three times as many viewable dots, or PIXELS, as did the Apple II. 

The Macintosh display resolution appears even greater than its 512-b y-
342 dots. One reason for this is that the monitor paints each pixel with 
exceptional precision. Another is that each pixel is square in shape, rather than 
rectangular, as with most o ther computers. In addition, the monitor refreshes 
the entire screen six ty times p er second, rather than only thirty, as is more 
common for high-resolution displays. 
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Another special Macintosh feature is windowing. A WI ·oow is a rect
angular area of the screen that presents information from some source, 
such as an application. Because several windows can be open at the same time, 
you can keep material from several different sources on the screen at the same 
time. For example, you can keep material from the Scrapbook on the screen at 
the same time tha t you edit a memo using the MacWrite word processor 
(Figure I.2). The MacWrite window can be positioned low on the screen, 
leaving room to display a Scrapbook page above. In this case, the material 
displayed in the Scrapbook window was created with a different app lica tion, 
MacPaint. Window manipula tions are described in the Appendix, "Mouse 
Skills." 

The Macintosh provides a set of "Desktop Accessories," each of which 
can be used to add another active window to a display. Normally an office 
desk might have on it a calculator, a digital clock, a notepad , and other 
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accessories. The Mac provides simple programs, the Desktop Accessories, 
that replicate these functions (Figure 1.3). The Desktop Accessories are 
available from the first menu, the Apple menu. For example, while you are 
writing with MacWrite, you can bring up the Calculator to make a quick 
computation needed for a memo. After you've calculated the answer, you can 
paste it into the text. 

Some of the special features of the .tvlacintosh become apparent only 
through use. Those who have used other personal computers will appreciate 
how much easier it is to get things done with the Mac. It is especially pleasant 
to find a user interface that remains consistent across a variety of applications 
programs. If you have never used another computer, you will probably 
wonder why so many people seem to make such a big deal about using 
personal computers. It's just not very hard with the Mac. 

With the Macintosh, you can draw a picture on the screen using MacPaint 
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and save it on a disk. Later, you can write a memo using the application 
program called Mac Write and add the saved drawing to the text. The memo, 
with its sketch, will appear on the screen just as it looks when printed out. With 
most other personal computers, there is no way to add a picture created with 
one program to text made with a different program. The user has to print them 
out separately-if there is any way to print the graphics-and then put the two 
printouts together with scissors and paste. 

The Macintosh Clipboard makes it possible to move material created 
with one application program into another program. You can cut or copy 
material in the first application, which places a copy of the material on the 
Mac's Clipboard-a storage area reserved fo r passing information between 
applications. Then you can paste the contents of the Clipboard when using 
another application. The cut, copy, and paste features make the Mac an 
integrated environment, since its major applications can share data. 

Most of the Macintosh's advanced user interface features are possible 
only because the Mac is a graphics computer. Most personal computers cannot 
easily mix high-resolution text and graphics. The Mac's ability to mix high
quality text and graphics on the screen makes it possible to mix ICONS-small 
pictures that represent standard objects and functions-and text labels. The 
graphics basis of the Mac also makes it possible to have effective windowing, 
and to let users mix their text and pictures. 

It is the graphic quality of the Mac that makes it feasible also to produce 
text in so many fonts, sizes, and styles. Computers that d on't produce text 
graphically are limited to displaying many fewer styles of text. Such 
computers require that users put special commands for the printer in the 
middle of ordinary-looking text. These "embedded formatting commands" 
permit the printing of some special text effects like boldface or italics, but 
these styles usually cannot be shown on the screen. The Macintosh's power to 
display what will be printed is unprecedented in personal computers. 

The Macintosh's considerable graphics abilities extend to its printing. 
Coupled with an Image writer printer or a laser printer, it can reproduce all the 
text and graphics that the screen can display, and more. The Mac's printers are 
capable of greater resolution and much larger displays. The Macintosh is an 
especially good tool for preparing presentation-quality graphics. Pie and bar 
charts, tables, graphs, sketches, organization charts, project schedules, and 
many other materials that combine text and graphics can be readily created 
and easily edited with the Mac, using a variety of special-purpose applica
tions. Many Mac applications are specificall y designed to support generation 
of presentation graphics for business. 
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While the Apple Macintosh has a number of very powerful hardware 
fea tures, it is not graphics and computational power alone that makes the 
Macintosh a valuable personal computer. It is the way that the power has been 
harnessed . The Macintosh is easy to learn to use. It is consistent in how it 
interacts with the user across applications. It gives the user great control over 
the appearance of documents, both on the screen and in printouts. Take 
advantage of the Mac's power by exploring its applications. 

USING MAC POWER 

The focus of this book is the applications that make the Macintosh useful. You 
can learn how to use major programs for word processing, spreadsheet 
analysis, project management, and graphics composition, among others . 

If you have never used a Macintosh, begin b y reading the Appendix, 
"Mouse Skills." If you are still getting to know your Macintosh, start by reading 
Chapters 1-3 in order. They will introduce you to two major applications, 
MacPaint and MacWrite, and show you how to organize your disks effec
tively. At that point, you will have a good exposure to the practical elements of 
Macintosh use. 

The remaining chapters deal with other important app lications, some 
from Apple, o thers developed b y major software companies. Chapter 4 
describes Multiplan, a spreadsheet application. C hart, covered in Chapter 5 
can be used to construct charts of many different types, from scatter plots to 
pie charts, based on sets of numbers. Chapter 6 covers ThinkTank128, an 
application that aids the planning process b y providing a flexible, interactive 
outlining system. Filevision, described in C hapter 7, is a visual filing system; it 
lets the user combine drawings and data filing in new, creative ways. Chapter 
8 deals with MacProject, a project scheduling and tracking system that lets you 
enter project schedule information by drawing it in and presents the 
information in charts and tables. Chapter 9 presents methods for transferring 
data among computers, including the Macintosh communications application, 
MacTerminal. Chapter 10 covers other applications for drawing and writing, 
including MacDraw and Word, as well as a number of tools designed to work 
with MacWrite and MacPaint. Macintosh Pascal, a major breakthrough in 
Pascal programming environments, is trea ted in Chap ter 11. Chapter 12 
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discusses Macintosh applications with non-standard user interfaces, other 
programming languages, and probable future forms for the Mac. 

If you are an experienced Macintosh user, you can read the chap ters as 
they appeal to you. You might want to check ou t the tips on using MacPaint 
and MacWrite at the ends of Chapters 1 and 2, and a quick skimming of 
Chap ter 3 could turn up something you haven't yet noticed about disk 
management. 

All the Mac's strengths-the advanced 68000 processor, the fast high
resolution screen, the effi cient ROM routines-are useless without applica
tions. Learn to use major applications, such as the ones described in this book, 
and you can put the power of the Macintosh to work for you. 



CHAPTER 

1 PICTURES 
THE MAC'S GRAPHICS CAP ABILITIES 12 
MACPAINT'S FEATURES 14 
TECHNIQUES FOR USING MACP AINT 15 
TRANSFERRING MATERIAL 

BETWEEN DOCUMENTS 23 
THE MACPRINT PRINT CATALOG FEATURE 27 
SOME MACPAINT SHORTCUTS 27 
PROBLEMS AND TECHNIQUES WITH MACP AINT 30 
MACP AINT RESOURCES 38 

11 



12 PICTURES 

THE MAC'S GRAPHICS CAP ABILITIES 

The Apple Macintosh has amazing graphics capabilities. Action graphics 
programs like Through the Looking Glass, fo r exam ple, demonstrate the 
Mac's ability to p ortray realistically the rapid movement of complex objects in 
a three-dimensional world (Figure 1.1 ). One of the most impressive things 
about this demonstration of graphics power is that the program was not 
written in carefull y tuned assembly code, but rather in Pascal, a language not 
ordinarily used for fast-action graphics game applications. 

Although the Macintosh's graphics capabilities are well displayed b y 
games, it is not primarily because of games tha t the Mac's graphics are 
important to most users. The Mac's graphics speed and resolution make it 
possible to experiment freely in the construction of visual presentations, such 
as charts, diagrams, maps, and plans. Graphics composition applications like 
MacPaint are so fast tha t you can try things out just to see what effect they will 
have without being concerned ab out the time it takes to experiment. 

Because the Macintosh is a true graphics computer, you can not only use 
different fonts, styles, and sizes for tex t in word processing applications, you 
can also combine graphics with the text. Many different Macintosh applica
tions have graphics capabilities. For example, in Apple's word processing 
app lication, MacWrite, you can paste graphics created with MacPaint into a 
memo. Using the Cairo font, you can add pic torial elements b y typing. 
MacWrite provides graphics manipula tion features such as moving and 
resizing graphic images in a document. 

The ap p lica tions that really let the Mac's graphics capabilities shine, 
however, are those specificall y designed for the preparation of graphic 
displays. These applications include Mac Paint and MacDraw from Apple, and 
Chart from Microsoft. The Telos Filevision application (see Chapter 7) has 
graphics construction capabilities mixed with data- base building features . 

The Mac has w onderful potential for prepara tion of black-and -white 
presenta tion graphics. Two features make Macintosh graphics applica tions 
immensely useful. First, the Mac has unusually good graphics resolution and 
speed . Second, whatever you create can be printed on paper exactly as it 
appears on the screen. 

The Mac's graphics capabilities are d ue, in large part, to a collection of 
very clever drawing routines called Q uiCKDR AW, found in the Macintosh 
ROM. Bill Atkinson of Apple wrote the Q uickdraw routines and then followed 
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Figure 1.1 The Through the Looking Glass chessboard 

that feat by authoring MacPaint. In a sense, MacPaint is Quickdraw made 
directly available to the Mac user. 

PHESE:-.ITAT!ON GRAPHICS are images that are meant to be shown to other 
people. Examples include graphs and other figures for inclusion in technical or 
financial reports, design sketches, and personalized birthday cards. 

Graphics construction applications can be divided into two classes. 
Programs like MacPaint treat pictures as collections of dots on the screen, or 
PIXELS. Such applications are called PlXEL-OHIEJ\:TED graphics programs. In 
other graphics programs, all the elements on the screen are represented in the 
!viae's memory not only as a collection of pixels but also as objects of types 
known to the program-this is a circle , that is a rectangle, and so on. Such 
graphics applications are known as OBJECT-ORIE:-JTED graphics systems. 
Examples include MacDraw and Filevision. 
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Object-oriented graphics applications have some interesting and useful 
characteristics. In Mac Draw, for example, one object can be moved to overlay 
and totally obscure another without actually elimina ting the overlayed object 
from the data base that underlies the picture. For example, a large circle could 
be placed so that it covered a small rectangle completely. Later, however, if 
the circle is moved aside, the samll rectangle will appear in its original location . 

There are some disadvantages to the object-oriented graphics systems on 
the Macintosh. One is that they don't provide as many features for fl exibility 
and detailed control as pixel-oriented applica tions do- fea tures such as 
FatBits in MacPaint. The tvlac's object -oriented graphics systems, MacDraw 
and Filevision, work best fo r portraying pictures with regular objects and 
sharp boundaries, depic ting worlds of regular fea tures and straight edges. 

MACPAINT'S FEATURES 

Pixel-oriented graphics systems are more appropriate for depicting pictures 
with shadow, texture, and fuzzy edges. MacPaint is such a graphics applica
tion. Pixel-oriented graphics have the characteristic that once the graphics 
designer has made a commitment to placing an object such as an oval or a 
letter at a particular location on the screen, and has gone on to do something 
else, the image loses its object status from the ap plication's point of view. It is 
no longer an oval or a letter, so far as the app lica tion is concerned , but merely a 
collection of pixels (dots) . This characteristic places some constraints on the 
extent to which a user can undo actions with MacPaint. F or example, you can't 
overlay five objects in MacPaint and then decide to remove the second and the 
fourth. MacPaint can't tell w hich dots b elong to the different objects you 
layered in the picture . 

On the other hand, because MacPaint doesn't restrict you to composing 
pictures from pre-defined objects, you can depict anything that can be 
depicted by placing d ots in any of 414,720 locations. This is the number of 
pixels that completely fill a display 8 inches wide and 10 inches high, at 72 
pixels per inch. The Macintosh has such a display-576 by 720 dots-its 
printed output. 

MacPaint reflects Apple's commitment to making the Mac a truly useful 
machine. If the MacPaint had b een designed to produce graphics only on the 
screen, it would have been an interesting toy to play with, but not a serious 
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tool. Because MacPaint can be used to prepare pictures printed on paper, it 
can be used to produce technical drawings, sketches, charts, and other types of 
graphic figures. 

A pixel-oriented display can b e represented as a b itmap in computer 
memory. A BITMAP is an area of memory in which each pixel is represented by a 
bit. If the pixel is white, the bit is 1, and if the pixel is black, the bit is 0. The 
414,720 pixels of a full-printed MacPaint page require a lot of memory if the 
page is treated as a bitmap. If you are mathematically inclined (and if you 
know that there are 8 bits to a byte ), yo u may have already calculated tha t such 
a pageful of pixels would occupy 51 ,840 bytes. Only seven such documents 
would fit on a single -sided 400K-b yte Macintosh disk with nothing else on it
no system fil es or applica tions. 

Fortunately, MacPaint is more clever than that. It stores the pixel map in a 
compressed form on the disk and expands only those portions that fi t into the 
drawing area of the screen into a bitmap. For most drawings, the compression 
technique is very effective. Many simple MacPaint documents may take only 
4K to 5K bytes on the disk. (A completely blank MacPaint picture takes 2,048 
or 2K bytes.) Even complex documents rarely require more than 10K or 12K 
bytes. 

TECHNIQUES FOR USING MACPAINT 

By far the best way to learn the basic MacPaint techniques is to use the 
application to produce figures of the types tha t are of interest to you. 
Experiment with each of the MacPaint tools until you know what they can do. 
Dip into the lovely little MacPaint manual from time to time. I t is q uite 
compact, and most people find tha t they see something new when they return 
to it after working with MacPaint. 

People interpret new experiences in terms of familiar ones. It is natural to 
think of MacPaint in terms of the familiar task of sketching with pencil or pen 
on paper. To an extent, it is possible to use MacPaint in this way. You can select 
the Paintbrush and draw freehand using the mouse, much as you would with a 
brush or with pencil on paper (Figure 1.2) . 

It would be a mistake to limit your use of MacPaint to this primitive 
analog of ordinary drawing, however. T o make effective use of MacPaint, you 
must learn to use its special features. Indeed , were it not for these features, 



16 PICTURES 

,. ., 

=-=:...=-~- -~-=-..:::::=:_-~-
--- ---- ------

Figure 1.2 "Spider-Cat," drawn with the Paintbrush-tool Icon by an eight-year-old 
MacPalnt novice 

only people with well -practiced artistic skills could use it effectively. T he 
special fea tures make it possible for people who don't think of themselves as 
artists to produce impressive graphics designs and figures. 

Many of the special MacPaint features are made available through its 
menus, especially the Edit and Goodies menus (Figure 1.3 ). Other features are 
exercised b y using the mouse in combina tion with the Option and C ommand 
keys. 

For one of my first MacPaint projects, I decided to make a Valentine's 
Day card . I w anted to create a couple of cartoon-like d ancing heart figures. 
My first thought was to draw a heart freehand, with unimpressive results 
(Figure 1.4). My problem, of course, was that I fail ed to take advantage of the 
special features of MacPaint. When an image has symmetry, you can turn on 
the Brush Mirrors option and just sketch one side. If the image is more 
complex, first draw and edit half of the object, make a copy, flip the copy 
across the axis of symmetry, and then position the copy appropriately. 
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Figure 1.4 An attempt at a freehand valentine 

To draw a valentine cartoon character taking advantage of MacPaint's 
features, I decided to create first the left half of a heart shape. I made a circle 
using the oval option from the Tools menu at the left of the MacPaint page. 
Holding down the Shift key constrained the tool to produce circles only. I 
dragged out a circle about an inch in diameter. Then I chose the straight- line 
tool and added a tangent vertical line. T he vertical line was just to mark the 
destination for a freehand arc, which completed the left edge of a heart shape 
(see Figure 1.5 ). 

I erased the vertical line and those portions of the circle that don't belong 
in the left half of a heart shape. I used the eraser from the graphics tool set to 
remove most of the extraneous lines. Then I used the Fa tBits option from the 
Goodies menu to clean up the d ots I had failed to get w ith the eraser (Figure 
1.6). The next step was to choose the selection rectangle and drag its box 

Figure 1.5 Circle, tangent, and arc 
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Figure 1.6 The leff half of a heart shape 

around the half heart. I then dragged the selected half heart to the right while 
holding down both the Shift and the Option keys. Because the option key was 
held down, the figure stayed in its original location, and only a copy was 
dragged off to the side (Figure 1.7). Because the shift key was held down, the 
dragging was strictly horizontal, with no slight skewing up or down. 

The next step was to flip the half on the right. Since it was still selected
enclosed by the edit rectangle-! just pulled down the Edit menu and chose 
Flip Hotizontal. To glue the new right half of the heart to the left half, I chose 

Figure t.7 Two Identical shapes 
t 
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Figure 1.8 The closed valentine 
shape 

the Lasso tool. I circled the right half with the lasso to select it. Then, holding 
down the shift key in order to restrict movem ent to the horizontal dimension, I 
dragged the right half to the left until it mated w ith the left half (Figure 1.8 ). 

At this point I chose the Spilling Paint Can tool in order to fill the heart 
with black. I was happy with the shape of the image, but it was larger than I 
wanted . I enclosed the w hole heart in the selection rectangle and held down 
the command key w hile dragging in order to shrink the heart to a smaller size 
(Figure 1.9) . (You can also use this technique to expand objects .) 

Now I added embellishments to turn the li ttle heart into a cartoon 
character. I chose appropriate brushes to crea te the arms and legs. The feet 
were made by using the Fill -in Oval tool to create one small black oval, and 
copies of it were placed at the ends of the legs. The hand was built entirely in 

Figure 1.9 A smaller, filled-In heart 
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Figure 1.10 An embellished heart 

the FatBits option, then moved into position at the end of the arm (Figure 
1.10). 

I made a second copy of the band, flipped it horizontally, and attached it 
to the other arm. Then I added some highlighting to give a three-dimensional 
quality tc the feet (see Figure 1.11). Using FatBits, I added highlights to the 
heart shape as well (Figure 1.12). 

To make two facing heart cartoon characters, I dragged a copy of the 
whole figure to the right and flipped it horizontally. Then I lassoed the new 
figure and dragged it over to the first character until the hands overlapped. As 
before, I held down the shift key while dragging to keep the two figures on the 
same horizontal level. Selecting the text tool, I chose a font, size, and style and 
gave my little picture a title (Figure 1.13). 

To build this picture of two valentine dancers, I repea tedly made use of 
the special features of copying, moving, and flipping. And I didn't have to stop 
there. This complex figure can b e treated as a component to be manipulated 

Figure 1.11 A heart cartoon character 
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Figure 1.12 Adding highlights with FatBits 

Figure 1.13 Valentine dancers 
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repeatedly and put into a different figure. For example, I made many copies 
of the pair of dancing heart figures, sizing each copy differently. (In order to 
preserve the proportions of an object you are changing the size of, be sure to 
hold down not only the Command key but also the Shift key as you drag the 
image to a smaller size.) Then, using the lasso, I partially overlapped the pairs 
of dancers to give an illusion of depth. Finally, I added a new banner at the top 
of the page. I'd produced a new and more complex picture in very little time 
(Figure 1.14). 

To get the most out of MacPaint, look for ways to exploit its special 
features. 

Title Boxes 

Making shadowed title boxes like the one at the top of the picture of five 
cartoon heart couples (Figure 1.14) is a simple three-step process (see Figure 
1.15 ). First select the Filled Rounded Rectangle tool and use it to drag out a 
black box, as in A. Then change the pattern from black to white and, using the 
same tool, drag out a partially overlapping white box, as in B. Finally, choose a 
font type, size, and style you like, and use the Text tool to add your title to the 
white box, as in C. Centering the title is easy if you choose the Align Middle 
option under style and then place the text insertion point in the middle of the 
white box. If you want to, you can fiJI the white box with a pattern from the 
Pattern menu. 

TRANSFERRING MATERIAL BETWEEN DOCUMENTS 

One of the nicest things about using the Macintosh is that its applications use 
consistent methods for doing similar things. A common requirement in 
working with almost any application is that of copying material from one 
document into another, or from one place in a document to another place in 
the same document. On the Mac, the usual way of doing this is with the 
Clipboard. The CLIPBOARD is a magic place-sometimes all in memory and 
somtimes temporarily on the viae's disk-that stores things for pasting into 
documents. 
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Rgure 1.14 Receding valentine dancers 
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(.R) 

(B) 

(C) 

Rgure 1.15 Constructing a title box 

There are two ways to put something on the Clipboard, copying and 
cutting. When you Copy something to the Clipboard, the original remains 
where it was and a copy is put on the Clipboard. When you Cut, the cut 
material is removed from its original location and put on the Clipboard. 

After you've put some material on the Clipboard, it w ill stay there until 
one of two things happens: either you put something else on the Clipboard 
with another Cut or Copy, or you turn your Mac off. To Paste the material on 
the Clipboard into a document, you simply select an insertion point-usually 
by pointing and clicking-and then give the Paste command. All three 
commands, Cut, Copy, and Paste, can either be chosen from the Edit menu or 
be invoked through keyboard commands. 

To make sure you're familiar with the use of the Clipboard in MacPaint, 
create a new MacPaint document (see Figure 1.16). Use the brush or any of the 
other tools to create a little picture. Now use the selection rectangle to select 
the picture. Your screen should show your picture enclosed by the dotted lines 
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Figure 1.16 Using Copy and Paste In Mac Paint 

of the selection rectangle. Now Copy the selected area onto the Clipboard by 
typing Command-C. Unselect the picture in the selection rectangle by 
clicking elsewhere. Now type Command-V to Paste the Clipboard contents 
into your document. The newly pasted image appears in its own selection 
rectangie. Drag it to a location near the original and drop it. 

Of course, within a single MacPaint document it is easier to use the Option 
key to make copies of selec ted areas of a document, so long as the two areas 
are in the same drawing window. If they are on widely separated parts of the 
full-page MacPaint document, the Clipboard method is best. The same copy
and-paste method can be used to copy material from one MacPaint pic ture to 
another. In fact, as Chapter 2 describes, yo u can even use the Clipboard to 
copy a graphic design into a MacWrite document. 
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THE MACPAINT PRINT CATALOG FEATURE 

Even if you make a special system disk for working with MacPaint- one with 
only the necessary system folder documents, the empty folder, and the 
MacPaint application-you can keep only a small number of Macpaint 
documents on it. Pictures you ar~n't working on at the time should b e kept on 
DATA DISKS, non-system disks on which you keep backup copies of your work. 

A 400K-byte Macintosh disk can hold a great many documents. But how 
can you remember which pictures are on what disk? One way, of course, 
would be to keep a written record for each disk, adding to it or deleting as you 
add and delete documents from the disk. Unfortunately, most of us aren't that 
well-organized. Fortunately, there is an easier way. MacPaint lets you print 
out a catalog of the pictures you have on a disk (Figure 1.17). It would have 
been fairly easy to include a feature to print out th~ ql!mes pf tfle docpment~, 
but MacPaint goes one better. After all, a name is not always as good a clue to 
the contents of a document as you hoped it would be when you thought it up. 
MacPaint's Print Catalog option-available in the File menu-actually prints a 
miniature version of each MacPaint picture on a disk. 

SOME MACP AINT SHORTCUTS 

Thanks to MacPaint's commitment to the design of the Macintosh user 
interface, the beginning user doesn't have to know any tricks to be able to use 
all of MacPaint's tools. Once you have a little basic experience with MacPaint, 
however, you'll find you can work faster and more easily by using the 
convenient shortcuts. Shortcuts give you ways of doing some of the same 
things you can do with the menus, but faster. 

FatBits Shortcuts 

FatBits gives you a close-up view of the pixels in a small area of the screen. 
You're likely to find yourself doing lots of work with FatBits, so it makes sense 
to use the fastest ways to get into and out of this mode. The Pencil is the most 



28 PICTURES 

MecPeint documents on di sk AM beckup 

Allen's Dino JP's Bronto Two Vels touchscreen touchscreen2 

-.... -
cursors Velentine old Ve lentine Keys Fl .12windw 

;·::::.: ...... \(, .. : .. :" .· ' R I.._~ -
l-······· B \....I . 

Finger Pem Loves Hot Spots window ESAS EdWinds 

-A 
ESAS AfEd VCR wAfEd VCR wCEd VCR NewVaiDence 

Figure 1.17 A catalog of MacPalnt documents 
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useful tool for FatBits work. After you have selected the Pencil, position it in 
the area where you want to do FatBits work, hold d own the Command key, 
and click the mouse. You can get back to the regular edit page by again 
clicking with the Command key held down. 

If you hold down the mouse button while drawing with the pencil, it will 
retain the color (black or white) that it starts drawing with-the opposite 
color of the dot it was pointing to when you first depressed the mouse button. 
You can d raw straight lines-horizontal, vertical, and 45° diagonal- by 
holding down the Shift key while drawing with the Pencil. 

When you work in FatBits, you usually want to do a good deal of 
scrolling-pushing the work area around under the Fa tBits window with the 
Grabber. (~o te tha t the Grabber-the hand-shaped tool-plays much the 
same role in MacPaint that scroll bars do in other applica tions.) Unfortunately, 
it's awkward to have to keep moving over to choose the Grabber tool, 
repositioning the window, then choosing the Pencil again . Fortunately, there is 
another shortcut. I ust hold down the Option key in Fa tBits, and the mouse 
pointer turns into the Grabber. Move the window to where you want it, release 
the O ption key, and you'll get your pencil back. 

Show Page Shortcuts 

The quick way to get to the Show Page view of your d ocument is to double
click the Grabber. Fro m th is global view of the picture you can do some very 
powerful things. By positioning the mouse pointer outside the current drawing 
window, you can drag the whole picture to a new position on the page. You 
can even d rag some or all of the image off the page entirely. 

This view of the entire page is also the most convenient way of making 
major changes in the loca tion of the drawing window. T o move to a d ifferent 
part of the document, put the pointer inside the window and drag it to the part 
of the page you want to work on nex t. 

Other Shortcuts 

Sometimes you want to do something to the whole graphics drawing window, 
such as place a copy on the Clipboard. To select the entire window, just 
double-click the dotted- line selection rectangle tool. The shimmering dotted 
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lines of the selection rectangle will appear at the edges of the window. At this 
point you can choose any of the operations that apply, such as copying to the 
Clipboard, flipping, or resizing by dragging with the Command key down. 

To choose a new brush shape, just double-click on the Paintbrush tool. 
You'll be presented with the brush shape selections, just as though you had 
selected Brush Shape from the Goodies menu. 

To erase the entire drawing window, double-click the Eraser. This 
shortcut has its dangerous side. Be sure not to double-click when you merely 
want to choose the eraser for a little selective erasing in the current window. 
Don't panic if it does happen by accident, however. Just choose Undo from 
the Edit menu. The shortcut for Undo in MacPaint is the-'key at the top left 
corner of the keyboard. Undo can take back only the last action you make. If 
you accidently erase the drawing window, for example, and then take any 
other action-such as clicking on one of the MacPaint tools-you will not be 
able to undo the erasure. 

PROBLEMS AND TECHNIQUES WITH MACP AINT 

MacPaint does have more serious uses than making valentines. Consider the 
simple chart of projected sales over time in Figure 1.18. Such charts can b e 
quickly prepared. First select a tight grid pattern from the Pattern menu at the 
bottom of the screen. Using the Filled Rec tangle tool, drag out the chart 
background using this grid pattern. Then type the words "Sales" and "Time" 
at the bottom of the grid. Use the select box to select the word "Sales," and 
choose the Rotate option from the Edit menu. Move the word (still in its select 
rectangle) to the left side of the grid. Now choose an appropriate brush size 
and shape. Choose the black pattern and draw the "Their Company" line. 
Then choose the all white pattern and use the brush to add the "Our Company" 
line. Finally, choose a smaller text size and use the text tool to add the line 
labels in the grid area. 

MacPaint is not the best application for making sales charts. A much 
better choice would be Microsoft Chart, which is discussed in Chapter4. Still, 
if all you want to do is create some visual presentations to convey a general 
idea, such as the one shown in Figure 1.18-"0ur company's sales will 
eventually surpass theirs"-then you can use simple MacPaint methods to do 
so. 
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Time 
Figure 1.18 Informal sales chart 

You can also easily make technical drawings with MacPaint. In the 
example in Figure 1.19, the front panel of the Spurious, Inc. videocassette 
recorder is displayed . Many of the same techniques used to prepare the 
valentine dancers figure were also used to build this one. Look for evidence of 
copying, forced alignment (keeping items on the same horizontal or vertical 
level by holding down the Shift key while dragging), and grids. 

Using the Grid 

T o get concentric circles, use the Grid (one of the options under Goodies, 
remember?) . As you know, when yo u drag a circle-the Oval option with the 
shift key held d own-you begin the d rag a t the corner of a square that would 
exactly contain the circle. When the invisible grid is turned on, you can move 
the mouse pointer only to grid intersections. Therefore, you can easily make 
concentric circles b y starting and stopping circle drags a t grid points that a re 
on the same 45° diagonal line. 

Using the Grid is also important for aligning objec ts and getting spacing 
right. Figure 1.20 was d esigned for a physics lab handout. It portrays the 
results of an experiment in which a strobe light flashes on two falling balls. 
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Figure 1.19 A simple technical drawing 
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Elementary mechanics, Experiment 1: 
Two falling objects 

(one with a horizontal velocity component) 
illuminated by strobe light 

Figure 1.20 Two tolling objects Illuminated by strobe 

T o begin with, the cross-hatched background was created by dragging 
this pattern with the Filled Rec tangle tool. Then the legs were added. The ball 
was created in a clear space on the left, dragged onto the grid background with 
the Option key held down, so that a copy could be deposited whenever the 
mouse button was released. The Grid was used to increase the vertical distance 
between successive balls while keeping the horizontal distances be tween 
successive balls the same. 

The Grid also makes it easy to create simple forms. The vertical and 
horizontal lines of the game form shown in Figure 1.21 , adapted from a well 
known board game, were made with the help of the Grid, which helped the 
form designer achieve equal spacing between the lines . The strange language 
on the form is the American Indian language Chickasaw. 
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' Figure 1.21 A form created with MacPalnt 
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Tiny Text 

It is possible to make letters even smaller than the 9-point fonts. For example, 
note the VCR front panel in Figure 1.19. I entered the words in 12-point on a 
blank area of the drawing window. Then I put the block of text in a select box 
and shrank it, dragging the box while holding the Command key down. 
Finally, I did a little cleanup with FatBits. 

Recovering from Error 

It is easy to make an error that you can't undo. I was dragging my only copy of 
a complex figure over a complex background when I accidently dropped it 
where I didn't want it. Then I clicked on the Eraser tool without thinking. If I 
hadn't started doing something else, I could have simply used the Undo option 
in the Edit menu. 

When something like this happens to you, you may be able to recover. Did 
you have the figure on disk before you started the current editing session? Or 
did you save your MacPaint document after you created the complex figure, 
but not since you messed it up? If so, you can probably recover it. Just choose 
the Restore option from the File menu. MacPaint will replace your modified 
document with its last saved version. The restored version should be in the 
same state that you last saved it. 

If you don't have an earlier saved version of the document, you're out of 
luck. At least you can take a lesson from the experience. It really pays to save 
different versions of complex MacPaint documents. As you make major 
modifications to a drawing, use the Save As option from the File menu to put a 
copy on the disk with a new name. You'll be glad you did if you can pick up the 
drawing at an intermediate stage rather than have to start from scratch. 

Making Room for Documents 

You will find that you can't make many complex MacPaint documents on your 
Write/Paint disk before MacPaint starts telling you that there isn't enough 
room on the disk. If you have only the built -in disk drive, you should probably 
make a special MacPaint disk, with just the system folder, the empty folder, 
and the MacPaint application, as explained in Chapter 3. This will give you a 
disk with lOOK bytes of free space, enough area for a few MacPaint documents 
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and the scratch area tha t MacPaint requires while it's working. MacPaint 
documents you are not currently working on should be kept on DATA DISKS

disks that have documents, but no applications or system files. 

Recovering from Disaster 

Some night your spouse may find that you are so deep in MacPaint that pulling 
the Mac's power cord from the socket is the only way to get your attention. If 
this happens, you may be able to recover some of your work . Start up your 
Mac again and have a look a t your disk window ( Figure 1.22). If you have a 
strange b lank icon labeled "Paint 1," simply open MacPaint directly (not with 
any of the other Paint documents). If it starts up with a document titled 

,.. • File Edit Uiew Special 
., 

Figure 1.22 Directory wllh remnant of a crashed MacPaint 
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Uiew Special 

, ...... 
loi!Ol Plense insert the disk: 
't.._) 

RM's Pictures 

Figure 1.23 Printing several MacPalnt files at once 

., 

"Rescue," then MacPaint was able to reopen the temporary version of your 
document it was working on when so rudely interrupted. 

MacPaint saves temporary documents like "Paint 1" when you move to 
another area of the p icture with the grabber or from the Show Page option. If 
you haven't done that, chances are the picture will be lost. 

Printing Many MacPaint Documents 

Let's assume you are the kind of well-organized person who has put a set of 
related i'viacPaint documents into a folder in exac tly the order in which you 
would like to print them. Now just open the folder and drag the selection box 
around them. Pull down the File menu and choose Print (Figure 1.23 ). After a 
brief delay, MacPaint is opened automatically and begins printing the 
documents you selected. The pictures \.vill all be printed in MacPaint's Print 
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Final mode, which is darker and crisper than the Print Draft mode. The order 
of printing is the order of the documents in the folder, moving left to right and 
top to bottom. Convenient, isn't it? 

MACPAINT RESOURCES 

Publication-Quality MacPaint Output 

A company called George Graphics provides the service of printing very high 
fidelity versions of MacPaint documents. Two levels of quality are provided: 
300 dots per inch from a laser printer, or 700 dots per inch from a high
resolution CRT typesetter. To take advantage of the service, all you have to 
provide is the Macintosh disk with a list of documents to be printed, and 
money. For further information, contact: 

BOOKS ON MACP AINT 

George Graphics 
George lithograph Company 
650 Second Street 
San Francisco, CA 94107 

MacCats ... 99 Ways to Paint a Cat with MacPaint. by Floyd Flanagan. 
Glenview, Ill .: Scott, Foresman and Company, 1985. 

MacWork/MacPlay, by Lon Poole. Bellvue, Wash.: Microsoft Press, 1984. 
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For several years, word processing programs for personal computers 
have made the claim that what you see is what you get. This means that the 
screen display of a text looks very much like the printed version. Most 
computers before the Mac could not display text in more than one font, in 
more than one size, or in more than one or two styles, unless the computer used 
a special graphics mode that was too slow for word processing. Strictly 
adhering to the what-you-see claim would severely limit a word processing 
program's printing capabilities on earlier technology computers. 

Dot matrix printers and laser printers, on the other hand, can usually print 
text in several sizes-normal, condensed, expanded- and in several styles, at 
least und erlined and boldface. Most advanced word processing programs for 
other computers compromise the what-you-see principle in some way. They 
utilize the printers' capabilities by providing cryptic format control com
mands for printing in sizes and styles that can't be displayed on the screen. 

WORD PROCESSING WITH THE MAC 

Word processing on the i\ifacintosh is very different. With the Mac, you don't 
have to put a funny command like"" PB" into your text to signify that you want 
to print a portion in b oldface. Instead , you can see the styles and fonts you 
choose right on the screen, much as they will appear on paper. And the Mac 
gives you a great deal of control over the appearance of the text, with many 
fonts in five sizes and five special styles-bold, itali c, underline, outline, and 
shadow-that can be combined with each other (Figure 2.1). 

The Macintosh gives authors so much control over the appearance of text 
that writing with the Mac can be likened to writing with a computer-based 
typesetting machine . In fac t, by the time this b ook appears on the book
shelves, programs a nd services will be available to use the Mac's word 
processing documents as inputs to au tomatic typesetters. For those without 
access to typesetting machines, the new laser printers permit a new level of 
output excellence with the flexible font control of the Mac. Even Apple's dot 
matrix printer, the Imagewriter, makes very impressive page layouts when the 
high-quality mode is chosen. For example, teachers have found that Apple's 
dot matrix printer accepts ditto masters easily, and the finished dittos can 
display font and style variety they've never seen before. Book publishing may 
become a process accessible to a great many people. 



Word Processing with the Mac 41 

This is New York font in 9-point. 
This is Geneva font in 9-point. 

ThiZJ iZJ Toronto font in 9-point. It iZJ the~ mOZJt legible~ of the~ 9-point fontZJ. 
This is Monaco font in 9-point. 

This is New York font in 12-point. Bold It•lic. 
This is Geneva font in 12-point. Outltne. 

Toronto 12- polnt. Toronto is wider than other rents. 
Monaco font, 12-point. The non-proportional font. 

This Is Chicago font In 12-polnt. The system font. 

This is New York in 14-point. ~. 
Genevl! font in 14-point. Underline. 
Toronto font in 14-rx:>int. Bold. 

Venice 14-point is the script font. u.nae,.u,ne bol.l. 

New York 18-point. ©wafi~rm.®a 

Geneva 18-poi nt. l!l®ll@JIJ (;}lia@t!J®~ g 

Toronto 18 point. lttJ!Jc~ OutJJ.n•. 
lonbou t S -point is a g@ ~i.spla!' font. 

Rthens 1 B-point is nice for headings. llliJMlD rfinunfmrnc 
San WranciSco 18-point iS a ver}J SilllJ font. 

New York 24-point JE©ll@l CO)oottill!JID.® 

Geneva 24-point[Bj(O)]cOJ (O)tuJtt]~!nl~ 

Toronto 24-point 
Bwtdl Ou.nU ftlTh~ lUJJnt<dl~R ftrou~ 
Figure 2.1 Some Macintosh font, style, and size options 
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The control tha t theM ac gives you over the appearance of your document 
goes far beyond the appearance of the text. You can include graphic materials 
mixed in with text simply by copying pictures or portions of pictures created 
with graphics applica tions. Best of all, you can see all the font selections, all the 
mixed text and graphics, every aspec t of how your document looks, b oth on 
the screen and in your printouts. 

On the Macintosh, word processing applications act like object- oriented 
graphics programs. MacPaint is a pixel-oriented graphics program with some 
text capabilities. Once you've gone more than a step beyond the action that 
places a character or a group of words on the screen, MacPaint doesn' t 
remember that the collection of dots that appear as a word are anything but a 
collection of d ots, or pixels. In pixel-oriented ap plications, objects like letters 
and words lose their object status. In the MacWrite word processing 
application, letters appear as collections of dots on the screen or on paper, but 
they never lose their sta tus as letters. Thus, you can always go back to a letter or 
any chunk of text larger than a letter and change its attributes- from plain to 
boldface or italic or whatever. This is possible in part because the application 
stores letters as characters in RAM and on disk and treats them as collections of 
pixels only for the purpose of presenting them to us on the screen or in 
printouts. 

WORD PROCESSING APPLICATIONS- CHOICES 

You have many choices of applications for producing text. If you are making a 
short document-say, a page-and you want a great deal of flexibility in 
composing the layout, you could even use MacPaint. Other applications that 
are not meant primarily as word processors can b e used to produce printed 
texts. Program listings in languages like BAS IC and MacPascal are typically 
produced by the programming application itself rather than with a separate 
editor/ formatter. Even data-base and spreadsheet applications offer some 
(sometimes quite extensive ) word p rocessing capabilities . 

To get the m ost complete facilities for writing and formatting texts, 
however, you will want to work with a word processor. The original 
Macintosh word processor, Mac Write, is very easy to learn to use and provides 
a great deal of control over the form of the text. It is most appropria te for 
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producing short documents such as memos. Word from Microsoft is the first 
Macintosh word processing application with design fea tures that support the 
preparation of really long documents, and it can also be used for creating and 
printing form letters. For more on Word, see Chapter 10. 

Other word processing programs will emerge, each with desirable 
features. Keep an eye on the reviews in magazines devoted to the Macintosh 
like MacWorld and The MAGaz ine, as well as in more general-interest 
publications like lnfoWorld, A+, and Byte. While both MacWrite and 
Word are very impressive applications, you would do well to keep track of 
emerging developments. The Macintosh may inspire new word processing 
systems, unlike anything ever seen before on a personal computer. 

USING MACWRITE 

Like Microsoft Word, MacWrite is a disk-based word processor. That means 
that, during the text editing process, portions of a MacWrite document will be 
immediately accessible in the Mac's internal Random Access Memory (RAM), 
while other portions may reside on disk. When you drag the scroll box to a 
portion of the document that is not currently in RAM, there is a brief pause 
while some of the document that is currently in RAM is saved to disk and the 
next portion is brought into RAM from the disk. 

The first version of MacWrite for the Macintosh was a RAM-based word 
processor. This meant that it could produce documents only as long as would 
fit in RAM. On a Mac with 128K bytes of RAM-most of which is dedicated to 
crucial operating systems programs, to representing the video screen, or to the 
MacWrite program itself- RAM -based MacWrite could be used to make 
documents of only about 20K bytes. That was about eight to ten pages of 
single-spaced text, depending on margins, font, and font size. You may still 
hear some people who are not familiar with the current version of Mac Write 
claim that the Mac's word processing capabilities are suitable only for brief 
memos. 

MacWrite is well suited for preparing memos, letters, and short reports , 
but it can also be used to write much longer documents. This book was written 
with MacWrite. When you write very long documents, it works best to put 
separate sections or chapters into different Mac Write documents. You can 
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then more easily keep track of revisions of different portions of a book or long 
report. Each MacWrite document that is to be part of a larger d ocument 
should start at the top of a page, since the previous document always extends 
to the bottom of a page. 

MacWrite Features 

You may already be familiar with many of the editing features of Mac Write. If 
you have ever edited a d ocument name in response to the prompt of a dialog 
box, or if you have changed the name of a d ocument, folder, or disk in a 
directory window, then you have already used many of the editing features of 
MacWrite. All of the program code that le ts you set the point for insertion with 
the mouse, tha t makes the Backspace key work to d elete selected text, and that 
lets you cut, copy, and paste textual material is provided not b y the Mac Write 
app lication itself but b y a sophisticated part of the operating system dedicated 
to text-editing func tions. This special operating system module, which is called 
C oreEdit, makes it easy for applica tions programmers to provide the basic 
text-editing functions in their applica tions. Because Apple makes this set of 
text-editing capabilities available to applications developers for free, most 
applications that have any text- editing capabilities implement them in the 
same way. This consistent approach makes it a lot easier for Mac owners to 
learn how to use new applica tions. 

The Insertion Point. In a sense, MacWrite has two pointers ( Figure 2.2). One 
is the mouse pointer. When the mouse is moved in the text area of your screen, 
you see the standard text pointer shape, the I- beam. The mouse pointer takes 
on its slanted arrow shape when it is moved outside the text area of the screen, 
into the scroll bar, title bar, menu bar, or a header or foo ter. The second 
pointer in Mac Write is a flashing vertical bar, the insertion point. This pointer 
doesn't move as you move the mouse. Instead, it moves as you type. You can 
move the insertion point to any place you can point to with the mouse's I-beam 
pointer. Just position the I-beam and click, and the insertion point wiJI appear 
there. 

One of the most common editing techniques in Mac Write is to change the 
insertion point b y pointing to the destination for new text with the I -beam, 
clicking to set the insertion point, and then typing in the new text. Then you 
just move the insertion point to the next place you want to enter text. Of 
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sing le-spaced text with one-inch margins. 
MacWrite is well-suited for prept~ring memos, letters, t~nd short I 

reports. It can be used to produce longer reports, too, but this works out 
best If the report can be divided Into severt~l sections, each of which can 
stort at the top of a page.l 

the mouse pointer 

the insertion point 

Figure 2.2 MacWrite's two pointers 

course, you don't have to add text from an insertion p oint. You can also delete 
backwards from the insertion point just by typing the Backspace key. 
Knowing how to type, how to set the insertion point, and how to backspace is 
enough to ge t you started editing with MacWrite. 

Dragging to Select. . a turally, there are more elaborate ways to edit large 
chunks of text than insertion and backspacing. One of the nicer things about 
word processing is that it lets you pick up whole pieces of text and move them 
elsewhere. To do things like that, you first have to know how to select chunks 
of text. You already know how to select an insertion point-just point with the 
1-beam and click. The standard method for selecting a letter or a group of 
letters is to drag through the letters. If you want to select a couple of words on a 
line, you just position the I-beam at the beginning of the first word, depress the 
mouse button, and drag to the right. The text you drag over appears in inverse 
video-it appears as white text on a black background instead of the usual 
b lack on white (see Figure 2.3). When you get to the end of the text you want 
to select, let up the mouse button. (You can also drag a selection from right to 
left.) 

Things to Do with Selected T ext. There are lots of things you can do with 
selected text, the text that appears in inverse video. You can delete it by typing 
the Backspace key. You can replace it by typing wha tever text you want to 
have replace it. When yo u strike the first key, the selected text disappears, the 
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=o UseM Ch5.1 

position it exactly where you want it. 

I 
Other woys to select. Dragging is only one way to select text in 

MacWrite. Vou can se lect a single word by pointing anywhere in the wor-d 
with the 1-beam pointer and double-clicking. The word wil l then appear 

inliiMF¥"1 

Figure 2.3 Selected text In Inverse video 

following material collapses back to the preceding material, and the new text 
appears at an insertion point that takes the p lace of the replaced material. Any 
letters typed subsequently are entered at this point in the text until you relocate 
the insertion point. 

Another thing you can do with selected text is place it on the Clipboard, 
that magic part of the Mac's memory that lets you transfer data between 
documents. After you've selected a block of text by dragging through it, you 
can simply type Command-C (or pull down the Edit menu and choose Cut) to 
put a copy of the selected text on the Clipboard. To type Command-C, you 
hold down the Command key, the one with the cloverleaf-like symbol,~, just 
to the left of the spacebar, while you type the letter C. (See the Appendix, 
"Mouse Skills," for more on the Command key shortcuts.) 

Using the Clipboard. Until you get confident about using the C lipboard, 
you might want to check that the material really got copied. You can do this by 
choosing Show Clipboard from the Edit menu. The copied material is there, 
right? You can hide the Clipboard either by closing its window (click its Close 
Box) or by clicking on some visible part of your MacvVrite window and thus 
putting the MacWrite window on top, concealing the Clipboard window 
below. 

As in MacPaint, Copy is not the only way to put material on the 
Clipboard. If you want to remove the selected text from its current location, 
yo u can Cut it instead. After you've selected the text so it is in inverse video, 
just type Command -X to remove it and put it on the C lipboard. Or, if you 
prefer, you can pull down the Edit menu, drag to Cut, and release the mouse 
button. 
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Whether you use Copy or C ut to put material on the Clipboard, you can 
paste the new material with the Paste command, available either from the Edit 
menu or b y typing Command -V. You can paste the C lipb oard contents in the 
same document b y scrolling to the new loca tion, clicking an insertion point, 
and pasting there . 

If you want to paste the ma terial into a different Mac Write documen t, you 
can C lose the current d ocument and O pen the one to which you want to add 
the material. So long as you d on't turn off the computer, or press the rese t 
button, or put something else on the Clipboard, the material you copied to it 
will still be there when yo u go to work on the new d ocument. J ust select an 
insertion point for the ma terial and do the paste. 

You can even paste text copied from a MacvVrite doc ument into a 
MacPaint document. After you load the Clipboard with a Cut or Copy, you 
must q uit the MacWrite application and open the MacPaint document you 
want to paste the C lipboard's material into. When you do the paste in 
MacPaint, the text w ill appear in a selection rectangle, so you'll be able to 
position it exactly where yo u want it. The transferred text w ill lose its special 
format attributes-boldface, italics, underlining, and so on-when it is cut and 
pasted between two applications. 

Other Ways to Select. Dragging is only one way to select text in Mac Write. 
You can select a single word by p ointing anywhere in the word with the 
I-beam pointer and d ouble-clicking. The word will then appear in inverse 
video, read y to be cut, copied , d eleted w ith backspace, or replaced by new 
text. 

If you want to select a large bod y of text-more than appears on the 
screen-you can do it by dragging dow n (or up ) through the text. When you 
get to the bottom (or top) window boundary, the text will just keep scrolling as 
long as you keep dragging. If you run out of table space, d on't forget that you 
can lift the mo use up without releasing the button, reposition it on your 
ta bletop, and continue dragging. 

An even easier way of selecting lots of contiguous text, however, is to use 
Shift-Clicking. C lick the start of the area you want to select. Then use the scroll 
bar to get the end of the text you are selecting in the w indow. Position the 
I-beam at the end, hold down a Shift key, and click the mouse. Behold! All the 
text between the first click and the Shift-Click is now selected . 

The Two Ways to D elete. Selected text can be deleted either b y typing the 
Backspace key or b y C utting. From the author/ editor's viewpoint, the main 
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difference between the two is that a deletion done by cutting is Undoable, 
while material d eleted with Backspace is soon gone forever. Backspace makes 
sense for deleting small amounts of tex t. It's quick and easy. Cutting is 
preferable w hen large amounts of text are being deleted; it gives you a 
measure of fallback safety that mos t of us find we need from time to time. 

You can recover backspaced text immediately after you d o the back
spacing (be fore you backspace somewhere else, for example) . If you type 
Command-Backspace repeatedly, the previously deleted characters will 
reappea r one-by-one, starting with the most recently backspaced character. 

Rulers, Headers, and Footers. MacWrite is a presentation-oriented word 
processor. This means that it provides many tools for preparing well
fo rmatted printed texts. Rulers make it easy to set margins, tab stops, line 
spacing, and features like centering and full justification. You can change these 
features within a d ocument b y inserting a new ruler wherever you want a 
major format change. To insert a new ruler, simply use the Insert Ruler 
command from the format menu. A new ruler will be inserted at the last 
inserti on point. C hange whatever format features you want to modify for the 
new section on the new ruler. The following text will all reformat to meet the 
new specifications, up to the next ruler. 

There is another way to change rulers. You can make a Copy of a ruler, 
such as the one at the beginning of your document, and then Paste it in at the 
point where the new format should start. This technique is particularly useful 
if you have several formats you want to switch back and forth between in your 
text. Keep a ruler for each of the formats you want to use at the b eginning of 
your d ocument. Then yo u can always move to the beginning, copy a ruler, and 
then paste the copy in a new location. 

H eaders and Footers let you specify how many blank lines you want at 
the top and b ottom of every page, as well as giving you the option of 
speci fying head er or footer text. You can also put icons in the header or footer 
that will be printed out as the current date, time, and page number. 

T abs. You can move copies o f the tab icon to appropria te locations on the 
ruler in order to set tab stops. As with a typewriter, when you type the T ab key, 
the insertion point w ill move to the next tab stop. Unlike a typewriter 
however, moving a tab on a ruler will affect the text tha t follows that ruler. 
Another way tha t MacWrite tabs are different from most typewriter tabs is 
that you can untab with one stroke of the backspace key. You don't have to 
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type a nu mber of backspaces to get back to the point a t which you typed the 
tab . 

Fonts. The number and variety of fonts, type sizes, and font styles really give 
MacWrite -formatted d ocuments a special appearance. But the different font 
styles and sizes make it difficult to answer some quite ordinary questions your 
friends might ask about the computer . A conventional question about a 
business computer is " Does it have an 80-column screen?" If you use a 
12-point Geneva font with wide margins on the Mac, the answer to this 
question is probably "Just about. It varies, but it's around 78 columns." 

If you use 9-point Geneva, however, the answer would be much 
different. "O h, no. The Mac displays over one hundred characters per line of 
text on the screen." 

Neither answer is the right response to the question. The number of 
characters per line on the Mac depends on the font and size and style of the 
letters on tha t line. Table 2.1 gives an approximate count of the number of 
characters per inch for a number of commonly used fonts in different sizes. 

You can get fo nt changes and style changes as you enter a text, or add the 
changes later when you edit the whole text. If you want to change fonts or font 
sizes as you enter text, you must pull down the choices available under the 
Font and Style menus to make the changes. If you want to change some aspect 
of the text such as boldface, underlining, italics, outline, or shadow, you can do 
so either from the Style menu or by the shortcut of typing the corresponding 
Command key combinations. The Command keys for the style options all 
make sense-B for bold, U for underline, l for italic, 0 for outline, S for 
shadow, and P for plain text. All the style options except Plain can be 
combined. If you want to write a phrase in bold italics, just type both 
Command-! and Command -B before typing the word . 

When you are editing an existing text and want to change some portion to 
a different font, font size, or style, you should first select the text to be altered 
(by double-clicking a word or dragging or shift- clicking the relevant text ). 
Then choose the new font (or size or style ), and the entire selec tion will 
change. T he selection is still selected at this point, so you can make other 
changes in it without reselecting. This is convenient if you want to change a 
long segment of p lain text to be bold and italic, for example. Don't type any 
ordinary text while the selection is in inverse video or it will all be replaced. 
Once you are happy with the changes you've mad e to the selection, click 
somewhere to deselect it. 
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Table 2.1. Average number of characters per Inch, different fonts 

Font Size Characters Per Inch 

New York 9 pt 17.0 
New York 12 pt 13.1 
New York 12 pt Bold 11.3 
New York 14 pt 11.4 
New York 18 pt 8.5 
New York 24 pt 6.6 

Geneva 9 pt 17.9 
Geneva 12 pt 13.0 
Geneva 14 pt 11.4 
Geneva 18 pt 9.0 
Geneva 24 pt 6.6 

Toronto 12 pt 11.0 

Chicago 12 pt 12.2 

Monaco 12 pt 11.5 

London 12 pt 13.5 
London 18 pt 9.2 

Athens 12 pt 14.1 
Athens 18 pt 9.7 

T o elaborate the style of a selected word or phrase, you can type the 
Command keys appropriate for the style you want. The style commands are 
"toggles"-if you want to change a phrase that is both underlined and 
italicized to b e italicized only, you can select it and then type Command-U for 
underline. Because the phrase is already underlined1 the underlining will be 
removed, and the phrase will only b e italicized. 

Special characters. Another feature that distinguishes the Mac from other 
computers is the number of special characters it can print on the screen. All 
kinds of special symbols (like£, ™, ¢, ©, §, 11, and e) and foreign language and 

0 

mathematical characters (such as {3 , ~ and A) are available from the Mac 
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keyboard in many fonts. You can type these symbols by holding down one of 
the Option keys, or sometimes both Shift and Option. 

Certain of the Option-plus-key combinations seem at first to produce no 
effect on the screen. If you type Option-u, for example, nothing appears on 
the screen, and the insertion point does not advance. But if you then type 
another key, such as the vowel a, you see the German a-umlaut, a. A key 
combination like Option-u followed by another key is called an OPTION -KEY 

COM BI:\IATION. This is a key that has no effect when first typed but, when 
followed by one of a certain set of other keys , produces an accented character. 
Another example is that Option-n followed by n produces n. 

The Macintosh fonts have room for new characters. If you pull down the 
Apple menu and select Key Caps, you can see what letters are provided. Hold 
down the Shift key to see the upper-case characters. Hold down the Option 
key and you will see many special characters. If you hold down both the 
Option and the Shift keys, you will see that many characters are blank. They 
appear as the symbol 0 . These blank characters present an opportunity for 
adding new characters to fonts. New fonts and expanded fonts are available to 
Macintosh users with special requirements. Special fonts for mathematicians, 
for linguists, and for writing in languages that use different alphabets are some 
of the optional fonts available. 

TECHNIQUES FOR GETTING THE MOST 
FROM MACWRITE 

One-Drive MacWrite 

If you are using MacWrite with one disk drive, you should make a special 
working disk to create enough room. As is always the case in working with 
computers, the amount of storage you seem to need is often just a bit more than 
what you have available. You need lots of free disk space to work with 
MacWrite because of the way it handles printing. When you request that a 
MacWrite document be printed out, there is a delay in which you are told that 
the Mac is "Now saving printed copy to disk." MacWrite builds a temporary 
document full of codes that instruct the printer on how to print the document. 
The temporary Print version is a good deal larger than the original, so you must 
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always have more free space on your disk than the largest Mac Write d ocument 
you might choose to print out. If there isn' t enough space for the print file, you 
will get the message "The disk is fu ll. Please try again." Don't b other trying 
again until you have removed some documents from the disk. You can keep 
MacWrite documents that you are not currently editing on data disks. 

Your one-drive Mac Write disk should contain the System Folder, so that 
you can boot with the disk, the Empty Folder, and MacWrite. When you are 
first putting the disk together, you should put Font Mover on it. Then open 
Font Mover and use it to remove any fonts you know you'll never use. If you 
aren't p lanning on creating the look of a handcrafted ransom note, you can 
probably do without San Francisco, for example. You may also decide that 
you won't ordinarily require London, Los Angeles, or Toronto. In any case, 
you can copy the fonts you remove to a backu p disk, using Font Mover, so that 
you can easily restore them if you ever must. When you've finished removing 
fonts, toss Font Mover in the trash to free up its space as well. Do this on your 
working copy only, not on the original disk! That should be stored in a safe 
place as a complete b ackup. 

Getting rid of unnecessary fonts will give you a lot more space on your 
boot disk- the one you start your Mac with. A word of warning, though: Don't 
remove the large versions of fonts you plan on using for high-quality printed 
output. You may b e tempted to get rid of 18- and 24 -point fonts if you plan on 
using only 9-, 12-, and 14-point in your documents. This would be a mistake if 
you plan on getting high-quality printouts. MacWrite very cleverly uses the 
18-point font, squeezed down to 9-point size, to make a crisper printed 
9-point p rinted text. Similarly, the 24 -point information is used to construct 
high-quality 12-point printout. This technique exploits the fact that the Mac's 
printers are capable of higher resolution-more dots per inch-than is its 
screen. If you remove the larger sizes of a font, then MacWrite will just 
"double-up" the information in the smaller font sizes to create the high -quality 
printout, with a less impressive effect. 

After you've thrown out some fonts, the Font Mover, and MacPaint, you 
should have a writing disk with lOOK bytes or more free space. This is enough 
room for several related documents you are currently working on, still leaving 
some free space for the temporary print file that MacPaint will create when 
you ask it to print out one of your texts. 

You have enough space on the disk that you can have a number of text 
documents on the disk. When you comple te a document and don't plan on 
working on it again immediately, you should put copies on your backup disks 
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(see Chapter 3). When you have several related documents on a disk, it makes 
sense to organize them by putting them into a folder with a name that 
identifies their class. 

To make a new folder, make a duplicate of the empty folder. Select the 
empty folder, then pull down the File menu and select Duplicate or, more 
simply, type Command-D. You'll then see a copy of the Empty Folder, 
named, appropriately, Copy of Empty Folder . This folder is currently 
selected , so you can simply type in a new folder name appropriate for the 
topic of the related MacWrite documents. Then drag the documents that 
belong together into the folder. Storing documents by folders makes it much 
easier to find them later than if they are lying around all over the desktop. 

Dummy Text Documents 

One way you can prepare to work most productively with MacWrite is b y 
setting up dummy documents. It takes a few minutes to set up the header and 
footer of a document. If you always use one set of headers and footers for 
letters, it seems a shame to repeat this effort every time you prepare a new 
letter. Perhaps you would like all your letters to include a graphic letterhead 
(Figure 2.4) that you built with MacPaint and to have page numbers at the 
bottom of the page . Instead of rebuilding the required header and foo ter 
every time you start a new letter, edit a dummy text document that already has 
that header and footer built in. 

The first step in making your own "stationery" on disk is to construct the 
material you want to appear in the MacWrite header. If you want graphic 
elements in the display, do it in MacPaint. Then Copy the graphic to the 
Clipboard . Leave MacPain t, open MacWrite with a new file, pull d own the 
format menu, and choose Show Header. Select the start of the header
position the mouse pointer there and click-and Paste the contents of the 
clipboard there. 

If you are willing to settle for an ordinary text letterhead ( Figure 2.5 ), you 
can just type in the material you want in the font, style, and size you want. You 
can choose to include the date, the time, and page numbers in the header or 
footer. 

Once you've put together your header and footer in the style you like, 
adjust the top text ruler to the margin and tab settings, line spacing, and 
justifica tion style you prefer. Finally, choose the font you want to use for the 
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Figure 2.4 A graphic letterhead 

text of your letters b y setting the insertion point at the b eginning of the letter 
and then choosing your preferred font, style, and size. DON'T ACTUALLY 
TYPE THE LETTER YET. 

Use Save As to store this almost empty d ocument. You might choose to 
call it Letterhead or E mpty Memo. Later, when you want to write a real letter, 
you can simply edit a copy of this one. One way to do this is simply to edit your 
Empty Memo, but d o a Save As to store the real memo or letter with a different 
name. 

The problem with deciding to do a Save As with a different name is that 
it's very easy to accidentally do a Save before you've given the document a 
different name. A b etter technique is to make a copy of the Empty Memo or 
Letterhead document in the disk direc tory window, position the copy where 
you want it, change its name from "Copy of Empty Memo" to "Memo to 
Alice," or whatever you want to call it, and then edit that copy. 
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You don't have to restrict your use of the almost-empty document trick to 
letter and memo formats, of course. If you are writing a series of documents 
that should all have the same format- the chapters of a report, perhaps-then 
you should use an "Empty Chapter" document as the basis for each of the 
documents that make up the report. 

Using such dummy d ocuments will help you maintain consistent formats 
for documents of the same type. They should also save you some time setting 
up appropriate d ocument formats. 

Printing single d ocuments with :VfacWrite is simple. If the document is open
that is, if you are editing it with MacvVrite-you just pull down the File menu 
and choose the P rint option (see Figure 2.6 ). If you want to print a document 
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Figure 2.5 A text letterhead 



56 WORDS 

I'" 

... 

' 

•IIJll Edit Search Format Font Style 

UseM Ch5.2 

~ 
Quality: Q High @Standard 0 Draft ( OK l 

il 0 From: D To: y Page Range: @ Rll 

Copies: D 
Poper Feed: (!)Continuous 0 Cut Sheet ( Cancel ) 

r·eport, pert1aps -- then you shou I d use an "Empty Chapter" document as 
the besis for· each of the documents that make up the report. 

Using such dummy documents wi II he lp you to maintain consistent 
iormats for documents of the same type. They should al so save you some 
time setting up flppropri ate document formats. 

Prinhng 
Pr·inting single documents with MacWrite i s simple. If tt1e document 

I 
i s open-- that is, if you flre editing it with MocWrite --you j ust pull 
down the Fi le menu ond choose the Print option. If you wont to print o 
document from a disk di rectory window, just select the document ond 
tl1en choose Print from the File menu. 

Figure 2.6 The MacWrite printing opttons 

from a disk directory window, just select the document and then choose Print 
from the File menu. 

A dialog box presents all the print options you have control over, 
including print quality, number of copies, and printing only part of the 
document. The initial release of MacWrite had a bug in the partial printout 
feature. If you tried to print out a document with page numbers starting a t, 
say, 20, you could not ask for the page range 20 to 22 to print out only the first 
three pages of the document. You had to ask for pages 1 to 3. Not even Apple 
Macintosh software writers are perfect, but this bug was repaired in the disk 
based version of MacWrite. 

Long Texts 

Suppose you have written a report that consists of three Mac Write documents: 
Report 1, Report 2, and Report 3. In order to make them print out with the 
correct page numbers, you must use the Set Page # option (in the Format 
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menu) while editing the second and third documents. The page numbers for 
the first one will begin with 1 automatically. When you finish your final editing 
of Report 1, note the last page number. Then, when you edit Report 2, use the 
Format option Set Page# to start the page numbers for this document with the 
next number. Follow the same procedure to make Report 3's page numbers 
follow appropriately from Report 2's. 

You should keep closely related documents in an appropriately labeled 
folder. If the three Report documents are in a folder called My Report, it is 
very easy to print all three in sequence. When you put the documents into the 
folder, arrange them in order, with the first document at the top left of the 
folder window, the next document to the right of that one, and so on. When 
you want to print them in sequence, you can simply drag a select box around 
them all. All the selected documents can now be printed in sequence-left to 
right in the window-by choosing Print from the File menu. That's not so 
hard. 

At some point you may find that you have to use MacWrite to produce a 
long text in which you can't leave blank space at the end of the page that is the 
end of the first Mac Write document. You'll wish, at this point, that you had 
chosen a different Macintosh word processor for this project. Have no fear, 
though. You can make it work. First crea te your long text with a series of 
MacWrite documents. Get the content, fonts, size, and style of each document 
just right. Don 't make any of the documents the maximum possible length; 
leave a little room for moving lines be tween documents. 

Once you've settled on the final form of your text, you can start moving 
material between tviacWrite documents to make the page boundaries come 
out right. If the last page of your first document is a partial page (as it almost 
always will b e), then cut it entirely. Save and Close that document and Open 
its successor. Paste the material you cut from the end of the first document at 
the beginning of the second. Then go to the end of the second document, cu t 
the partial page there, Save and Close, and Paste it at the beginning of the third 
document. As you move from document to d ocument in this way, use the Set 
Page # option to give the MacWrite documents the appropriate sequential 
page numbers. 

This process must be complicated a bit if you are using full justifica tion
both right and left margins a re even. If your removal of the last page of a 
document cuts a paragraph, then the last line of the page before will look 
funny. The last line will no longer b e justified to the right margin, since, so far 
as MacWrite is concerned, the paragraph now ends there. The only solution is 
to retype the last word of the paragraph. It will wrap around to make a new 
last page of one word. Make sure that the next Mac Write document starts with 
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the same page number. After you've printed the complete set of MacWrite 
documents, you can go through them tossing out all the one-word pages you 
had to have to make the justification come out right. Whew! Thanks to 
MacWrite, you won't have to do this often. 

Accidental Text Selections 

People sometimes accidentally select text they don't want. The secret is just to 
take it in stride. Suppose I want to select the word" difficult" in the text below, 
perhaps because I want to replace it with "awkward." I position the mouse 
pointer ( the I-beam) at the start of the word and begin dragging to the right. 
At first the drag selection is going OK (see Figure 2.7). My hand moves up a 
bit, and all of a sudden a lot of text on the line above is in inverse video (Figure 
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Figure 2. 7 Start of a text selection drag 
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to me. Do other peop 1 e never ecci dente I I y se I ect text they 
don·t want? 

A: It happens to me all the time. The secret is just to take it in stride. 

Disasters 

Suppose I want to select the word "difficult" in the text be iO'N, 
perhaps because I want to replace it with "awkward ... I position the 
mouse pointer ( t11e !-beam) et the stert of the word and begin 
dregging to the right. At f irst the drag selec tion is go ing OK. 

Figure 5.y 
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My hend moves up e bit inadvertently, end ell of a sudden a lot of text. 
on the line above is in inverse video. It's no pr-oblem, though. I just 

Figure 5.y2 
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Figure 2.8 An error In dragging text 

2.8 ). I t's no problem, though. I just move the mouse pointer back down and to 
the right a bit, and the word I want to select is in inverse video. Only then do I 
release the mouse button. 

Of course, it sometimes happens tha t I accidenta lly make a selection I 
don't want. Then I just select over again. 

People vvho find it difficult to select single letters by dragging with the 
mouse can just click after the letter, backspace to delete it, and then type the 
new material they want to replace it. That can be pretty fast too. 

If someone thoughtlessly turns off your Mac before you do a Save, there is no 
way to recover your work without a time machine. Unlike MacPaint, 
MacWrite doesn't use a temporary disk file to store your d ocument in while 
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you work on it. Your whole document is in the Mac's RAM-Random Access 
Memory. That's one reason you can go so quickly from the beginning to the 
end of a MacWrite document, with no disk accesses. If you turn your Mac off 
without saving, no trace of the d ocument exists. 

If you did routine Saves from time to time while editing, then the last 
saved version is still out there. If you didn 't, you will probably remember to do 
so next time! 

Keyboard Commands 

Figure 2.9 presents the menus of Mac Write. The menu options displayed with 
trailing command symbol-letter combinations can be chosen without using 
the mouse. You can issue these commands from the keyboard by holding 
down the command key and typing the letter. Learning to use these shortcut 
commands will increase your fluency with MacWrite. 



CHAPTER 

3 

62 

MANAGING YOUR 
MACINTOSH DISKS 
ABOUT THE MAC'S DISKS 63 
THE DISK DIRECTORY 64 
DIFFERENT VIEWS OF A DIRECTORY 68 
THE IMPORTANCE OF BACKING UP 69 
ONE-DRIVE DISK COPYING 71 
TWO-DRIVE DISK COPYING 72 
BACKING UP YOUR OWN WORK 72 
WHEN THE PARTY'S OVER 77 



About the Mac's Disks 63 

A data-base managem ent system would be worthless if there were no 
way to store informa tion for later retrieval. E very application for produc
tivity-word processing, spreadsheet systems, project managers, whatever
would be of no use if documents could not b e stored and then later retrieved 
and modified . 

When you use almost any application program on the i'vlacintosh, you 
enter new information (or edit old ) that is then stored on a disk. Your goal in 
using the application is usually not just to store information, however. You 
want a printed document or the display of informa tion on the screen. Storage 
of informa tion on a disk is a necessary intermediate goal, particularly if you 
plan on using the informa tion again. 

ABOUT THE MAC'S D ISKS 

The built-in disk drive on the Macintosh was designed b y Sony to meet special 
requirements established by Apple that ensure reliable storage of large 
amounts of information. Encased in the rigid plastic shell is a flexible plastic 
disk about 3)~ inches in diameter. Although there is nothing floppy ab out the 
protective case, the disk inside is very similar to 8-inch floppy disks and 5}~ 

inch mini-floppy disks. T hey are therefore often called MICRO-FLOPPY DISKS. 

O ne of the most important things the Mac opera ting system is responsible 
for is managing the use of the disk. It provides all the techniq ues tha t 
applications need to store or write informa tion to the disk, along with all the 
information needed to retrieve or read information from the disk. Computers 
cannot work q uickly and directly with information stored on disk. They must 
first read the information into Random Access Memory (RAM), where it can 
be readily manipula ted. The altered information can then b e written back on 
the disk, either replacing the original version or as a new set of information. 

If a computer is turned off before altered information is stored on the 
disk, only the original version w ill be available. This is the reason that 
computer users learn to save their work regularly. It exists only as an 
ephemeral sta te in RAM until it is saved to disk. 

The information is stored on a disk in FILES. A file is a set of data that are 
stored together on disk, something Hke the way a file in a filing cabinet holds a 
set of related data. A disk file is a set of information elem ents such as characters 
(letters), nu mbers, or machine instructions. MacWrite and MacPaint docu-



64 MANAGING YOUR MACINTOSH DISKS 

ments are files, as are the Mac Write and MacPaint applications themselves. In 
fact, every application, document, and set of data on the disk is stored in one or 
more files. 

THE DISK DIRECTORY 

A special type of file, the computer's DISK DIRECTORY, has information about 
the disk-how much it can hold, when it was initialized-and a list of all the 
files on the disk. Directories contain not only the names of the files on disks but 
also information about where the files are physically located. See Figure 3.1. 

Disk Directory 
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Figure 3.1 The Disk Directory concept 
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When an application directs the Macintosh to read from a particular file, 
the disk operating system uses the directory to find out where that file is. As 
you might imagine, if anything happened to ruin a disk directory it would 
ordinarily make the entire disk useless, since the operating system would not 
be able to find any of the disk's files. The operating system Apple developed 
for the Sony disk drives cleverly puts into each block on the disk information 
about what file the block belongs to. This makes possible the development of 
utility programs for reconstructing the directories of damaged disks. The level 
of care shown in the design of theM ac' s disk operating system is a reflection of 
the Macintosh development team's commitment to producing a very reliable 
computer system. 

In fact, the Mac's ROM (Read-Only Memory) already has a hidden utility 
for reconstructing certain types of bad disks. Suppose that some day you insert 
a previously good disk and your Mac spits it back out as bad. If the disk was to 
be your boot disk-a system disk that is used when you start up or reset the 
Mac-then first press the rese t button or turn the machine off and then on 
again. Then hold down the Command key and an Option key at the same time 
and reinsert the problem disk. Keep the two keys depressed until the drive 
stops whirring. This process can repair certain types of damaged directories. 
Any folders you had on the disk will disappear, but the documents and 
applications should all still be present, and the disk should once again be 
usable. You can then recreate the fold ers by making and renaming copies of 
the Empty Folder and putting the files in them. 

When you put a disk into a Macintosh disk drive, the Mac reads 
information from the disk directory into RAM. This makes it possible to get 
other files from the disk and lets the Mac know where the unused portions of 
the disk are, so that it can store new information on the disk. One sign that the 
Mac has read a disk's directory is the appearance of a disk icon on the desktop. 
When you open the disk, either by selecting it with a click and choosing Open 
from the File menu, or by double-clicking it, you open a disk window that 
reflects information in the disk's directory (Figure 3 .2 ). 

T he directory window doesn't actually show you everything in a disk 
direc tory. In fact, it doesn't even list all the files on the disk. Files that are not 
meant to be directly accessed by users aren't visible in directory windows. 
One example of such invisible files is the font files that are stored on the disk. 
To see what font files you have on a disk, you must use the Font Mover 
application. 

A i'vlacintosh disk directory window displays the contents of the disk-
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Figure 3.2 A Disk Directory window 

applications, documents, system files, and folders. APPLICATIONS are programs 
that you can use, such as MacWrite and MacPaint and the Font Mover. 
DocuMENTS are the data files you create through the use of applications. One 
of the clever aspects of the standard Macintosh user interface is that 
documents know what their applications are. This means that you can simply 
open a document and that its application (if it is present) will automatically be 
loaded to le t you work on the document. 

SYSTEM FILES are special data and code files that the operating system 
needs to make the Macintosh as easy to use as it is. Applications use parts of the 
system files routinely, but you don't have to worry about that. Just don't try to 
remove system files from the disk you use to start your Mac with-the Mac 
won't work without them. 

FOLDERS provide a very useful way of organizing a disk. Just as related 
documents in a file cabinet may be grouped in labeled folders, you can use 
Macintosh fo lders to group related documents. You can even use folders to 
create hierarchical groupings by putting some folders inside other folders (see 
Figure 3.3 ). 

In the disk directory window in Figure 3.3, there is a folder called "Using 
Mac- I" that represents the first part of this b ook. That folder is open, revealing 
several other folders, one for each of a number of chapters. Two of those 
folders are also open, for Chapters 3 and 4. Within each chapter folder are the 
MacWrite text documents that make up the chapter. 
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Folders can be opened to create folder windows in the same way tha t 
disks can b e opened to create disk windows. Y au can double -click the d esired 
folder, or you can select a folder with a single click, and then choose the Open 
command from the File menu. 

Folders aren't d ocuments themselves . They act more like directories, 
subdirectories of the main disk directory. Using folders makes it a lot easier to 
keep track of your work, especially on backu p disks, where you store copies of 
many different documents. The disk window in Figure 3.4 represents a disk 
with twenty-four documents on it. Seeing all these documents at once is a bit 
confusing, and understanding their relationships to each other requires paying 
careful a ttention to their names. When they are sensibly organized into folders, 
it is much easier to find wha t you want (Figure 3 .5). 
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Figure 3.3 Folders within fo lders 

., 



68 MANAGING YOUR MACINTOSH DISKS 

D RM backup 
32 lt•ms 343K 1n disk S7K ovo1Jobl~ 

0 ~ 
Ernply Folder Ne\>NoiDonce 

~ rJr1 
0 ~ 

Two Vols 
Kay Quotes 

~ 
0 

UseMOull 

~ 
F 1 . 12··-~ind\'1 

Kay on PCs 

[Q [Q ~ 
touchscreen2 touchscreen Finger 

0 
ESAS Derno 

Pam Loves old '-.lolo:-nlint> 

Figure 3.4 A disk window with many documents 

DIFFERENT VIEWS OF A DIRECTORY 

'v'olenline 

When you first booted your Macintosh system, it represented files as icons in 
your disk directory window. If you feel more comfortable with lists of files 
with no little pictures, you can choose to have files displayed as names, 
ordered alphabetically or by date, size, or kind (Figure3.6). Simply pull down 
the View menu to the choice you want. People with prior computer 
experience sometimes feel that Real Computer Users Don't Use Icons. Before 
you set about making your Macintosh display files in the same way that old
fashioned computers do, try working with the icon representations for a while. 

Supposedly the two halves of the human brain have significantly different 
information-processing abilities. In most people, the left half of the brain is 
particularly adept at understanding and working with words and numbers. 
The right half is the one that is skilled at certain pictorial and spatial tasks. 
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Perhaps using the icon representation of files lets both halves of the brain 
cooperate in the task of recognizing your documents and other files. I've found 
that I find the documents I want to work on in a directory window much faster 
when I'm using the icon representation than when I view the directory in some 
other way. Try more than one method yourself, but give the icon view a 
chance. 

THE IMPORTANCE OF BACKING UP 

The documents you create using Macintosh applications are stored on your 
disks as data files. The hard-shelled disks used in the Mac are extremely 
reliable. It is much less likely that anything will happen to data stored on such a 
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Figure 3.5 The same window, organized into folders 
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disk than if the Mac used ordinary floppy disks. On the other hand, there are 
ways for disaster to strike even the reliable Mac flopp ies. 

Mark King's three-year-old son wanted to see whether one of his dad's 
Macintosh disks would make a good raft for the action figures he played with 
in the bathtub. It didn't. It also made a very bad data disk afterwards, even 
when it had dried out. King had used his Mac to create the entire technical 
manual for Spurious Widget's newest product. Because it was an urgent job, he 
had worked on it using the Macintosh at work and, in the evening, on his home 
Mac. It had taken him four weeks to write, and the only copy had been on the 
disk/raft that wouldn't float. Mark wasn't very happy, and neither were his 
bosses, since his manual was supposed to go to press the day after the disaster. 
The story doesn't have a happy ending, except that Mark learned how to make 
backup copies of his work. 

Two months later, Mark's sixth-grade daughter demonstrated her science 
project on electromagnetism while Mark sat at his Mac in his home office. She 
put a giant electromagnet on his desk next to his box of working disks and 
turned it on. Disks store information in the form of many tightly packed 
magnetic fields, and they can easily become very mixed up when exposed to 
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strong magnetic forces. All the files on the disks closest to the magnet were 
destroyed. 

Fortunately, Mark had learned his lesson after the earlier ruined-disk 
catastrophe. He had recent backup copies of all his work on a nearby shelf, as 
well as a slightly older set of backup disks a t his office at Spurious Widget. 

Because the Mac's micro-floppy disks are encased in a tough plastic shell, 
they are a good deal less subject to catastrophe than conventional floppy disks. 
Still, you should protect them from liquids, excessive heat, and strong 
magnetic fields. Try not to spill coffee on them or drop them in the dishpan. 
Don't leave them on the dashboard of your car in the sun. A void placing them 
on televisions or other devices that generate strong magnetic fields. And b e 
prepared for disaster despite your precautions. 

Take Mark's experiences as a warning. Learn now how to make copies of 
your work, and do so in a regular and organized fashion. There are several 
different kinds of backup disks you should make. First, you should have a 
backup of any application disks. If two d isks are provided in the application 
package, consider keeping one some distance from your machine-in a 
building other than the one in which you do most of your Macintosh work, if 
possible. If a plumbing leak were to occur directly over the area where you 
kept your disks, you would b e very pleased to have a backup somewhere else. 

ONE-DRIVE DISK COPYING 

Although it is possible to copy a disk by dragging its icon into another disk's 
icon, the process is time consuming on a Macintosh without an external drive 
because it requires that you exchange disks many times. Instead, use the Disk 
Copy utility application provided on your system disk. By using every 
available byte, it lets you copy a disk with only four disk swaps on a 128K Mac. 

Adding a second disk drive to your Macintosh is one of the best ways to 
encourage yourself to back up your disks. Having the external d rive increases 
the usefu lness of many applica tions programs, as \veil. When you are using 
applications that are not limited to available space in RAM, such as Microsoft 
Word (described in Chapter 10) or T elos Filevision (see Chapter 7 ), you can 
create much larger d ocuments when you use a second disk drive. You can also 
deal with larger sets of documents when you use an external Macintosh disk 
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drive. For example, you can select a larger group of MacWrite documents for 
sequential printing. 

TWO-DRIVE DISK COPYING 

It is very easy to copy a complete disk if you have a Macintosh with two drives. 
Boot with the application disk in the built-in drive and a blank disk in the 
second drive. A dialog box will prompt you through the actions required to 
initialize and name the blank disk. At this point, icons for both the application 
disk and the blank backup disk are on the screen. Just drag the icon of the 
original disk to the icon of the backup, and your Mac will take care of the rest. 
When the copying process is complete, select the backup disk and eject it. Put 
it in a safe place. Don't forget to label it first. That will make finding it much 
easier, should you need it later. 

Many commercial applications are not fully copyable. Some applications 
can be copied, but require that the original disk be inserted once whenever 
you start up a copy of the application. Other applications programs seem to be 
copyable, but the copies do not work at all. Copyable software is a great 
convenience to the user. If you have purchased an application that can be 
copied, don't make copies of it for others. Distributing commercial software 
steals from the developers and discourages the production of copyable 
software. 

BACKING UP YOUR OWN WORK 

Making whole disk copies is not the usual way of doing backups. You 
ordinarily work with only a few documents at a time, and your backups should 
be done on a few-fil es-at-a-time basis. A good rule of thumb is to back up 
your work any time you would feel more than merely annoyed to lose your 
most recent additions or changes. 

It would not make sense to back up a whole disk every time you change 
one or two files on it, and it usually takes less time to back up a file or two than a 
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whole disk, particularly if you are using a second disk drive. You may find it 
convenient to organize your documents into folders (see the Appendix, 
"Mouse Skills") and then back up by folders. 

For most Mac users, it makes sense to have three kinds of disks: backup 
application disks, working application disks, and document storage disks. 
BACKUP APPLICATIO:-.J DISKS are the copies of your application disks, which you 
keep in a safe place. WORKIC\G APPLICATION DISKS are disks that have system 
files and applications. In some cases, these disks have to be modified from the 
form of the original application distribution disks for you to get the most from 
them. Docu;-..fE T STORACE DISKS are disks without system or application files, 
where you store the documents you create with applications. 

A 400K-byte Macintosh micro-floppy disk has enough room for essential 
system files, an application, and (very roughly) lOOK b}' tes for document 
space. For most applications this is a reasonable amount of working space, 
even though some of it may have to be reserved for temporary print files
such as MacWrite requires when it prints documents-or for temporary files 
required by some applications-such as those used by MacPaint. 

If you use a specialized MacPaint working disk, you have enough free 
space that you can freely save copies of a work in progress, each with a slightly 
different name. When, as often happens, you wish you could go back to an 
earlier version of the picture, you have one stored right there on your Paint
Work disk. If you have such a Mac Write disk, you can work on a thirty-page 
book chapter, stored as three or four documents on your Write-Work disk. 

To make an application work disk like Paint-Work or Write-Work, just 
make a copy of the release disk-the original one you purchased-and remove 
from it everything you don't need. Then put applications that aren't required 
for using the main application, such as Font Mover itself, in the trash. Don't do 
this to the original application disk or to its stored backup. You may want to 
use such minor applications some day. 

Some application disks, such as the one that Microsoft's Multiplan is 
released on, use a protection scheme that requires that the original disk be 
present when the application is opened. It is easy to copy the contents to 
another disk, but when you open the copied Multiplan application, one is 
prompted to insert the original disk as a check. This approach to copy 
protection makes it easy to use Multiplan on a Macintosh hard disk drive, such 
as Tecmar's MacDrive or the Corvus hard disk. 

Working application disks are the ones you keep with your Mac. Aside 
from essential system and application files, they contain only a few docu-
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ments, usually a group of related documents you are currently working on. 
When a d ocument or small set of documents is in reasonably good shape and 
you want to go on to work with other documents on the disk, it's time to put 
copies onto Document Storage Disks. 

To make a d ocument storage disk, initialize a blank disk and give it a 
name that refl ects the na ture of the d ocuments you plan to put on it. If it will 
contain all the files you are developing for use in your company's annual report 
for 1985, you might call it "Annual Rep '85." This disk may eventually contain 
documents mad e with a number of different applications, including MacPaint 
pictures, MacWrite text fil es, and Multiplan spreadsheets. 

If you are a cautious computer user, you wi11 create a second, d uplicate 
storage d isk for backup of your documents and store it in a separate location. 
In the case of the disk with the annual report, you should probably initialize 
another document storage disk and call it "Annual Rep '85 BACK." 

Mark King used two document storage d isks after his son's disk-rafting 
experiment taught him the importance of being backed up . When he b egan 
work on the user's guide for a new Spurious product, he initialized one disk as 
"NewUsersGuide" a nd the other as "NewUsersGuide BACK." 

Mark b egan his work on the new user's guide b y using a Macintosh 
program called T hinkTank, described in Chap ter 6. ThinkTank is an 
application that helps users develop complex, fl exible outlines. Kin g's work 
with ThinkTank led him to decid e that the manual would have a number of 
chapters. Most chapters would consist of several Macintosh d ocuments . Table 
3.1 is only the top level of planned organiza ti on for the user's guide. Each of 
the "major elements" has its own suboutline and set of notes that Mark made 
with ThinkTank. 

Mark's plan call ed for a separate folder for every major element except 
the cover. T he entire project called for the use of twenty d ocument files
eight MacWrite documents and twelve MacPaint pictures. A disk directory 
window with twenty such documents jumbled together \Vould look a bit 
confusing. Instead , the disk directory for his disk labeled "NewUsersGuide" 
had only seven items-a MacPaint d ocument called "Cover" and six folders, 
each labeled as a chap ter or appendix (Figure3.7 ). T his organization made it a 
lot easier for Mark King to find the d ocuments he wanted. 

Mark's home Macintosh has only one disk drive, so he made separate 
working disks for MacPaint and fvlacWrite. When he wanted to edit the text 
fil es from a section o f the user's guide, he put those files on his" vVrite-vVork" 
disk. 
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First he booted the system with Write-Work. To boot with a new system 
disk, you first eject the currently inserted disk. Then press the Reset key you 
installed on the left side of your Mac. Insert the new system disk, such as Write
Work, and your Mac will act as though it had just been turned on and had that 
disk inserted. Naturally, if the Mac were already off, you would simply turn it 
on and insert the boot disk. 

After booting with Write-Work, Mark would ejec t the disk (by typing 
Command-E) and insert the disk with the files to be edited-in this case, 
NewUsersGuide. If he wanted to work on Chapter 2, he would then double
click on the folder icon labeled "Chapter 2." He then would drag a selec t box 
around the two Mac Write files in this folder, "Control Functions" and "Setting 
Internal Options." At this point he could drag the selected icons over to the 
open Write-Work window (see Figure 3.8). 

Dialog boxes would then prompt him to make disk exchanges until copies 
of the two text files were placed on his working disk. After he made the 
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changes he wanted on these files, he would transfer copies to NewUsersGuide 
and to NewUsersGuide BACK. When he needed space on his working disk to 
edit another document, he could simply put these documents in the trash, since 
they were safely duplicated on two separate storage disks. 

At work, Mark uses a Macintosh with a second drive. On this sys tem itis 
more convenient to boot with a working disk that has both MacWrite and 
MacPaint, because it isn' t necessary to leave as much space on the boot disk for 
working documents. Mark puts NewU sersGuide in the second drive, opens its 
disk directory window, and opens the folder window that contains the 
documents he wants to work with. Then he just double-clicks the document he 
wants, and the appropriate application (Mac Write or MacPaint ) is auto
matically loaded from the internal disk into the Mac's RAM. 

As with the single-drive method, after Mark has modified several 
documents he copies their new versions onto the appropriate backu p 
document disk. Sometimes Mark isn't certain which version of a document is 
most recent- the one on his ordinary document storage disk or the one on the 
backup disk. When this happens, he opens windows for the folders that 
contain the two versions of the document. Then he selects one of the 
documents in question and types Command-! to Get Info on it. He notes the 
time that the document was last modified, closes the info window, and then 



When the Party's Over 77 

selects the other document and gets info for that one. The most recently 
modified version is now identified. 

WHEN THE PARTY'S OVER 

f" 

Most projects, thankfully, come to an end. When the actual new user's guide
"Spurious Ultimate 'Widget Manual"-was published , Mark King breathed a 
sigh of relief. But he didn't throw away all the documents associated with the 
project. Instead, he renamed them, calling NewUsersGuide "UWidgMan
Archive" and making NewUsersGuideBACK "UWidgManArchiveBACK." 
He put the former on a shelf in his home office and the latter in a file folder at 
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the office. An ARC HIVE DISK is one that stores d ocuments that are no longer 
under development but in a finished state. 

Sometimes when you finish a major project you will feel that you never 
want to see any of the documents connected with the p roject again. Don't 
throw them away. A month or a year after the end of the project you may find 
you want to produce a drawing very much like one of the figures you did for 
the current project. Think how nice it will be to take a copy of the old drawing 
from an archive disk and modify it for the new purpose, ra ther than have to 
recreate the whole thing from scra tch! 

Printed Directories 

D 

O ne problem with making effective use of the material stored on archive disks 
is that it's very hard to remember what is on them a few weeks or months after 
you've put them on the shelf. The solution is to keep printed directories of disk 
contents (see Figure 3.9 ). You can produce p rinted directories of different 
sizes and levels of detail using your Mac. I like to print two kinds of directories 
for my archive disks. One squeezes the top-level information about a disk onto 
a small area of paper. With a pair of scissors, I trim this printout and then fold it 

NewUsersGuide 
Size Nome Kind lost Hodifitod 

OK 11\jtpNH( i K 1 folder WE-d , Mar 21, 1984 tQ 
45K 11\jtpNH( i 1< 2 folder WE-d, 1"1ar 21, 1984 

50K ehoptu , fold~r Mon, Mar 5, 1 984 

71K Chaptu 2 folder Wed , Mar 21, 1984 

45K Choptu 3 folder T ue, Mar 6, 1984 

43K ct.optu 4 foldt-r Sot, Mar 1 7, 1 984 

3K Ctl"t'i~r document Sot, Feb 1 8 , 1 984 

OK f.mpt9 r «>ld~r folder Tut', Mar 6, 1984 0 
~I lQ '21 

Figure 3.9 Printed mini-directory, viewed by name 
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so that I can slip it into the little plastic bag that holds the 3}~-inch disk itself. 
Now I can flip through my box of stored disks and immedia tely get some idea 
of what's on them. If you use this method, you won't have to put each disk into 
your Mac and open its directory window when you are searching for a 
particular document. 

To make such a printed directory, simply bring open the directory 
window on the screen. Choose an appropriate view. If there are many 
documents on your disk, you should change the view to one of the non-icon 
displays-viewing by name, by size, by date, or by kind-so that all the 
document names will fit in the window. Size the window so that it displays 
everything. That is, drag the size box so that the window displays all the 
names. To print this display of the disk documents, type Command-Shift-4. 
This prints the active window-the one with horizontal lines in the title bar. 

You can use the same technique to print directories for individual folders 
on a disk. Or you can open several folder windows on the display, positioning 
them so that they present a tiled rather than overlapped appearance. To have 
them all printed together, depress the Caps Lock key before typing 
Command-Shift-4. That will make the whole display print out. You can fold 
up the whole screen print and keep it with the disk. 

As you've already learned in Chapter 1, you can print a special directory 
for the MacPaint documents on a disk. All you have to do is choose Print 
Catalog from the MacPaint application. If you have many MacPaint pictures 
on storage disk, this printout will be too large to fold up and keep with the disk. 
You might want to consider keeping a file folder of directories for your disks. 
Such a folder can contain both the special MacPaint pictorial directories and 
screen prints of ordinary windows. When you need to find an old document, 
you can quickly flip through your printed disk directories to find it. 
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A spreadsheet application lets a user create and edit a spreadsheet-a 
large display of rows and columns that can contain words and numbers 
(Figure 4 .1 ). Such spreadsheets are widely used in business for budgeting and 
for other forms of financial planning. They can be adapted for a much wider 
range of uses, however, including making tables of text items or even 
recording students' grades in a fl exible computer-based gradebook. 

You can use the keyboard to enter values for particular locations in the 
spreadsheet. The real power of spreadsheet programs, however, is that they 
let you specify the values of some locations by r ules. For example, you can tell 
the program that the value to be displayed in a certain location should always 
be the sum of the values in the eight locations above it in the column. 

Financial worksheets have long been used in business for planning and 
forecasting. The work was done using large sheets of paper divided into rows 
and columns, and arithmetic operations were performed using a calculator . 
When this manual technique was the only means for doing spreadsheets, 
making any change to the worksheet was a painful process. Because subtotals, 
totals, and other figures ty pically depended on the altered value, many cells 
on the worksheet would have to be recalcula ted b y hand every time there was 
a change. 

A computer-based spreadshee t makes changing values very easy. Recal
culations can proceed automatically, showing all the new values ' 'vithin a few 
seconds. 

USING MULTIPLAN-AN EXAMPLE 

The firs t spreadsheet application created for the Macintosh was Microsoft's 
Multiplan. Multiplan is a powerful program-an earlier version won 
l nfoworld magazine's award for best software package of 1982. T he 
Macintosh version has a number of impressive new features that exploit the 
graphics capabilities of the Mac and let the user construct formulas by 
pointing with the mouse rather than b y typing references to cells. Consider an 
example of how a simple budget can be prepared with Multiplan. 
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The Base Canard Widget Project Budget 

Mark King had spent several weeks developing the plans for a major new 
research and development project a t Spurious Widget, Inc. The new project, 
the "Base Canard Widget," would take about two years to develop, using his 
current staff. Mark developed a preliminary project proposal, outlining the 
effort and the expected benefits. At an early afternoon meeting he presented 
the concept to his department manager and the divisional vice-president of 
Spurious. They agreed that the idea was a timely one, offering significant new 
growth opportunities for Spurious. They told him to have a project budget 
drawn up for a ten o'clock meeting the next day. 

Naturally, they expected him to stay up half the night, working out the 
budget and totaling and checking his figures. Mark produced the preliminary 
budget shown at left in just over an hour. Here is how he did it. 

He began by starting up Multiplan, double-clicking the Multiplan icon 
(Figure 4.2 ). Since he hadn't selected an existing Multiplan document, the 
application opened a spreadsheet labeled "Untitled." Mark decided to begin 
his budget by listing the job titles of the people who would be involved in the 
project. To put a name into a cell of a Macintosh Multiplan spreadsheet, all you 
have to do is position the mouse pointer at the cell you want to use ( Figure 4.3 ). 
Then, to put a label-an alphabetic string-into the cell, click the cursor to 
select the cell, and type in the name. 

As Mark typed the name of the first label, it appeared in the formula bar at 
the top of the desktop as well as in the selected cell. When the name he entered, 
"Project Director," grew too large for the cell, the new letters continued to 
appear only in the formula bar as they were typed (Figure 4.4). Mark accepted 
the contents of the formula bar as the contents of the cell by typing the Return 
key. At that point, the cell was displayed in normal rather than inverse video, 
and the cell below became the selected cell. 

Mark successively entered the titles of a ll the staff members associated 
with the planned project b y typing the text of their titles and typing return 
(Figure 4.5). After all seven members of the team had been listed, the selected 
cell was at Row 11, Column 1 (shown as RllCl at the beginning of the formula 
bar). Then Mark wanted to put some titles across Row 3. He positioned the 
pointer and clicked the mouse button at Row3, Column3 (R3C3) . He typed 
"%on Project" for the text of this cell, but then typed the Enter key rather than 
the Return key to accept the title. This kept R3C3 as the selection. :--low typing 
Command-H made the title right- justified in the cell. 
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,. • File Edit Uiew Specil!l 

LJLJ 
MIAtiploo.Htlp S~sltro Foldtr Efll>IY Foldtr 
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Figure 4.2 The MuHiplan Disk Directory window 

Command-H may sound like a strange mnemonic for right-justification. 
The reason the key command is not Command-R is that that key combination 
is used in Multiplan to execute another common function, Fill Bight. The three 
cell-justification key commands are Command-F, Command -G, and Com
mand-H for justifying the text left, center, and right, respectively. The way to 
remember these keys is that the G key is in the center of the keyboard, with F 
to its left and R to its right. Naturally, Mark could have pulled down the 
Format menu to choose the Align Center option, but like most experienced 
Mac users, he takes advantage of the greater speed of key commands when 
they are available. 

After centering the first column title, Mark moved to the cell to the right 
by typing the Tab key (Figure 4.6). He could just as well have used the mouse 

Figure 4.3 The mouse pointer shape for Multiplan cells 
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Figure 4.4 Entering text in a cell 
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Figure 4.6 Entering column titles 

to select the next cell for entry, but it is faster to use the keyboard when 
entering a sequence of items in a row or column. The Return key selects the 
cell below the current cell, and Tab selects the cell to the right. Shift-Return 
selects the cell above the current cell, and Shift-Tab selects the cell to the left 
(see Figure 4.7) . 

As he entered the "Monthly Rate" column title, Mark realized that the 
standard co lumn width (10 numerals) was narrower than what he wanted , so 
he selected all cells, and used the Column Width option from the Format menu 
to increase the column width to 12 (Figure 4.8). The new column size looked 
about right, but Column 2 was larger than he needed, since it was being used 
only for overflow text from Column l. Mark put the pointer on the vertical line 
dividing the headers of Columns 2 and 3, depressed the mouse button, and 
dragged a bit to the left. When he released the button, Column 2 had a more 
modest width. 

After getting the new column width, Mark hit the Tab key to selectR3C5 
and entered the word "Amount," which he centered. Next, he put the text 
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Tab 

Figure 4.7 Keyboard movement commands In Multiplan 

"Year One, January-June" in cell R2C4, typed the Enter key to accept the text, 
and typed Command -G to center the text. 

Mark planned on treating each year of the project in two parts, before and 
after the annual Widget salary adjustments, which take place on July 1. T o the 
right of the three columns reserved for the January-June data, he needed three 
columns for the corresponding data for July-December. Rather than type in 

,. ti file Edit Select Format Options Cal culate 

. ·· ·· · ··· ······· ·· ····· ······ .... .. .... ............. ... . ............ ..... . . . 

~r:~J.e~t : ~;;e~t;;:.· · :: :·:· :: :: :'l.· :o~ ·P:r-~j :.]'!'.tl411!': ·:?. :· :.::· .::· :::::: :·: :::.::::: 
~~-~-~!':~~~-~-~- -~0-~-~Q~.~- ....................... : .. .......... .. .... : .... ............. . .............. . .. . 
~~.~.i.~!':.~.~-~iQn.~.r: .......... ... .......... .. .... . : .. ..... ...... ..... ; .. ......... ........... ..... ........ . 
~~~rr .q~s-~9-~~r..l. ....... ......... ............ : .................... ..... ... . ..... ............ . . 
~~~rr. _q~s.i_9_~~rJ ... .. ..... . ................ .. : ................ : .. .......... .................... . 
q~.~-~!~P.~!':~.o.n .................................. : ............. ..... : .................... ............... , 
Clerk : . ; 
.... .. ... . .. ... .. .. .......... .... .. . ·············· ··· ··········· ···· ····· ·········· ····· -·· . . . . . . . . ........... .... ..... ................ . ........... .... ... : ....... .... .... ... :·· ·· ······· ... .. . 

. . 
············· ····=········ .. ········ ············· -· ···:········· ····· ···=······ .. ........ . . . . 

...... . .. . ... .... ..... ·· ·· · ····· ············· ....... 

Figure 4.8 Choosing a new column width 
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the three headings again, he selected the first three by dragging from R3C3 to 
R3C5 (Figure 4.9). All three appeared in inverse video. Mark copied them to 
the Clipboard by typing Command-C. Then he used the Scroll Bar to move 
the display to the right on the spreadsheet. He selected three cells in Row 3, 
from Column 7 to Column 9, and typed Command-V to paste the Clipboard 
contents into that location (Figure 4.10). 

Mark decided the blank column ( C6) wasn't necessary, so he selected 
several cells from Column 6, including R3C6, and used Command -X to cut the 
cell to the left of the"% on Project" title. The three new column titles shifted to 
the left to fill in the deleted cell (see Figure 4.11). If there had been material in 
the cells below the deleted area as well as to the right, Multiplan would have 
presented a dialog b ox to ask Mark whether he wanted the deleted cells to be 
filled from below or from the right. 

Mark decided tha t he wan ted to put a title on the worksheet, but he 
needed more room at the top. He put the mouse pointer on the header for Row 
1- the little box a t the left of the first row-and clicked the mouse bu tton 

Format Options Ctllculote 

Figure 4.9 Three cells selected 
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Figure 4.10 Pasting a copy of the three cells 
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while holding down a shift key. Doing this twice added two new rows to the 
top of the page, shifting everything he'd typed so far two rows down. He then 
added title captions at R1C5 and R2C5, both centered by typing Command-G 
(see Figure 4.12). 

Since he would want to get total salary costs fo r each period, Mark put the 
text title "Total Salaries" a t R14Cl. He also labeled Rl5Cl with the word 
"Fringe," aligning this one on the right side of the cell . T hen he put the fringe 
benefit rate, 24.3~, at Rl6C2. 

Now that the basic layout of the first portion of the spreadsheet was set 
up, Mark could fin ally start entering the numbers. First he entered the 
proportion of time that each project member would put in on the project in 
Column 3, Rows 6- 12. Then he entered the monthly salaries of those 
employees (Figure 4.13). He wanted to show the proportions of time 
committed to the project as percentages, so he dragged Column3 from Row6 
to Row 12 and then pulled down the Format menu, selecting the P ercent 
option. 
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Figure 4.13 The first numbers 

He also chose the Commas option from this menu, to make commas 
appear in numbers of more than three digits, for greater readability. This 
option always applies to the entire spreadsheet. Then he dragged through the 
monthly rate column ( C4) to select it and chose the Dollar option from the 
Format menu (see Figure 4.14). 

The next step was to compute how much each employee would cost for 
the six-month period in question. Mark selected Row 6, Column 5, which was 
to display the Amount to be budgeted for the projec t director (Mark himself ) 
for this period. All the values Mark entered in the "~ on Project" and "Monthly 
Rate" columns so far had been constant values, not dependent on other cells in 
the spreadsheet. The values of Column 6, " Amount," however, would depend 
on the values in these columns. 

Mark needed to define a formula that would control the value of the 
selected cell. He typed "=", which told Multiplan that he was about to enter a 
formula, rather than an absolute value, such as a text or a number. Such 
formulas give rules that make the value in the cell with such a formula be a 
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function of the values of one or more other cells. The rule Mark wanted to use 
was that the proportion ( in the cell two columns to the left) should be 
multiplied by the salary (to the immediate left of the cell being defined) and 
that that monthly cost should be multip lied by six, the number of months in the 
period. Mark was able to enter the required formula with just two mouse clicks 
and three key presses. First he clicked R6C3. The formula bar showed 
"=RC[-2] ", showing that he had referred to a cell on the same row, two 
columns left. He typed " 0 

" , the multiplication sign , which then appeared in 
the formula bar. H e then clicked the cell R6C4, and finally typed" 0 6". When 
he hit the Enter key, Multiplan calculated the result, $13,478.40 (see Figure 
4.15 ). 

Of course, Mark could have used his desk calculator or the Desktop 
Accessory Calculator to find out that0.6 o $3,744.00 o 6 is $13,478.40 and then 
entered that number as an absolute value. The advantage to using a formula is 
not only that Multiplan performs the ca lcula tion but also that it does so 
automatically, no matter what the value of the cells the formula refers to. 
Therefore, if Mark's superiors like his proposal so well that they award him an 
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unscheduled merit pay increase, he can modify the number $3,744 to the new 
value, and the cell R6C5 will be recomputed appropriately. 

The next step was to create similar formulas for the amounts to be 
allocated for other members of the project. First, he dragged the pointer 
through Column 5, Row 6 to Row 12. Then he typed Command-D to instruct 
Multiplan to fill the selected area below R6C5 with the same formula (Figure 
4.16). That formula does not refer to absolute locations, but only to cell 
locations relative to the cell whose value is being computed . This means tha t 
the filled area will not contain the same value as the first cell, but rather the 
appropriate values, the ones dependent on the two cells to the left. 

The next step was to compute the total salary budget for the period. Mark 
selected the cell a t Rl4C5 to hold this value. He typed"=" to let Multiplan 
know that he was going to enter a formula. To get the sum of the salaries, he 
simply typed the word "SUM" followed by the left parenthesis, and then 
dragged the mouse from R6C5 to R12C5. The area he had dragged out was 
enclosed in dotted lines. The dragging caused the formula bar to display a 
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Figure 4.15 A cell value determined by formula 
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Figure 4.16 For formula filled down 

relative reference to a range of values, "R[ -8]C: R[ - 2]C" (see Figure 4.17). 
The input to the SUM function was thereby defined as the range from the 
eighth cell above the current cell to the second cell above the current cell. To 
finish off the formula, Mark typed a right parenthesis-marking the end of the 
input to SUM-and then typed the Enter key. The screen then displayed the 
total salaries for the first six months (Figure 4.18) . 

T o determine the amount of fringe benefits for this period, Mark selected 
a new cell, R16C5, and defined it to be the product of the Fringe Rate (in cell 
R16C2) times the Salary T otal ( in cell R14C5). Again, Mark created the 
formula by using pointing inputs, so that all the references were relative to the 
current cell rather than absolute (Figure 4.19 ). 

At this point, even though less than a fourth of the entire spreadsheet had 
been crea ted, Mark had done most of the work. Everything else could be built 
on the founda tion he had already laid. To fill in the"~ on Proj." column for the 
second six months, Mark d idn't type in the figures again. Nor did he choose to 
use Copy and Paste. He reasoned that if he decided to change someone's 
percent effort on the project in the first half of the year, he would probably 
want it to carry over to the second half. So he simply set up the simplest 
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Figure 4 .17 Entering the form ula for total salaries 
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Figure 4.18 A sum entered by formula 
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Figure 4.19 Setting up the formula for fringe benefits 

possible relative formula for R6C6: he set it equal to the cell three columns to 
the left. He then filled this formula down through the next six cells, so that the 
same percentages are used in both halves of the year ( Figure4.20) . Still, he can 
always go back and change any of these values, replacing it with an absolute 
value or a different formula. 

To determine the values for the monthly rates in the second half of the 
first year, Mark assumed that those on the project would receive salary 
increases averaging 6 percent on I uly 1. He therefore d efined cell R6C7 to be 
equal to the earlier monthly rate (given three columns to the left) times 1.06 
(Figure 4.21 ). He filled this formula down through the next six cells as well, so 
that all monthly salaries were 6 percent larger than in the first half of the year. 
Following the model he used for the first three columns, he made the formulas 
for the salary amo unts for each member of the project and for the total salaries 
and fringe benefits (Figure 4.22). 

At this point, Mark moved down the page and entered some titles for the 
second year of the proposed project. He assumed that the same people would 
work on the project, so he defined a formula for the title of the first participant 
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Figure 4.20 A column defined by reference to another column 
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Figure 4.22 Second half of first year, complete 
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Figure 4 .23 Participant titles for the second year 
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in the second year. Again, he only had to select the new location ( R21 C1), type 
" = ", to start defining a formula, and point to the first title for Year One. 
Multiplan automatically built the formula that refers to the value fifteen rows 
above ("= R[ - 15]C" ] (Figure 4.23). Note that you can create formulas that 
produce text values, not onl y numeric values. As before, the Fill Down option 
let Mark copy a formula for a selected portion of the worksheet, so that all the 
participants' titles referred to those used for the first year. 

Y1 ark went on building theY ear Two portion of the spreadsheet, referring 
to relevant cells in the Year One section as he created the formulas that 
determined the new values. When both sections were complete, Mark set up a 
new column of annual totals in Column 10. Here he was again able to create a 
single formula that referred to the two Amount columns to the left, and use Fill 
Down to use that formula for the whole column (Figure 4.24 ). 

A Budget Summary 

Mark created a new portion of the spreadsheet, below the Year One and Year 
Two portions. The new section summarized the figures from the first portions, 
together with estima tes of the non-salary contributions to the project budget. 
Mark inserted text labeling the summarized salaries, fringe be nefits, and other 
expenses such as travel and equipment. 

He realized that there would not be enough room on a printed page to 
print all the cells he had crea ted already, along with the new ones below, so 
Mark selected cell R32C1 as a good spot for a printed page break. Then he 
pulled down the Options menu and chose Set Page Break (Figure 4.25). That 
separated the new lower portion of the spreadsheet from the upper. When he 
had finished , Mark had the bottom-line figure for his proposed project. It 
would cost $919,148.05, including overhead ( Figure4.26 ). He printed out the 
complete spreadsheet and pasted the four pieces of printout paper together. A 
company photocopier with reduction capability let him copy the whole 
spreadsheet to a single BH- b y-11-inch piece of paper (Figure 4.27). 

The printed spreadshee t served as the focus of Yfark's presentation to his 
department manager and the division vice-president the next morning. After 
some discussion, the department m anager convinced Mark that he could do 
the job with some reductions in sta ffing. They agreed that the junior staff 
designer could participate on a half -time basis on the project. Furthermore, 
the clerical duties for this project could be handled by a Level2 clerk as well as 
by a Level4. 
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Year T'w'O 1 July - December . . 1 
............................ . .... ...... . ................. .. .. .. ..... . ....... .. .................... . .. . .. '!' .. 

'!.on Proj. : Monthl y Rate : Amount: : 1 
.... ......................................................................... . ............. .. ......... ' I '" 

50.00'/.: $~ 1 206 . 76 $12 1 620.28 : : $2~ 1 526 . 20 I 
.......................................................................................................... 1"' 

33.00'/.: $5 1 079.80 : $10 1 058.00 : : $19 1 546 . 67 I 

:::::::::. :~~ ; :o:o~ : : :::s~; ::,::,? ; :s:~ :: =: ii :( ; :~:~~;:s~::~::: : : :::: :::::::::::: :: i~~ ;:o:z~ : ::,_~ :: : ::: 
100.00'/.: $3 1 213.50 : $19 1 280.96 : : $37 1 ~70 .56 I 

:::::.:::: :~~; :o:w: : )~ ;:s:a~ ; .?~:: : : Ii:~: ; :~:2~ : :z:s::: :::::::::::::::: ::·:: :: ·~:~~ ; :s:q~ : :2:~.: : ::: 
75 . 00'/. : $2 1 292. ~~ : $ 1 0 1 3 1 ~.65 : : $20 1 0~5.~5 I 

.... ... . . .......... . .. . . . .. . ............... . .................. . . ............................ . .. ...... 1' " 

I 00.001. : $1 1 998.88 : $11 1 993. 31 ; : $23 1 307.75 I 
........ ...... ..... : ............ . ..... : ............. ........ : . .. . .. . .......... . ··:·--·· ... .... .. .. . . .. . 1 . .. 

: : : : I ·· ·· ··· ·· · ·· ··· ·· · ~-·· · ·· ··· ··· ·· ·· ··· -~ ··ia? ~ ·z·29 ~ ·o9·· ~-·· ······· · ···· ·· ·· · ~ s· i 69~ ·s·zo ~·s·9 ·· : ··· 
................... : ...... . . ........... ·: .......................................... :···· .............. 1' " 

. . . . . .................................................. ...... ....... .. ................ ... . . . . . . 

Figure 4.24 The column of totals 
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r 4i File Edit Select Formnt Options Calculate 

Year One : :vear r ... o I .... ................. :·· ·· .. ·············· ·:··· ······ .. ······· ···•············· .. ····: ············ ·········:··· 
: : I . 

"I~~ : :~:t~Jtr-:_:_::: : ::.:::-:::.~~:~~:l~~;:::n : : :_ : :··::-:- : : :···: 
$13 833 . 64 : : $13 561,65 I ....... . . .. ....... . .............. . . . .. . . . . . . .. . . . 1 .. ... .. . .. ... 1 .. ... . ............ . 

$4 1 323.01 : : $4,238.02 I 
.................. . . : ···- ...... . ....... . .. : .... . ........... ' I " .... ....... . 

. : I 

·· : : : : : ;:o:~~; :a:1: ::::::::::: ·: : :: ::::: : :: :k~~;:?~~ ; :~:~ :: : ::: : ::: .::::::::::: : 
167 1 829 , 70 : :$167,215.20 I 
.... . .......... . .. : .................. : .... . .. .. """ ' " " I "''' ' ' ' ' ' '"'""" 

:I1:~; :~:qq::o:o : : : :: : :: : :: : : : : : :: : : : : : : ! : :::s~;:4:oq: :o:o: : !: : : :: : :::::: : ::::::: 
$62, 837.00 : : $33,126.00 I 

............... . . .. . . : · ··"'''"'"'"' ' ''':··· · · · "'' ' ' ' ''"'' ' ' 1'' ' '' ' ''''''' ' ' ' ' ' '' 

: : I ........... . ................................. . ................. 1 ... .. ............ .. 

krnMrn1rn63 . 51 : :$HO 984 . 54 1 

Figure 4.26 The bottom line 

"How long will it take to get the new budget figures based on those 
assumptions, Mark?" asked the department manager. 

" Less time than it will take me to walk down the hall to my office and 
back," he told her. "Why don't you two take a coffee b reak, and I'll be back 
with the new figures in five minutes." 

Mark opened his Canard project Multiplan document and changed the 
"~ on Proj." value for staff designer 2 to 50 percent. He also edited the Clerk 
designation to read "Clerk, Level 2" and changed the salary level appropri
ately (Figure 4.28 ). He made the Year Two change in time on project and then 
took a look a t the new bottom line displayed in R49C7. Before his bosses' 
coffee had started to cool, he had the new budget total back to them ( Figure 
4.29). 

Mark and his department manager went on to make extensive use of 
Multiplan in preparing more detailed budget plans. One feature they found 
very useful was Multiplan's ability to incorporate links from one spreadsheet 
to another. This made it possible to develop separate sheets with the 
breakdown of equipment expenses, for example, and to link the totals from 
those sheets to references in the budget summary section. Whenever a change 
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Figure 4.28 Modifying a spreadsheet 

is made in a source spread sheet, the effec ts of that change are automatically 
carried over into the spreadsheet to which it is linked. 

SHOWING FORMULAS 

After you have b uilt a .\1 ultiplan spreadsheet, you should archive it in the same 
manner tha t you archive other documents, as discussed in Chapter 3, 
" Managing Your Macintosh Disks." It also makes sense to create two paper 
archive versions of your spread shee ts. O ne archive copy is a printout of the 
entire spreadsheet with its final values, just like the ones given above in this 
chapter. The o ther type of paper archive is a printout of the spreadsheet when 
the Show Formulas option is selected. Show F ormulas has the effect of 
replacing values w ith the formulas that underlie them. Having a copy of the 
formulas of each of your spreadsheets handy helps make you ready to answer 
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Figure 4.29 The recalculated total 

questions about how the values of particu lar cells were computed (Figure 
4.30) . 

When you choose this option, the spreadsheet columns are doubled in 
size, to give enough room to present most formulas. Of course, you can still 
change column widths, so you can make the columns a li ttle narrower if they 
don't have to be twice as wide as normal. The spreadsheet can be printed with 
its formulas rather than its values displayed. Paste together the formula 
printout, make a reduced photocopy, and keep it with the printed spreadsheet 
that shows values. 

CHARTING IN MULTIPLAN 

For advanced charting, Microsoft's Chart program is clearly the best method 
for creating and editing charts related to Multiplan spreadsheets. However, 
Multiplan itself has some simple charting capabilities. You can choose to 
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display some cells in bar graph format by selecting them and choosing Bar 
Graph from the Format menu. Mark King wanted to give a q uick visual 
impression of the relative contributions of the major categories to the budget 
total. H e first used the split bar to create two separate "panes" in theM ultiplan 
window. On the le ft he displayed Columns 1 and 2. In the right panel he 
displayed the totals by ca tegory for the project. He increased the size of 
Column 8. Then he set up a formula for R38C8-the first relevant cell of the 
new column. The formula set this value to the value of the cell to the left, 
divided by 35,000. He filled this formula down through the column, and then 
chose the Bar Graph option. By typing Command-F, he aligned the bar charts 
to the left of the cells (Figure 4.31). 

OTHER KINDS OF SPREADSHEETS WITH MULTIPLAN 

Multiplan can be used fo r many things other than budget p lanning, of course. 
As you might imagine, one can easily prepare a spreadsheet form for 
preparing a financial statement. Multiplan can also be used for a variety of 

,. • File Edit Select Format Options Calculate 
., 
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Figure 4.31 A simple bar graph in Multiplan 
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other financial applications . A number of books on Multiplan describe 
methods for cash management, debt management, fixed asset management, 
working capital management, quote preparation, inventory management, 
billing, commissions calculations, and so on. Two examples of such books are 
referenced at the end of this chapter. 

Multiplan has other uses, including many that have nothing to do with 
business or finance. Writers may choose to construct text tables using 
Multiplan rather than MacWrite or Word. This process is described below, in 
Chapter 10. 

MULTIPLAN'S COMMAND KEYS 

Figure 4.32 presents the Multiplan menus which mark the special key presses 
that can b e used to issue commands from the keyboard rather than pulling 
down a menu for every step. 

BOOKS ABOUT MULTIPLAN 

The Power of Multiplan, b y Robert E. Williams, Portland, Ore.: Management 
Information Source, 1982. 

This book presents ten different exercises for students of Microsoft Multiplan, 
ranging from "Invoicing from Inventory" to "Calculating Cornmission Using the 
Iteration Option." The book does not assume a Macintosh, so the reader must 
translate the book's instructions to type, for example," RUC5" to mean to point to 
the cell at Row 11, Column 5. 

Multiplan Models for Business, b y Douglas F . Cobb, Gena B. Cobb, and 
Thomas B. Henderson. Indianapolis: Q ue Corporation, 1983. 

This book presents models for eight major Multip lan application areas: cash 
management, debt management, fixed asset management, working capital 
management, financial statements, planning and budgeting, and quote p repara
tion. This book contains a great deal more explanatory text than the Williams 
book d oes. Like that b ook, it does not include Macintosh-specific instructions. 
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Making a Pie Chart 111 

Microsoft's Chart application is a specialized application for the pro
duction of presentation graphs. With Chart, you can quickly and easily create 
area charts, bar charts, column charts, pie charts, line charts, and scatter plots 
(see Figure 5.1). Chart takes advantage of the Macintosh's crisp, high 
resolution display and rapid graphics capabilities to automatically construct 
graphs on your screen and in p rintouts, based on sets of numbers you enter. In 
Chart's terminology, each such set of nu mbers is called a SERIES or a DATA 

SERIES. Chart lets the user enter a series and graph it in any one of a number of 
standard Chart styles. 

MAKING A PIE CHART 

At the second presentation of Mark King's proposed project, described in 
Chapter 4, his division vice-president casually remarked that the proposed 
budget was still rather large. Mark decided to produce a couple of pie charts to 
convey quickly what proportions of the b udget were going to d ifferent 
categories. To begin, he started up his Mac with the Chart disk (Figure 5.2). 

Mark opened Microsoft Chart b y d ouble-clicking its icon (Figure 5.3). 
Two windows are open whenever you begin working with a new chart. One is 
the chart window itself, here labeled "Untitled ." This is where the chart you 
create will appear. The other is a window labeled "New Series." This is where 
you will enter the series of numbers that are to be charted . 

Mark chose to b egin his Chart session by specifying the form of the data to 
be entered. He pulled down the Data men u and selected the Text option. This 
means tha t the series of numbers to be plotted will each have a name. Other 
data options include entering a numbered series or a series based on the days 
of the week. A d ialog b ox labeled "Text Series" opened on the screen (Figure 
5.4). The default name of the series is simply the word "Series" with the 
current time. 

Mark used the standard text-editing techniques to give the new series the 
name "Canard Budget Categories." He also set the X-axis label to "Major 
Category" in p lace of X, and "Dollars" in p lace of Y (Figure 5.5) . After he 
clicked the "OK" button in the d ialog box, a new vvindow appeared on the 
screen with the title "Canard Budget Categories" (Figure 5.6). 

Before actually entering the values to be p lotted, Mark used the Format 
window to set up the fo rma ts to be used for the categories and values he 
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Figure 5.6 "Canard" series window 

planned to enter (Figure 5.7). For the Categories, he chose to align the names 
on the left. For the Values, he accepted the defau lt alignment, on the right, but 
specified that the text "$ " should precede each value (Figure 5.8 ). The reason 
Mark didn't choose the " Dollar" number format is that he didn't want to 
include the two decimal places for cents. 

After clicking the "OK" button in the Values dialog box, Mark entered the 
names and rounded off dollar values of the major budget categories in the 
Canard projec t budget. The process consists of simply typing in the first name, 
hitting the Enter key, typing in the first value, hitting Enter again, then typing 
the second name, pressing Enter, and so on (Figure 5.9) . 

At this point, Mark had to choose which type of pie chart he wanted to 
display. One of his goals was to show that almost half the project costs were 
indirect. For this reason, he had listed the two major indirect expense 
categories, overhead and fringe benefits, next to each other in the series . 
Because he wanted to show the relative contribution of each ca tegory to the 
total expense of the project, he chose to present the data in a pie chart. He 
pulled down the Gallery menu ( Figure 5.10) to Pie and was presented with six 
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options fo r different types of pie charts {Figure 5.11). He chose the fifth one, 
which presents the segments of the pie w ith different shad ings and their 
category lab els. 

Clicking the "OK" button closes the Pie C hart gallery, and the new 
selection is active. To actually see the chart, Mark finally clicked the Plot Series 
box in the" Canard Budget Categories" window. The resulting display shows 
the relative contributions to the Canard project budget of each of the major 
budget categories, such as salaries, equipment, overhead , and so on {Figure 
5.12) . 

Mark felt that, while this presenta tion was fairly effective, he needed a 
supplementary presentation to really impress his vice-president with the 
contribution of indirect costs to the budget. He would create a second pie 
chart with only two segments, one for direct costs-salaries, equipment, 
materials and travel, and the consultant- and the other for indirect costs
overhead and fringe benefits. 

The first step was to do pull down the menu and choose Save as. Mark 
named the chart "Canard Pies." Then he chose the Data menu's Text option to 
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Figure 5.11 The Pie Chart gallery 
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Figure 5.12 The pie chart for Canard budget categories 

set up the format for the new series. This series he named "Canard 
Direct/Indirect" (Figure 5.13 ). 

Then Mark entered the names and values of the new categories, 
" DIRECT" and "INDIRECT." From the Pie Chart gallery he selected the 
sixth type, in which pie segments have different shadings and are labeled with 
their percentage contributions to the total ( Figure 5.14). Then he clicked the 
Plot Series box and got a new pie chart (Figure 5.15 ). 

Now it was time to print out the two charts for use in his presentation to 
the vice -president. Mark pulled down the File menu to choose the Print 
option, then selected the first series and printed it out in the same way. The two 
charts are sho·wn in Figures 5.16A and 5.168. 

One of Chart's great advantages is that it is very easy to learn the basics so 
that you can easily produce simple charts of your O"\vn. You can quickly learn 
how to input a data series and have the values plotted in a format of your 
choosing. Chart also has many more ad vanced capabilities, including many 
format control options. Practice and experimentation w ill reward you with the 
ability to produce high -quality charts easily. 
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CHARTS WITH MORE THAN ONE SET OF DATA 

Eldon Johnson is director of marketing research for a manufacturer of video 
arcade games. His department studies consumer preferences and perfor
mance on the firm's arcade games. They recently completed a major study of 
user behavior in early games. When his research staff presented him with the 
raw data on user performance during the first eight novice games, Eldon 
decided to use Microsoft Chart to get a visual representation of the data. 

Thirty novice p layers had played a sequence of eight games on the 
company's new arcade game. Using Chart, he q uickly set up a data series 
called " MEAN SCORES BY GAME" and entered the eight mean scores on the 
games. He chose to plot the series as a column chart (Figure 5.17) . As he 
expected , the chart seemed to show a rela tively steady progression of game 
scores. Did this m ean that every user progressed relatively steadily, he 
wondered? What if only a few users were really getting better? He asked his 
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Figure 5.15 Pie chart for "Canard Direct/ Indirect" 
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Figures 5.16 A and B "Canard Budget Categories" and "Canard Direct/ indirect" 

assistant to give him three sets of figures- the average scores for each game for 
three groups: the lowest-scoring ten users, the highest ten , and the middle ten. 

Eldon entered these three sets of game scores as three separate series in 
Chart. After entering the Low Group, he clicked the mouse pointer on the 
window labeled "New Series." This made a new window active, which he 
labeled "Mid Group." After entering the eight average game scores for the 
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Figure 5.17 Column chart, mean scores by game 

members of this group (Figure 5.18), he clicked on the New Series window 
again to create a High Group window. He filled in the game scores for that 
group, and then chose one of the Scatter Plot options from the Gallery menu. 
Chart automatically plotted all three sets of data (Figure 5.19). 

Looking at the scatter plot, Eldon immediately saw that his fears were 
well founded. It looked as though only a third of the users were actually 
improving. Was it possible that two-thirds of novice arcade game users would 
be so discouraged by their failure to improve that they would not continue to 
feed their spare change to the machine? This was clearly important enough to 
discuss in his weekly meeting with the manager of the Product Development 
Group. 

Eldon wanted a larger copy of the chart to use in the meeting. He clicked 
on the chart window to bring it to the fore, and dragged the title bar to the 
upper left corner of the display (Figure 5.20). Then he used the size box to 
enlarge the screen. The next step was to select the whole chart for resizing in 
the newly enlarged space. In the Chart application, each of the parts of a chart 
is an object that can be manipulated. An object such as the vertical axis can be 
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Figure 5.20 The chart window dragged to the upper left comer 

selected by clicking on it It changes appearance to show that it is the active 
object, by displaying two small circles at either end of the axis. 

Since Eldon wanted to enlarge the whole chart, he typed Command-A, 
the shorthand command for the Select All menu item in the Chart menu. Eight 
small black rectangles appeared around the borders of the chart area. These 
rectangles are "handles" that the mouse pointer can grab onto to change 
features of the selec ted item. Eldon pointed to the handle at the lower right 
corner of the chart and dragged it down and to the right (Figure5.21) . When 
he released the mouse button, the chart was replotted in a larger size. Part of 
the chart had disappeared off the top of the screen, so he pointed between two 
of the handles and dragged the whole chart down. 

Looking over the enlarged chart (Figure 5.22), Eldon decided he wanted 
a larger title and more prominent axis labels. He clicked the mouse pointer on 
the Three Groups title, and it was enclosed by eight handles. From the Format 
menu, he selected the Text option (Figure 5.23). An elaborate dialog box 
offering control of the appearance of text objects appeared (Figure 5.24). He 
chose to change the chart title toN ew Y ark font , bold, and medium size. Using 
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the same procedures, he selected the two axes titles and changed them to the 
Chicago font. The resulting chart (Figure 5.25) looked about right to Eldon, 
and he used a printout of it in the meeting to present his point quickly. 

USING MULTIPLAN AND CHART TOGETHER 

It is an easy matter to use Chart to present important results from a Multiplan 
spreadsheet. From Multiplan, select a portion of a row or column to be treated 
as a data seri es in Chart. Drag through these cells to select them, and then Copy 
them to the C lipboard. Each series must b e a set of contiguous data. If the row 
or column you want to take the series from has gaps or unwanted values, 
construct a new, contiguous section of the spreadsheet for the values you want 
to use in Chart, making sure to set the value of each cell with a reference to the 
old spreadsheet cell, rather than with a particular numerical value. That way 
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you will be able to update the spreadsheet later, and the cells that Chart 
references will change appropriately. 

Leave Multiplan and start up the Chart application. Specify the data type 
for the series, then Paste and Link the Clipboard contents into the new chart 
series. Thereafter, whenever that Chart document is opened, you will be 
asked to insert the disk with the Multiplan document. The plotted chart will 
always reflect the most recent changes to the spreadsheet. 

Chart is a powerful tool, the basics of which are easily learned. Within a 
few minutes of starting your Chart disk, you can easily create usable charts of 
many different types. If you will b e using Chart frequently, or if you must 
make presentation-quality graphics, set aside some time for experimenting 
with Chart's many formatting functions, which are distributed through the 
Data, Gallery, Chart, and Format menus. 

As you grow in expertise, you should find yourself making extensive use 
of the command keys in place of some of the pull-clown menu selections. To 
help you graduate to the use of these key combinations, Figure 5.26 presents 
the set, as they are presented in the menus themselves. 

FURTHER READING ABOUT MICROSOFT CHART 

Presentation Graphics on the Apple Macintosh, by Steve Lambert. Bellevue, 
Wash.: Microsoft Press, 1984. 

Lambert had access to the Microsoft applications programs during their 
development and probably contributed, through his comments to its program
mers, to its final form. 
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Using ThinkTank 131 

ThinkTank 128, from Living Videotext, is one of the easiest-to-learn 
practical applications for the Macintosh. ThinkT ank helps you create and 
manipulate outlines. Of course, you could use a word processing application 
like MacWrite or Word to make outlines, but ThinkTank makes it easy to 
manipulate outlines in ways that are not possible with word processing 
programs. 

USING THINKTANK 

T o start a new outline, simply open the ThinkTank icon, either by double
clicking it or b y selecting it and using Open from the File menu (Figure 6 .1 ). If 
you want to examine or edit an outline that already exists, just open its icon and 
the ThinkTank application will be opened automatically. 

When you begin from the ThinkTank application, you are presented with 
a minimal outline-one that consists of only a single heading, the word 
"Untitled " (Figure 6.2). You will notice that the word is prefaced by a minus 
sign. T his symbol means that a heading has no subheadings. If a head ing is 
preceded by a p lus sign, then the heading is understood to have subheadings. 

I used ThinkTank to create an outline for this book. T he first step was to 
enter the main heading, or title, of the book (Figure 6.3). T he heading 
"untitled " was already selected, so I just b ackspaced over it to erase it and then 
typed in the title of the book. A ThinkTank outline can have only one main 
heading. After you type the main heading and the Re turn key, ThinkTank 
automatically indents the next line. This happens only after you enter the main 
heading. T hereafter, typing Return creates a new line a t the same indentation 
level as the one ab ove. You have to let T hinkTank know if you want the new 
line to be indented farther or less than the previous heading. 

I typed in tentative titles for the chapters planned for the book (Figure 
6.4}, follo"ving each one with the Return key. As I did so, ThinkTank showed 
that the heading I was currently entering was the selected one by enclosing it in 
a rectangle. None of the main subhead ings have subheadings themselves a t 
this point, so they are all preceded by minus signs. 

ThinkTank uses the Mac's Monaco font, which is a non-proportional font, 
like the type produced by ordinary typewriters. Every letter takes up the same 
amount of space on the line. The FontSize menu lets you choose how large you 
want the letters to be. In these examples, a 12-point fo nt is used , but the 9-
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point Monaco font can also be used. Different font sizes permit different 
amounts of information to be displayed in the ThinkTank window (see 
Figure 6.5). 

In ThinkTank, the text insertion point is shown b y a vertical bar. In the 
above figures, this bar is at the right of the selection rectangle that encloses the 
current heading. In these figures, the insertion pointer shows up as a thick line 
on the right side of the selection rectangle ( Figure 6.6). ~aturally, T hinkTank 
lets you insert anywhere in a heading line. All you have to do is point to the 
letter you want to insert in front of and click. The insertion pointer appears as a 
vertical line before the letter. You can now type in new text at this point, or 
backspace over old text. 

ThinkTank d oesn't have all the text-editing features you are familiar with 
from other Macintosh text applications. You can' t select a word or phrase by 
dragging through it, for example. Only headings can be selected, not letters or 
words. Most Mac users will find that this restriction takes a little getting used 
to. The hardest thing to remember is where to click to get a new insertion 
point. Don't point to just before the letter you want to insert in front of, as you 
would with other applications. Point to the letter itself when you click. The 
new insertion point w ill be just before the letter. 

When I had established my chapter headings, I went back through the 
outline, adding subheadings for each chapter. I first selected the Intro
duction's heading, "What Makes Your Macintosh Special," by clicking on the 
line with that heading. I pressed the Return key, and a new , blank heading line, 
preceded by a minus sign, appeared immediately below. T his line was at the 

THINK TANK WINDOW CAPACITY 
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Figure 6.5 ThinkTank window capacity 
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same level as the chapter headings. Since I wanted it to be a subheading under 
the " Introduction" line, I typed Command-R to specify that the new 
(currently selected) line should be indented one stop to the 1'ight. At the same 
time that the new line was indented to the right, the minus sign preceding the 
chapter heading line above h1rned into a plus (Figure 6.7 ). I typed the new 
heading-"Techniques for Using MacPaint"- and created three subheadings 
for it. Here I typed Command-R when entering the first of these subheading 
lines ("Transferring Material Between Documents") to set up another level of 
indenting. When I entered the next line, I didn't have to indent again, since I 
wanted "The MacPaint Print Ca talog Feature" to b e at the same level. 

To reverse- indent, one can simply type Command-L, specifying that the 
selected heading will be positioned one stop to the left. One way in which 
outlining with ThinkTank is different from outlining with a word processing 
application is that the subheadings are all tied to the more major heading 
above. For example, when a heading is moved left or right, all its subheadings 
move with it. 
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Another way that a ThinkTank outline behaves differently from an 
ordinary text outline is that the ThinkTank user can selectively hide or "bury" 
portions of an outline. After I had finished outlining the Introduction, I wanted 
to conceal that level of detail while I worked on the structure of Chapter 1 in 
the outline. I pointed to the Chapter 1 heading line ("Pictures") and double
clicked. Immediately, the detail levels below that heading disappeared 
(Figure 6.8). Of course, the subheading information was not lost. To see it 
again, all I had to do was double-click on the heading line again. The ability to 
close and open levels of topic detail make ThinkTank an appropriate tool for 
intellectual planning. The user can alternately pan back to get the big picture 
of the problem and zoom in to focus on details. 

Inserting and deleting are performed in ThinkTank in much the same way 
that they are in other Macintosh applications. To insert or delete letters, as we 
have already seen, you simply select a text insertion point and type in new text 
or backspace out the old. If you want to delete a comple te heading and all its 
subheadings, you select the heading (by clicking anywhere on its line) and use 
the Cut option from the Edit menu. T he keyboard command shortcut, 
Command-X, is available for cutting. T he deleted heading (and all its 
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subheadings) is on the C lipboard a t this point, and you can move it to a 
different part of the outline if you want to, using the Paste function. 

In ThinkTank, moving around through your outline document is a little 
different from other applications we have examined. Instead of using scroll 
bars, ThinkTank has eight d istinct scroll a reas around the document window 
(Figure 6.9) . C licking in any one of these areas will move the window one 
"unit" in tha t direction. In the case of the vertical movements-clicking in the 
gray area at the top or bottom of the window-a unit is one line of text. 
Clicking in the gray areas to the left or right of the window moves the display 
one" heading stop" in the chosen direction. C licking in the gray corners makes 
the display move diagonally, one unit horizontally and one vertically. To 
move a whole page in a chosen d irection, point to the appropriate scroll area 
and double -click. 

It is easy to revise an outline by changing the indentation of headings or by 
adding or deleting headings. After entering the subheadings for Chapter 2, 
"Words," I decided that I wanted to add to the outline the acknowledgments 
and other materials that would precede the Introduction. I simply scrolled 
back to the beginning, and inserted the new material (Figure 6.10). 
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The T hinkTank Extra menu gives you some sim ple sorting and searching 
capabilities. To sort all the subheadings of a heading, you must first select the 
heading. Then pull do'vvn the Extra menu to Sort and release the mouse button 
(Figure 6.11 ). Now the subheadings are rearranged in alphabetical order 
(Figure 6.12) . Sorting works about as you would expect, with numbers being 
sorted after letters. Because the sort is alphabetic ra ther than numeric, a 
heading tha t begins '.vith the number 6 will be sorted after one tha t begins with 
the number 193, because 1 precedes 6 in the alphabe t. If you plan on sorting 
headings that begin with numbers, be sure to include the same number of 
digits for every number and use leading zeros before the smaller numbers. 
Then your "006" will be sorted b efore "193." 

The Extra menu's Search option lets you carry out opera tions similar to 
the Find and Replace options of MacWrite. You can find every instance of a 
word in an outline segment-a portion under a heading. If you choose, you can 
replace each instance with something else. See Figure 6.13. 

There is more than one way to move a heading to a new p osition. In 
addition to cutting and pasting, you can simply drag a heading (and its 
subheadings) to a new loca ti on in an outline. First, just point to the heading 
you want to move to another place in the window . Depress the mouse button 
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Figure 6.12 Sorted subheadings 

and leave it down. A gray border will surround the heading and its 
subheadings as a unit, and the pointer will change to a slim pointed horizontal 
shape. Position the pointer between the two headings where you wish to pu t 
the enclosed material and release the mouse button. Bingo! The selected 
portion of the outline has been moved. 

PRINTING OUTLINES 

To print a portion of an outline, first select the heading for the part of the 
outline you want to print. If you want to print the whole outline, select the 
main heading. T hen pull down the F ile menu to the Print option ( F igure6.14 ). 
A d ialog b ox will open to offer print setup options ( Figure6.15 ). When you've 
finished choosing print op tions, click the "OK" button. The selected portion of 
the outline will be printed. 
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MOVING OUTLINES TO TEXT DOCUMENTS 

., 

After creating an outline, you may want to transfer all or part of it to a word 
processing application document. Perhaps you would like to begin the 
document with the ou tline, or you might want to use the outline headings as 
headings in your text. The first step is moving the outline or outline portion to a 
text document. While in ThinkTank, select the heading you want to copy into a 
word processing document file. Naturally, if you want to copy the whole 
document, you will choose the main heading. Then type Command-C or 
choose Copy from the Edit menu. At this point, the C lipboard will contain the 
selected heading and its subheadings. (If you don't believe it, choose Show 
C lipboard from the Edit menu to have a look at the copied material. ) 

Quit ThinkTank, and start the word processing application by opening 
the document into which yo u want to insert the outline segment. Select an 
insertion point and type Command-V or choose Paste from the Edit menu. A 
copy of your outline will appear (Figure 6.16). You can use the word 
processing application to add multiple fonts, styles, and sizes to your outline if 
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you want. You can even paste an outline into a MacPaint document and 
elaborate it graphicaJly (Figure 6.17). 

THINGS TO DO WITH THINKTANK 

, • 
·~ 

I 

ThinkTank is not limited to constructing outlines for books. Unlike many 
other Macintosh applications, ThinkTank's strength lies not in creating 
finished products-printed outlines. Instead, it is a tool for encouraging 
organized thought. ThinkTank encourages its users to separate a problem into 
components. It makes it easy to expand an issue into a very detailed outline or 
to collapse it back to the major headings in order to keep track of the big 
picture. 

Project managers who do not need the fu ll panoply of project planning 
and tracking features provided by MacProject may want to consider using 
ThinkTank for project planning. You can outline the major stages of a project, 
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Figure 6.15 The Print dialog box 
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with subheadings for all the contributing activities for each stage. Re-editing 
the outline as your project goes on gives you a simple means for tracking 
project progress. 

Anyone who must plan and give oral presentations should consider giving 
ThinkTank a try. Writing ou t the complete text of an oral presentation in 
advance is not usually the best way to prepare a talk. In fact, having a complete 
transcript of an oral presentation to read from is a certain way of making the 
presentation colorless and hard to listen to. On the other hand, the planning 
that must accompany writing can improve a talk immeasurably. Using 
ThinkTank can help you plan an oral presentation at many different levels of 
detail without actually having to write it out. The printed outline can even 
serve as your lecture notes. 
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The Macintosh's computational power and graphics capabili ties made 
possible new kinds of software not previously available on other computers. 
Mac users have been given the ability to manipulate information, especially 
non-verbal information, more directly than is possible with other computers. 

FEATURES OF FILEVISION 

One of the best examples of such innovation is Filevision from Telos Software 
Produc ts. Filevision makes it possible to store data in files that refer to pictures 
you create. Put another way, with Filevision you can draw pictures that have 
objects with associated data. 

The documents you create with Filevision are called DRAWL c FILES. 

These pictorial data bases include both drawings and data forms that describe 
the elements in the pictures. Menu options let you instruct Filevision to 
pictorially highlight objects in your drawings that have certain data character
istics . Or you can print out complete or selective lists of data about drawing 
file objects. If the stored data includes names and addresses, you can even do 
mailing labels with Filevision. 

Filevision drawing files are a useful way to enter data you would like to 
arrange topographically-as though it were part of a map. If you have a 
collection of objects stored in a particular arrangement, you can use Filevision 
to record both where the objects are located and what their alphanumeric data 
characteristics are. For example, Filevision can be used to store an organiza
tion chart together with facts about the d epartments represented and their 
managers. 

Figure 7.1 is a drawing of a map of the Los Angeles area I made with 
Filevision. It includes objec ts of four types: background objects (such as the 
coastline and the mountains), freeways, cities, and Olympic Games sites. 
Unlike a picture created w ith MacPaint, each object depicted in this scene is 
recognized as an object by Filevision. If you point to an object and click, its 
name appears just b elow the window with the drawing. 

In Figure 7.2 a different Filevision drawing file is on the screen, depicting 
a closeup of the a rea of Los Angeles in which the Olympic swimming 
competition was held. A rectangular object has been selected by pointing and 
clicking, and it shows up with nine small white rectangular"handles." Just as in 
MacDraw, a graphic object's handles let the user reposition or stretch the 
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object using the mouse. The text at the bottom of the screen informs us that the 
object is the natatorium. The type of objec t is a Sports Facility. 

Each object in a drawing file has associated with it a set of alphanumeric 
data that the user can access by clicking the Info button on the bottom of the 
screen or by double-clicking the object. Each type of object has its own 
standard information form that gives the user access to information about 
objects of that type. When a Filevision user defines a new type, the layout of 
the information form for all objects of that type is determined. Once the 
na tatorium has b een selected, if the user clicks the Info button, the form 
appears, showing that three types of events took place at the facility: 
swimming, diving, and synchronized swimming (Figure 7.3 ). 

Filevision has built-in facilities to support two major kinds of work with 
drawing fil es- crea ting and editing the drawings and their associated data 
forms, and using the completed drawing files to access and understand the 
stored information. Like MacDraw- described in Chapter 10- Filevision is 
an object-oriented graphics composition application rather than a pixel
oriented application like MacPaint. Unlike either MacDraw or MacPaint, it is 
also an information-filing system. 

Done~) 

Figure 7.3 The information form for the natatorium 
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Consider a few of the capabilities Filevision provides to support 
information browsers-those who use preexisting drawing fil es to get 
information. Eight menus give access to one of the largest sets of information 
manipulation commands available for a .\1acintosh applica tion {Figure 7.4). 
Two menus of special interest to the information browser are the Tinker and 
File menus. The File menu provides many selective print options. The Tinker 
menu provides for temporary changes in the appearance of a drawing to bring 
out some aspect of the data. It le ts you tinker with the drawing. The Tinker 
menu gives the browser control over object-oriented displays in ways that 
other applications don't provide. 

MANIPULATING THE DISPLAY 

vVhen authors create a drawing file, they define the types to be used in the file . 
Every pictorial object must belong to one of these defined types. Filevision 
le ts users manipulate information based on type or on information stored in 
data forms. 

Controlling the Appearance of Objects 

All the objects of a particular type can be hidden in a drawing. First you make 
that type the currently selected type, either by pointing to an object of that 
type and clicking, or by choosing it from the Types menu. Then you simply 
choose the Hide These option from the Tinker menu {Figure 7.5), and al1 the 
cities shown on the drawing disappear (Figure 7.6) . Naturally, a Show These 
option then becomes available to make the objects that represent cities 
reappear in the drawing. 

Highlighting 

Control over the appearance of objects is not limited to making all the objects 
of a type appear or disappear. One can also Highlight objects. HIGHLIGHTING is 
a process that "grays out" unselected objects in a drawing and adds special 
shadowing to the objects that are highlighted. The result is a display in which 
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the highlighted objects stand out quite strongly. You can choose to highlight aU 
the objects of a type, but a much more useful fea ture is the ability to highlight 
only those objects that have certain data cha racteristics which you specify. 

If you choose the H ighlight Some option when the City type is selected, 
you can specify the constraints you want to place on the highlighted objects. A 
special fo rm fills the screen, asking you to describe the conditions fo r 
highlighting a city. In the example in Figure 7.7, only those cities with two or 
more Olympic sites are to be highlighted. As soon as the user clicks the Done 
button on this form, the drawing is redisplayed , but with almost all the objects 
grayed out . According to the data stored with this drawing file, only the cities 
of Los Angeles and Mission Viejo had more than one Olympic site in the 1984 
summer games, so only those two objects are highlighted (Figure 7.8). 

Complex Highlighting Specifications 

The Highlight Some option permits more complex statements of conditions. If 
you wanted to know which Olympic sites were in use throughout the period of 
the Olympics, you could ask to see those for which the first day is July 29 and 

lines Shades 
., 

Figure 7.5 Selecting Hide These with "city" a s the current type 
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Figure 7.6 The same drawing, with cities hidden 

Figure 7.7 Filling out the Highlight Some "Co nditions" form 
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the last day was August 12. The process of filling out a conditions form does 
not require that you type in the conditions phrases (such as "First Day is less 
than or equal to" ) seen in the condition boxes on the right in Figure 7.9. These 
English phrases are composed by clicking the selections in the box to the left. 
T he only items you have to type are the limiting values that the condition refers 
to, such as "840812." 

In Figure 7 .9, dates are expressed as numbers consisting of the last two 
digits of the year, followed b y the month (here "08") and then the day of the 
month. Expressing d a tes this way, as single numbers that represent year, 
month, and day, makes it easy for Filevision to sort on date fields. If you 
express dates with strings such as "8/12/84," only the first digit will be used in 
sorting, because the "/" is unders tood to mark the end of the nu mber. 

PRINTING LISTS 

Information stored ab out the objects of a given type can be printed out from 
Filevision b y using the print options available under it's File menu. Like most 
other data -base manipulation systems, Filevision stores d ata in HECORDS. Each 
record has a number of FIELDS, the predefined parts of a record . The list of 
printing options of the Filevision application lets you decide which fields 
should be printed in a list. The formatting page for the list lets you choose 
which of a record's fields should appear in the list, where on the line, and how 
much space to alloca te for each one (Figure 7 .10). You can independently 
specify whether the material from the field should be right-justified , left
justified , or centered in its column. 

The list-formatting options also let the user decide what data field will 
determine printing order. In this example, Olympic sites are to be printed 
according to the order of their first day of use. The field that determines the 
order of printing d oes no t have to be the field in the first column of the 
printout. 

A second printing op tion lets you print more than one line per record. You 
can use Print info to print all the information about the objects of a type. A 
formatting page, similar to the one used to print lists, lets you choose options 
tha t control the printout. The Print Info options in Figure 7.11 specify that a set 
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of Olympic swimming records are to be printed in an order based on the 
record time for each of the events. 

Other printing options include printing the display and printing sets of 
labels based on a drawing file's data . 

THE RANGE OF FILEVISION'S USES 

Since Filevision is a new kind of software, one not previously available on 
microcomputers, it is likely that users will come up with uses its developers 
never imagined. Here are some uses that they have thought of. 

Intelligent Maps 

The Los Angeles Olympics drawing file d escribed in Figures 7.1 through 7.11 
is an example of an " intelligent map." A Filevision map lets the user get a lot 
more out of it than is possible with ordinary maps. Filevis.ion maps such as 

s Tinker TeHt s mbols lines Sh11des 

Figure 7.12 A mop of the United Stoles, with twelve stoles highlighted 
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those in Figures 7.12 and 7.13 can change their appearance to exclude certain 
types of information and to highlight others. A Filevision map can be used to 
generate lists. If your information form includes name and address fields, you 
can use the Print Labels option to produce mailing labels. 

Intelligent Illustrations 

Other possibilities for Filevision include "intelligent illustrations." For ex
ample, a drawing of the parts of the human eye (Figure 7 .14) could employ 
data forms that let students formulate their own questions about how the 
objects in a drawing are interrelated, and get the answers in both pictorial and 
verbal forms. Artistically inclined users can create striking images as technical 
illustrations, as in Figure 7.15. Technical data for each object is available on 
command from its information form . 
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Figure 7.13 Callfomia wine regions 
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Figure 7.14 The human eye 

bois lines She lles 

Lil y Flower Disk Flower 

Figure 7.15 Two flowers 



160 PICTORIAL DATA BASES 

Art Analysis 

Filevision can be used for art analysis. For example, a sketch of an artistic work 
can be stored as a drawing file (Figure 7.16), together with whatever data is 
desired about the elements of the artistic work. You can use Filevision's power 
to highlight, to sort, and to compare the fea tures of such elements in the pursuit 
of new critical insights. 

Everyday Uses 

On a more mundane level, Macintosh owners may choose to use Filevision to 
produce drawing files tha t relate to everyday aspec ts of their lives. A map of 
one's apartment may b e an aid to organizing the p lacement of furniture 
(Figure 7.17). And you've probably been admonished to keep a list of your 
valuables. With Filevision you can keep a map of your living space in which 
each valuable has its own data form, filled w ith all the information that the 
police and the insurance companies would like you to have on hand. Or, if you 
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Figure 7.16 Bottlcelll's Primavera as a Fllevlsion drawing 
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Figure 7.17 An apartment map 

are a collector, you might choose to keep a drawing fil e that not only stores 
relevant data about each item in your collection, be it coins or rare wines (as in 
Figure 7.18), but also shows where each item is located. 

BUILDING A DRAWING FILE 

Filevision not only provides powerful information-browsing capabilities, it 
a!so provides the tools for creating and editing drawing files. Most users will 
want to create their own drawings, populated with objects of types of their 
own design. These types have data forms of the users' own devising. To see 
how it's done, follow my construction of the 1984 Los Angeles Olympics 
drawing file . 

I opened the Filevision icon and was presented with an empty drawing. 
The default type at this point is always called" Background." I wanted to enter 
a few background elements for the Los Angeles area-the coastline and the 
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mountains. From the palette of drawing tools at the left, I chose the last one, 
the Freehand Line tool. I positioned the pointer and depressed the mouse 
button to sketch out the Los Angeles area coastline. As soon as I released the 
mouse button, a set of nine "handles" appeared (as in Figure 7.19). These little 
solid rectangles (and one diamond shape) let the user move an object or 
change its shape. 

I wanted to add several elements made with other tools on the palette, 
such as the Text tool , to this Background object. I also wanted to make several 
little waves in the area of the Pacific Ocean. Rather than try to sketch the 
waves freehand, I decided to make a special wave symbol that I could drop 
wherever I wanted. I called up the Filevision Symbol Editor from the File 
menu, chose a symbol that I didn't plan on using, and used Clear to erase it 
(Figure 7.20). The Symbol Editor will remind you of FatBits in MacPaint. It 
lets you develop up to twenty special icons or symbols for use in each drawing. 
After I finished sketching my "waves" symbol (Figure 7.21), I clicked the 
Done button to get back to the drawing page. 

I chose the Symbol tool, the fourth item on the palette. I held down the 
Shift key as I selected the Symbol tool, thereby telling Filevision that I planned 

Tinker TeHt S s lines Shades 

Figure 7.19 The coastline 
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Figure 7.22 The first completed object 

to add an element to the current object (the coastline), rather than add a new 
object. The Symbol tool leaves a copy of the current symbol shape wherever 
one clicks in the drawing. After adding a few sets of waves to that first 
background element, I held down the Shift key again while selecting the Text 
tool, the large capital A. I entered the names "Pacific Ocean" and "Santa 
Monica Bay." 

An ELEMENT is a portion of a drawing created through a single use of a 
drawing tool. Elements can be combined to make up drawing objects, 
although some objects consist of single elements. Because I chose to enter all 
the coastline elements as parts of one object, they are all closely linked 
together in the Filevision drawing file. When I click on one of them, all are 
highlighted (Figure 7 .22). Furthermore, since only objects (not elements) can 
have data forms, there can be only one data form to represent the entire object. 

I used the Symbol Editor to make a new symbol to represent mountains. 
Then I added a new complex object consisting of several elements made with 
the new symbol and the words "San Gabriel Mountains" (Figure 7.23 ). 

My next step was to pull down the Types menu to Add another. Filevision 
presented me with a type definition form. I called the new type " Freeway" 
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and gave it five data fi elds ( Figure 7.24 ). Actually, two of the fields, Name and 
Link, are always automatically supplied by Filevision when you create a new 
object type. I provided for up to two freeway numbers b ecause of the strange 
practice in Los Angeles of giving freeways names without regard to their 
numbers. (The Hollywood Freeway includes portions of Highways 101 and 
170, and the Ventura Freeway consists of the rest of 101 and parts of 134.) A 
third number tells how many Olympic sites are immediately accessed by the 
freeway. 

I could have included many more fields. A type can have up to thirty data 
fields , and each data field can have a name up to fifteen characters long. The 
fields themselves can b e much larger, if you desire, up to a limit of 2,000 bytes 
for a single object, distributed among that object's fields as you desire. You can 
have up to 999 objects in a drawing file, but they can't all be 2,000 bytes large. 
The maximum drawing file size is 132K bytes. 

Using the Symbol Editor, I created two new symbols to represent 
interstate highway and California highway symbols. Each freeway in the 
drawing consisted of a number of elements, including one or more freehand 
line segments, one or more highway symbols, and one or more text elements 
positioned right after a highway symbol. In Figure 7.25, clicking on the line 
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that represents the Ventura Freeway has resulted in the line acquiring handles 
and in the object's two symbols and two text elements becoming highlighted . 

The next step in preparing my Olympics drawing file was to create a new 
objec t ty pe, the Olympic Site. The da ta fi elds associated with an Olympic site 
would be its name, its link, its event type, the first and last day of its use d uring 
the Olympics, and a comment field, as shown in Figure 7.26. T o represent the 
sites, I used symbols that represented the different sporting events that took 
place a t each. I used the Symbol Editor to construc t sixteen new symbols, 
representing sp orts from archery to tennis (see Figure 7.27). (In case the 
symbols in Figure 7.27 seem a bit cryp tic, here they are in order: Row ! 
archery, track and field, baseball, b asketball; Row 2-cycling, equestrian, 
fencing, footb all (soccer); Row 3-gymnastics, field hockey, water polo, 
swimming; Row 4-shooting, weight lifting, wrestling, tennis.) 

The next step was to add all the Olympic sites to the drawing file, along 
with the information about each one (see Figure 7.28). By clicking on any 
object in the d rawing, one can learn what the type of the object is and its name. 
Clicking on the symbol of the wrestlers, we learn that it represents the 
Anaheim Convention Center. To get more information about an object or to 
edit information, you simply click the Info button. Figure 7.29 shows the data 
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Figure 7.27 The Olympic sports symbols 
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Figure 7.28 The drawing file with Olympic sites 
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form for the Loyola Marymount University site, where the weight lifting 
competitions were held. 

Once a drawing fil e such as this one has been created and the data has 
been entered , it can be locked and given to others who need to use the data but 
who don't have to edit it. Such users can still Tinker with the drawing file, 
ex ploring the significance of the stored data. 

LINKING DRAWING FILES 

Draw ing files can be linked to each other. Each site in the Olympic map 
drawing fil e can have a link to a more detailed local map for tha t site. Figure 
7.30 shows the drawing file fo r the University of Southern California site, 
where the Olympic swimming events were held . This file has not only a map 
of the USC campus and surrounding area but also a section referencing 
previous major O lympic swimming records. Each of the swimming figure 
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symbols is an object with a data form that has information on the current 
Olympic record for a swimming event. By first selec ting the USC site on the 
global Olympic map and then choosing to Link, the user moves automatically 
to the new drawing fil e. 

From thi s new file, it is possible to use the Tinker menu's Highlight some 
option to ask a question like " What Olympic swimming records are held by 
athletes from the United Sta tes?" Filevision will display a pictorial response 
( Figure 7.31 ). If every O lympic site in the higher-level map has a link to such a 
drawing file with local street information and Olympic records, Filevision can 
provide the user ·with a richly interconnected set of drawing files and data. 

Since a user is likely to want to get back to the larger map from such a 
specific drawing file, it makes sense to provide a link in that direction as well . 
Since nothing in the USC site drawing file serves as a na tural representation for 
the larger map, I added one. I used the rounded rectangle to make a box and 
added two text elements- a Cairo font arrow and some Geneva font text-to 
create a box reading "t L. A. Map" (Figure 7.32). I gave this background 
object the artificial name "Click Link for Big Map," which serves as an 

MaJor Olympic SWimming Records 
11t n Womon 

1 OO·lhttr f r.fl t y1o a a 
200·11otor f r.uty1• a a 
400· 11•tn Frouly1o a a 
BOO·tt•t tr Frtutyl• a 
1 '00·11otor froul y1o a 
1 00· 11ot or Bock•troko a a 
200-l'ht.r Back•trok• a a 
t OO·l1• tn Bruatatro)cf' a a 
ZOO·Motu Broutotrok• a a 
l 00·11t1tr Bulttrlly a a 
200 · t!ottr Bu lltrlly a a 
4 00 ·11t1tr 1ndmd uol t!tdl y a a 
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instruction to naive users. A complete set of interrelated Filevision drawing 
files provides a Macintosh environment for exploring the geography and 
records of the Los Angeles Olympic Games. 

Filevision can be used to build richly interconnected files of drawings and 
data. Although it can also be used as an ordinary filing application-one tha t 
can be used to file client data or recipes-its capabilities go beyond ordinary 
filing. It provides users with new opportunities to use the Mac productively 
and imaginatively. 
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MANAGING MAJOR PROJECTS WITH THE MAC 

The Macintosh provides many tools that contribute to the accomplishment of 
major projects. In a sense, this entire book deals with how you can use the Mac 
to carry out major portions of projec ts. Word processing programs contribute 
to the production of project proposals and reports. Chart, MacPaint, and 
MacDraw help the project manager develop presentation-quality graphics. 
MacT erminal lets a project's staff tap into the resources of mainframe 
computers. Other special-purpose applications, such as accounting and data 
base systems, can contribute to project progress. 

Several Macintosh applications are useful project-planning and project
management tools. Multiplan spreadsheets, as described in Chapter 4, can 
play a very useful role in planning the financial aspects of a project. A project 
budget spreadsheet, such as the one presented for the Canard Widget project, 
does not end its usefulness when the d ecision is made to fund the project. A 
project manager can continue to use the spreadsheet to track project 
expenditures, altering any of the factors that do not conform to the projected 
expenditure rate. Multiplan will automatically calculate the consequences of 
the difference for the entire spreadsheet. Be sure to use a copy of the original 
planning spreadsheet for this process of tracking expenses. That way you can 
always compare the currently tracked expenditures with the original budge t 
plan. 

ThinkTank (covered in Chapter 6 ) is another tool tha t can be effectively 
put to use in project planning. You can outline an entire project with 
ThinkTank, treating each of the project's major milestones as a separate major 
outline heading. All the task elements that contribute to each of these 
milestones can be treated as subheadings. Since ThinkTank makes it easy to 
collapse and expand outlines, it is a good tool for alternately stepping back to 
see the big picture and for selectively expanding task descriptions to study 
particular portions of the project. 

CREATING A SCHEDULE CHART WITH MACPROJECT 

Apple Computer's MacProject is a specialized tool for project management. 
Using MacProject, you can draw a graph tha t portrays all the tasks of a project 
and their dependencies. You can enter information about who will perform 
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each task and what other resources the task requires. Mac Project uses the data 
you enter to produce six different types of charts and tables, which present 
information about the project in different ways. 

The printout of a MacProject schedule chart looks like that in Figure 8.1. 
Each rectangle represents some task tha t is part of the project. The text in a 
rectangle gives the name of that task. Earlier tasks are placed to the left of later 
ones in the chart. Where two tasks are connec ted by a line, the task to the right 
depends on the comple tion of the task at the left end of the line. A line denotes 
a d ependency-the task on the right cannot begin until the task on the left is 
completed. The thicker boxes, connected by thicker lines, are the project's 
critical pa th . This is the sequence of tasks that determines how long the project 
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will take to complete. Any unexpected d elays in this portion of the project will 
result in a d elay of the final project milestone. Small d elays along other paths 
may not result in project delays. 

After you have entered a schedule chart, together with some information 
about the tasks and 'vVho will work on them, MacProject can produce many 
different charts and tables that will help you plan the project and track its 
progress. To see how to enter a schedule chart and other p roject information, 
consider an example. 

Dire Wolf Software, a small software development company, used 
MacProjec t to develop the chart in Figure 8.1 after being awarded a contract 
by JPI Aerospace, Inc. Dire Wolf was to produce a major software application 
for J PI. The chart in Figure 8.1 is a plan for carrying out the first stage of the 
contrac t, the software design phase. 

Aaron Lightfoot was the Dire Wolf project manager for this contract. His 
preliminary design for the product, completed as part of the contract proposal 
process, had divided the design into several partially independent sequences 
of tasks. He began the project-planning process by entering these component 
task sequences. 

He first selec ted I nvisible Grid from the Layout menu. Like the grid in 
MacPaint, this feature makes it possible to align graphic objects on the screen. 
MacProject has only one graphics tool, the rectangle . You drag a rec tangle on 
the screen by positioning the mouse at the point ""here you want the upper left 
corner of the task rectangle , depressing the button, and dragging to the lower 
right. Then release the button, and the box appears, with a centered text 
insertion point. This box represents a project task. Don't worry if the box is not 
exactly the size you want or is not in exactly the right p lace. You can easily 
adjust it later. 

Text entry follows normal Macintosh conventions. If you want to use 
d ifferent fonts, font sizes, or font styles, simply choose from the Fonts and 
Style menus. You can drag through text to select portions, and you can Cut, 
Copy, and Paste text, just as in other Macintosh applica tions. 

A box with a rounded rectangle shape is interpreted as a milestone rather 
than a task. A M ILESTONE is an event, such as the start of a project or the delivery 
of a product. To crea te a milestone in a chart, first enter the milestone as an 
ordinary task rec tangle. While it is still the selected rectangle, p ull down the 
Task menu to select change to Milestone (or type Command-M). T he 
selected rectangle will become a rounded rectangle, denoting its new status 
as a milestone rather than a task (Figure 8.2). 
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Figure 8.2 Entering task boxes 

A useful method for adding new task boxes to a project is to use the 
D uplicate option in the Edit menu to make a copy of a selected rectangle. T o 
select a task, whether for d uplicating, copying, cutting, or whatever, click on 
the rectangle's border. After you have mad e a dup lica te, position the duplicate 
in an appropriate location and then make appropriate changes in the text of the 
task box to label it (F igure8.3) . 

Since D uplica te is a frequently used function, it has a Command key 
equivalent, Command-D. As you become exp er t w ith MacProject, you will 
find that yo u make increasing use of the com mand keys for greater speed in 
developing new projec t charts. F igure 8 .4 shows the set of MacProject menus. 
Note the Command key equivalents for options in the Edit, Task, and Style 
menus. 

Someti mes, in the process of entering text in a task box, you will discover 
that the size of the rectangle is wrong. Select the b ox b y clicking on any edge. 
T he eight handles that surround it are its size handles (Figure 8 .5 ). Y a u can 
drag these to reshape the rec tangle. The four handles in the centers of the sides 
are for dragging those sid es inward or outward. T he four corner handles make 
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it possible to drag two sides at once, so that you can change the box's size 
diagonally. 

Moving a task box is as easy as changing its size. First select the box by 
clicking on the edge of the rectangle. Then drag from a point on an edge that is 
not a handle. The outline of the task box will follow the mouse pointer to the 
new location. 

To express a dependency, you drag a line from the task that must precede 
the dependent task. Start by positioning the mouse pointer well inside the 
preliminary task box and drag the pointer to the inside of the dependent task 
box. A line will follow the pointer's path. When you release the button, the line 
will automatically reposition. Figure 8.6 shows a portion of Aaron's schedule 
chart after he drew in some dependency lines. 

Aaron chose to enter most of the task boxes before setting up depen
dencies in his chart, but you can build your schedule chart in ·whatever order 
you choose. The scroll bars, at the right and bottom of the window, let you 
move to any part of the project chart . 

If you accidentally overshoot your destination rectangle and release the 
mouse button when you are past the dependent task box, MacProject will 
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draw a new task b ox a t that point. To get rid of it and its dependency line, 
simply select it by clicking on an edge and type Command-X to cut it. 

It is possible to select more than one task b ox at a ti me, if you want. Just 
depress the Shift key w hile dragging out a dotted-line rectangle that encloses 
the entire area with the tasks you want to select (Figure 8.7). The newly 
selected tasks will all appear in inverse, as in Figure 8.8. At this point they can 
be dragged as a group to reposition them without changing their relative 
positions, just like a group of icons on the Mac desktop. 
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After entering the sequence of tasks in the schedule chart, you can enter 
task information. You need to tell .\llacProjec t how long you expect each task 
to last and who is responsible for the task. First, however, you must let 
MacProject know what you mean when you say that a task ,,.., ill take so many 
working days. MacProject needs to know how many hours of work are in a 
working day and how many working days are in a month . 

If you pull down the Dates menu to the Calendar option, you are 
presented with a clock dial and a calendar (Figure 8.9). By clicking on the 
clock dial, you d etermine how many working hours MacProject will assume 
you have in the course of a working day. By clicking on the days of the 
calendar, you can toggle individual dates back and forth b etween working 
days (black numerals on white) and days off work (white numerals on black). 
If you click on a d ay-of-the-week column header ( S, M, T , W, T , F , or S ), you 
toggle all the da tes that fall on that day of the week to working or nonworking 
days. 

By clicking on the month and year indicators a t the top of the calendar, 
you can select what month of what year you want to te ll the system about. The 
Dire Wolf contract with J PI Aerospace began in February 1985, so Aaron 
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made the appropriate adjustments to reflect Dire Wolf's policies for working 
days and working hours. 

After clicking the OK button in the Calendar window, Aaron scrolled the 
schedule chart back to the left and selected the start milestone, the rounded 
rectangle labeled "Contract Award." From the Dates menu, he chose Set 
Earliest Start (Figure 8.10). The new window let him specify this date as 
February 4, starting at 9:00 A.M. After he clicked the Set button in this 
window, the window closed up and the schedule chart had the same 
appearance as b efore. Now he needed to make the chart display dates. 

The Show Dates option in the Dates menu brings up a window that lets 
you specify up to four dates to be displayed for each task. Aaron clicked 
buttons that would cause the early start and early finish dates for each task to 
be displayed at the upper left and upper right corner of the tasks rectangle 
(Figure 8.11 ). The date "2/4" appeared at both the left and right top corners of 
the start milestone, since it is an event of no duration. 

To assign duration to each of the other tasks, Aaron used the Task Info 
window. He selec ted Show Task Info from the Task menu. This window takes 
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up a bout one-fifth of the available screen. When you are entering information 
for a number of tasks, you have to go back and forth between selecting a task 
in the schedule chart window and entering information about that task in the 
Task Info window. It makes sense to use the chart window's size box and title 
bar to resize and reposition it so that there is room on the screen for both it and 
the Task Info window. 

One by one, Aaron worked through all the task elements he had entered 
into the schedule chart. As he clicked on a task box, its task information would 
appear in the Task Info window above. T o begin with, the information for 
each task was a11 zero (or, in the case of the Resources, all blanks). Typing the 
Tab key wo uld select the first field of the information for the select task, its 
duration in days. Aaron entered this number, then hit T ab again to select the 
next information field for the task, its fixed cost. 

In the same way, he entered information about the resources tha t would 
contribute to each task . In the case of Dire Wolf software, the resources were 
the staff members who would carry out the design work. Each was 
represented in the Resources list b y his or her initials and by the percentage of 
their time that would be devoted to the task during the specified period. (The 
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initials CS in Figure 8.12 stand for Carmen Silver, the owner of Dire Wolf and 
chief technical guru, AL for Aaron himself, LI and PR for Len Ishikawa and 
Pam Richards, the programmers , PL for Pe ter Lang, the subject-matter 
expert, and KM for Kathy Meyer, the writer.) 

When the task information had been entered for all the task elements, 
every rec tangle had its start and end dates displayed in the chart (Figure 8.13). 
MacProject showed Aaron that he should b e able to schedule the design 
project's milestone-a meeting with the client to get approval of the design
on March 14, 1985. 

The critical path was marked on the final schedule (Figure 8.14). Aaron 
decided that he would have to pay special attention to how the tasks on that 
path progressed. He was largely responsible for the first two elements 
(planning the author features and describing the author features )- perhaps he 
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could work a few long days and put this portion of the project ahead of 
schedule at the beginning. 

USING A COMPLETED MACPROJECT SCHEDULE 

As useful as a printed schedule chart is for p lanning and keeping track of a 
project, it is only one of the project-scheduling tools MacProject provides. An 
important concern of projec t managers is how their resources are distributed. 
Are the demands of a project too grea t for the number of people available? 
The resource chart helps answer this question. 

Aaron chose the Resource Timeline option in the Chart menu to bring up a 
screen display of a bar chart showing each staff member's responsibilities. 
Figure 8.15 shows the printout he got by selecting the Print option from the 
File menu while in the resource chart display. By glancing up and down the 
columns, he could check that none of the staff was allocated for more than 100 
percent time. To his dismay, he discovered that he himself was scheduled to 
work 125 percent of the time during two days of the week of February 25. 
Looking over the resource commitments, Aaron discovered he could ask Pam 
to shoulder a bit more of the "Sample Author WalkThru" task during this time. 
The resource chart is an important tool for checking on the feasibility of a 
schedule. 

MacProject can also be used to plan for projec t costs and to track those 
costs during a project. However, first you have to describe the costs of the 
resources. Aaron used the Resource Cost Entry option to bring up a window 
with the names of all the resources-"CS (50~)," "KM (50~)," and so on. For 
each staff member, he entered the appropriate daily salary figure, multiplied 
by the percentage of that person's time spent on the project. (Fringe b enefits 
and overhead calculations would be per fo rmed later with the help of 
Multiplan.) When Aaron was done, he had a list of staff resources and costs 
(Figure 8.16). 

The Cash Flow Table option under the Chart menu brings up a table that 
shows both periodic and cumulative expenses associated with the project 
(Figure 8.17). If having an even cash flow were more important than 
completing the work as soon as possible, Aaron could go back to the schedule 
chart and set nev, dates for certain tasks to avoid the high level of activity
and charges-in the week of February 25. 
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By selecting the Project Table option from the Chart menu, you can get a 
complete display of all the informa tion MacProject has about a project except 
the dep endencies (Figure 8 .18) . For most projec ts, this table will be large 
enough to span several pages, which you can paste together after you print it. 

Another useful scheduling aid is the Task Timeline option, again available 
from the Chart menu. A task chart gives a useful quick summary of the 
expected order of events in the life of a projec t (Figure 8.19 ). 

The small project chart we have explored here may be only the start of a 
much larger MacProject document. The Set Chart Size option in the Layout 
menu le ts you increase or decrease the size of the chart ( Figure8.20 ). Each 
vertical rectangle in the grid represents a standard piece of printer paper. 
During construc tion of a schedule chart, MacPro jec t lets you scroll righ t over 
the page breaks be tween the pages tha t make up a chart. After you print out 
such a multipage schedule chart, however, you need to tape it together 
carefully before you can hang it on your wall. 

' * file Edit Chart Task layout Dates fonts St e 

Figure 8.18 Viewing the project table 
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PLANNING AND TRACKING 

Once the basic information about a project has been entered in a MacProject 
document, its usefulness has only just begun. You can use the chart to ask 
"What if?" questions about the project schedule. "What if it takes four more 
days to choose sample library elements?" "What if we go to ten-hour work 
days-when will we finish the project then?" Posing and answering such 
questions is easy with MacProject. 

To track an ongoing project, you should always work with a copy based 
on the original planning document. Keep the original safe, so that you can go 
back to look at it from time to time and marvel at how optimistic you had been 
about the schedules. 

As a project moves forward , some tasks may take longer to complete than 
planned. Hopefully, others take less time than was allocated. Using a copy of 
your original MacProject document, you can find out just what effect each 
slippage or saving will have on the timing of the project's milestones. 
MacProject makes this power available to managers without requiring a long 
study of an obscure project-scheduling system. By directly manipulating 
schedule charts and tables, you can use MacProjcct to track projects of many 
levels of complexity, including those with schedule charts that would cover a 
wall of your office. 
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NO MAC IS AN ISLAND 

An information-processing device ·would be useless without a way to output 
the results of its information manipulations. T he Macintosh's two primary 
means of outputting are its display screen and its printers. Both are extremely 
useful forms of output. The display of text and graphics on the screen p rovides 
an immediate and highly interac tive display of information. Printed output 
provides information in a compact, transportable, and comprehensive form. 

A third form of informa tion output from the Macintosh is the link you can 
establish between the Mac and other computers. Having a link to other 
computers facilita tes collaborative work with your colleagues who use those 
computers. It is possible to exchange documents with other computer users 
quickly and easily a t re mote locations, even thousands of miles away. A link to 
other computers also makes it possible to distribute your work electronically 
to people who need access to information you can provide. 

A link to other computers is not only an output channel, it is a lso a new 
input channel to your Mac. Thus far in this book we have assumed that all 
information entering a Mac came from either the keyboard, the mouse, or a 
micro- fl oppy disk. Receiving informa tion from other computers makes it 
possible to carry out collaborative work creating or editing documents. If the 
other computer you are communica ting with is a rviacintosh, you can exchange 
any document files, including spreadsheets, p roject schedules, MacPascal 
programs, and MacPaint graphics. Two Mac users at opposite ends of the 
country can jointly develop a project plan, for example, successively 
modifying a MacProject d ocument and exchanging it fo r comments and 
further editing. Two authors working together can send each other revised 
versions of the same tex t files. In fact, if the exchange of information is strictly 
textual, you can easil y exchange documents with almost any other computer, 
not just with Macintoshes. 

FOUR COMMUNICATION METHODS 

There are four ways in which you can exchange d ocuments with other 
computers: by micro-floppy disks, by local serial connection, by telephone 
connection, and b y local area network (LAN) . 
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Micro-Floppy Disks 

If the other machine is a Macintosh, you can use a micro-floppy disk to 
exchange information. Any document or group of documents can b e copied to 
a micro- floppy and given to another Macintosh user for his or her use. So long 
as the o ther user has the application program that uses that type of document, 
he or she can use the documents on the disk. 

Local Serial Connection 

If the o ther machine is not a Macintosh but is in the same room with the Mac, 
you can usually connect the two for purposes of communication by using their 
serial interface ports. In the case of the Mac, this means using the 9-pin 
connector lab eled with the telephone icon. On the other computer you will 
usually use a25- pin RS-232-C connector. :'\laturally, you'll need a special cable 
and appropriate software for each machine. More on this below. 

If the other computer is an IBrvl mainframe computer, you w ill need to 
use a special piece of hardware called a protocol converter, such as AppleLine. 
This device lets the mainframe system treat the Macintosh as a special type of 
terminal (the IBM 3278 Mode! 2) requ ired by such systems. 

Telephone Connection 

If the two computers are not in the same room, you can connect them b y 
means of the telephone and a modem for each computer. A modem is a device 
that converts the electrical signals that a computer sends and receives through 
a serial port into the signals tha t a telephone line carries. Each computer must 
have appropriate software for the communication process (such as Apple's 
MacTerminal applica tion ), just as in the case of direct connections. 

Local Area Network (LAN) 

We will all undoubtedly be hearing a great deal about LANs, or local area 
networks, during the nex t few years. A LAN is a set of computer worksta tions 
and other devices , such as large hard disk drives and fast laser printers, 
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physically linked by communication cables. Each computer, disk drive, 
printer, or other device on a LA:'\J is said to be a i\ODE in the network. Each has 
a device (or software) fo r controlling communications with the other nodes on 
the network. Usually all the nodes in a LAN are within a few hundred feet of 
each other. 

LA:'\Js make a great dea l of sense for environments in which groups of 
people work together using a number of computer workstations. From an 
economic point o f view, their advantage is that they make it possible for each 
computer user to have access to expensive peripheral d evices, such as hard 
disks and laser printers, that would be too expensive to provide for each 
computer. From the perspective of collaborative effici ency, a LAN provides 
the easiest and fastest way for colleagues to exchange documents electron
ically. As we will see, the Macintosh already offers two approaches to local 
area networking. 

HOW TO START COMMUNICATING ELECTRONICALLY 

You already know how to communicate with other Macintoshes by exchang
ing document disks. If you work in a collaborative Apple 32 system 
environment or if you belong to a Macintosh users' group , you have probably 
already exchanged disks with other users. For communicating through direct 
serial connections or over telephone lines, you need to use an appropriate 
communications program, such as MacTEP, a public-domain program, or 
M acT erminal, a multi fea tured communications application from Apple. 

T o transmit information to or from another computer, you must first be 
connected to the other computer. T here are three ways to do this. F irst, you 
can be physically connected to the second machine by a cable. Inside the cable 
are a number of w ires. One of the wires is used b y your Yf ac to send data to the 
other computer. Another w ire receives data from that computer. Still other 
wires serve other purposes, such as signaling that the computers are connec ted 
to each other, or stating their readiness to send or receive da ta. Figure 9.1 
shows a cabling arrangement for connecting a Mac's phone port to a modem 
or a second computer. If you aren't up to soldering your own cable, you can 
probably get one from your dealer. 
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Macintosh 
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Figure 9.1 A cabling arrangement for communications 

One of the trials of communicating with other com puters is that the so
called RS-232 "standard" for communications interfaces does not ensure that 
two RS-232 devices can work together with a simple cable. The full RS-232 
standard provides for up to twenty- five wires inside a cable. Each of those 
wires is soldered to a small pin in a connec tor a t the end of the cable. rhe pins 
fit into holes in the computer's or modem's matching connector. The problem 
is that most of the twenty- five pins can be used in several different ways (or 
not at all ) without violating the "standard ." That means that different 
computer manufacturers make different choices about which of those pins 
will actually b e used and how they will be used. This often makes it very 
difficult to connect machines directly. If you must frequently connect you r 
Macintosh to different machines in order to transmit or receive text files, 
consider purchasing a SmartCable (IQ Technologies, Inc. , 11811 N.E. First 
Street, Suite 308, Bellevue, W A 98005 ). This clever device auto matically 
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figures ou t which pin is sending data, which one is receiving data, and which 
pins are doing the "handshaking"-telling when the system is ready to send or 
ready to receive. It has 25-pin connectors at both ends, but you can use it with 
your Macintosh phone port by using your printer cable or the Mac modem 
cable to go from the Mac 9-pin connector to the SmartCable. 

The second way to be physically connected to a second computer is to use 
a modem and the telephone system to link up. The telephone network 
connects your tvlac's modem to the modem of another computer, whether that 
system is another microcomputer such as a Mac or an IBM PC, a mini
computer like the DEC VAX ll/750, or a large mainframe computer. Of 
course, the connec tion isn't entirely physical if the telephone link happens to 
make use of satellite transmission, but the principle is the same. 

The third way to connect to another computer is to use the AppleLine 
protocol converter. l'his device allows you to connect your Mac to an IBM 
mainframe computer. With AppleLine and MacTerminal, your Mac can 
emulate an IBM 3278 terminal. The AppleLine peripheral device connects the 
IBM mainframe's communications controller to the Mac or to a modem that 
connects to the \1ac. The AppleLine converts the signals that IBM computers 
use into the kinds of signals that most other computers use, including the 
Macintosh and Lisa systems. 

There are several advantages to using a Mac in place of an IBM 3278 
tv1odel 2 terminal. One is that it takes up much less room on your desk. More 
important, the Mac can be used to d o a great d eal of work without constantly 
interacting with the mainframe system. Once you've used the Mac to get 
information from the IB tvl mainframe, you can manipulate it independently of 
the big computer, perhaps by ed iting the text with MacWrite or by 
manipulating the numbers in a Multiplan spreadsheet. When you've got the 
results you want, you can copy them to the Clipboard and then paste them in 
the MacTerminal window, sending them in a burst to the mainframe. 

Many mainframe users are very happy to do as much of their work as 
possible on the Mac because its response time can be so much better than a big 
computer's. The mainframe must divide its processing time among all the 
users currently sharing the system. When many users give the computer many 
tasks at once, its response time can slow down tremendously. Sometimes it can 
take many seconds to respond to each key press. If you've already entered all 
the work on your Mac, you can quickly dump it to the big IBM. If response 
time is terribly slow at that moment, you can take a coffee break and let the 
Mac worry about sending each line to the mainframe when it is ready. 
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USING MACTERMINAL 

The MacT erminal applica tion provides software control that makes all three 
of these kinds of machine communication- direct serial connection, tele
phone links, and connection through the AppleLine protocol converter. 
MacTerminal is an application tha t lets you use your Mac as though it were a 
computer terminal. A computer terminal has a keyboard and a screen, like a 
personal computer, b ut it usually doesn' t have very much internal memory or 
any form of mass storage such as a disk drive sys tem. Terminals let a user type 
information that is immediately sent to computers, and they display infor
mation that the computer sends back. MacTerminallets you d o more than 
type things to other computers, however. It also lets you send documents 
direct from Macintosh disks and receive whole documents and put them on 
disk. 

Different terminals have different performance characteristics. For 
example, a Hazeltine 1520 terminal uses a set of digital codes to transmit and 
receive certain instructions which is different from that used by a Lear-Sieglar 
ADM 3-A terminal. The standard emulation mode provided b y the Mac
T erminal program makes your Mac look like a Digital Equipment Corpora
tion (DEC) VT100 terminal, the terminal type in w idest use today. Most large 
time-sharing computers, such as the ones you can access b y telephone, can 
interact with a VT 100. 

MacTerminal controls are provided through its five pull-down menus 
(Figure 9.2) . MacT erminal users should also remember to make app ropriate 
use of the Apple menu's Scrapbook and Note Pad options too. It can be very 
convenient to load the Scrapbook or Note Pad w ith the elements you want to 
transmit from MacTerminal. 

In MacT erminal, you are presented with a window capab le of displaying 
twenty- five lines of 80 characters of 9-point font (Figure 9.3). If you choose to 
activa te the 132-character- line option, yo u can horizontally scroll, using a 
scroll bar at the bottom of the window. Small indicators with labels such as 
" On Line" give sta tus information about the current state of the emulated 
terminal. " O n Line" means that whatever you type w ill be transmitted to the 
connected computer. " Local" means that your typed input will not b e sent out 
from the phone port. " Kbd Locked" means that nothing typed on the 
keyboard will be sensed by the emulated terminal; typed input will not appear 
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on the screen, nor will it be transmitted. T he "Ll " ... "L4" indicators serve 
the same function as four lights on the DEC VT 100 terminal. You will 
probably not ordinarily need to be concerned with the special functions 
rep resented by these lights. 

If you have a good connection to another computer, and if that computer 
has a program handling your input, you can simply type in the MacTerminal 
window, and all the typed input w ill be transmitted to the connected 
computer . But suppose you want to send a complete text document to an 
Apple II computer in the same room. You would first connect the two 
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computers' serial ports with an appropriate cable (one that connects the Send 
Data pin on the Mac to the Receive Data pin on the Apple II , and so on). Then 
you would start communications programs on the two computers. If you were 
using the Apple Pascal operating system on the Apple II, you might choose to 
use the PTerm program from Southwestern Data Systems ( 10761-E Woodside 
Avenue, Santee, CA 92071). Just as .\llacTerminal makes the Mac act like a 
COI(lputer terminal, so PTerm makes the Apple II running the Pascal operating 
system act like a terminal. 

To b egin the fil e transfer process, choose the Send File option from the 
File menu in MacTerminal. In Figure9.4 a text document named "Apple2" has 
been selec ted from the available choices for transmission to the connected 
Apple II computer. The same method can be used to send Macintosh text files 
to other local microcomputers, such as an IBM PC or a Hewlett-Packard 
microcomputer, or any other machine that has a serial interface and terminal 
emulation software that supports the use of that interface for machine 
communica tions. 
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To make the file-sending operation work, the terminal emulation 
program in the other local computer must have an option to receive an 
incoming file for storage on disk. Most popular microcomputer terminal 
emulation programs, such as PTerm, do have such an option. This provides 
you \vith a straightforward way to transmit text documents from the 
Macintosh to other computers. These documents are the type you create in 
MacWrite when you use the Text Only button from the Save As window. 

If the other computer is another Macintosh, you can even transmit 
documents of other types, in addition to text. To do so, you must first establish 
the appropriate file transfer settings (Figure 9.5). From the Settings menu, 
select the File Transfer option to bring up a dialog box with the file transfer 
setting options. Two different transfer methods are possible. The Modem7 
method is one that uses a communications protocol developed several years 
ago for communication among an earlier class of computers, which all used 
the CP/ M operating system. Because the Modem7 method became so 
widespread, it has since been adopted by the d evelopers of software for other 
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opera ting systems as a standard fi le transfer protocol. This means tha t 
communications progra ms for the IBM PC and the Apple Macintosh were 
implemented with the Modem7 option. 

M odem7 makes it possible to transmit not only text files but also other 
types of documents, such as YfacPaint pictures or Filevision drawing files. You 
can even transfer applications, al though it is likely that soft·ware developers' 
copy protec tion schemes w il l prevent the copy of an applica tion from 
working properly on the new disk. Yfodem7 is also a useful method for 
tra nsferring fil es, especially files tha t a rc no t simply text files, w ith other 
comp uters tha t have software that uses the yfod em7 transfer method . I t 
performs a number of checks on the transmission d a ta to ensure tha t it is error
free. 

Computers for w hich M od em7 software is available are typically o ther 
microcomputers rather than larger, time-sharing minicomputers or main-
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frames. When you communicate with such large systems, you should stick to 
the Text transfer method . 

The option to specify a delay following every character or every line is 
most likely to b e of use when you are communicating with the big time
sharing systems. These computers usually have to take in data from a number 
of separate sources all at about the same time. When the da ta is being sent to 
these machines at the speed of a normal human typist, they can often- but not 
always-keep up fairly well. Such a system has no way of knowing that your 
input is being sent by an application (MacT erminal) that can pull characters 
out of a fil e and send them out through the serial port a great deal faster than a 
human being could type them. 

When you send a file to a system tha t can't keep up with the Mac's input 
rate, some of the characters may be lost. If you have trouble with lost 
charac ters when you send files to a " host" time-sharing system, first see 
\'llhether specifying a small delay aft er each line solves the problem. The hos t 
may have a small buffer available for storing up to a line of text without losing 
any of the characters for that line. If a line d elay doesn't solve the problem, add 
a delay between charac ters as well. If necessary, you can degrade Mac
Terminal's file-sending performance to that of an ordinary typist. 

CUSTOMIZING MACTERMINAL FOR THE COMPUTERS 
YOU TALK TO 

Other computer systems you want to use yo ur Macintosh to communicate 
with may differ in the ways they interac t. For example, one may have the 
Modem? file transfer method available, and another may not. You can change 
:VlacT erminal's settings to match the req uirements of any other computer yo u 
routinely use. Figure 9.6 shows four documents that are to be sent to different 
computers. These computers each require different settings of the com
munication options. The files lab eled "Osborne! " and "Apple II" are for local 
communications with other microcomputers. As it happens, these two 
computers require that the Mac use different baud rates- a measure of the 
speed with which the computers communicate. To send the Osborne! 
document, I must set the speed to 1200 baud, since tha t is the maximum baud 
rate of that machine. T o send the Apple II document, the baud rate can be as 
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Figure 9.6 Several MacTermlnal documents 

high as 9600. T o use a computer with d ifferent communications char
acteristics, one must customize certain of MacT erminal's attribu tes so that it is 
compatible with the other computer. 

T o set communica tions options, such as the baud rate that MacTerminal 
will use, you use the Compatibility . . . command in the Settings menu. 
The large dialog box in Figure 9.7 offers a set of baud-rate options together 
with a number of other communications a ttributes, such as the number of bits 
used to form a character. It is un fortunate that all computers don' t do things 
the same way when it comes to sending and receiving serial information. 
Fortuna tely, MacTerminal gives you options for making the Mac conform to 
whatever me thods the communicating com puter uses. 

In addition to customizing MacTenuinal to describe the communication 
options of each microcomputer you communicate w ith, you can also modify 
MacTerminal's compatibility for any remote time-sharing computer you use. 
You can use the Communications dialog box to choose an appropriate baud 
rate, number of bits per character, and so on. With the Terminal Settings 
option in the Settings menu , you can determine the characteristics of the 
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emulated terminal (Figure 9.8). The settable features include some that deter
mine what kind of a terminal the Mac will look like to the other computer. 

One of the options that the Phone menu offers is one labeled Phone 
Settings. This command opens a dialog box that le ts the user enter a telephone 
number for the computer for which all the settings customize the MacTermi
nal document. You can enter not only a telephone number but also an area 
code and even a telephone access code, such as one from Sprint or MCI, if you 
are a subscriber to such a service. 

If a telephone number has been entered into this box, you can then use the 
Phone menu to actuall y place the call. Simply pull the menu down to the Dial 
option. The ~lac will immediately instruct the modem to place a call to that 
number. If you have an Apple modem, or one that uses the same signals to 
control special functions like automatic dialing, your fingers need never touch 
a telephone to place a computer- to-computer telephone call. 
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TWO LOCAL AREA NETWORKS 

A nu mber of different local area network implementa tions are open to 
Macintosh users. Each has special features tha t are likely to be an advantage in 
particular situa tions. Two simple and inexpensive local area network ( LAN) 
sys tems are the Corvus Omninet and Apple Computer's AppleTalk system. 

Corvus is a manufacturer of microcomputers and computer peripherals 
that got its start as a hard disk drive manufacturer. One of Corvus's earliest 
products was a network system that allowed several microcomputers to share 
the same large disk drive. Tha t produc t evolved to the modern Omnine t 
system, which has the largest installed base of any microcomputer network 
manufacturer as of this writing. 

The heart of an O mninet system is a hard disk drive. Each hard disk drive 
made b y Corvus incorpora tes fil e server hardware. T hese circuits, together 
with the appropriate software (also supplied b y Corvus) , make it possible for 
a number of different computers to use the drive as though it were connec ted 
directly to tha t computer alone. File server systems are so named because they 
serve files to the computer systems to which they are connected . As you can 
imagine, in file server systems there is a danger that one user's documents on 
the hard d isk could be altered b y another user. Corvus solves this problem b y 
letting you divide the disk into a number of separate volumes. 

A VOLUME is an area or set of areas on the disk that can b e trea ted by the 
Mac's software as though it were an independent disk drive, one with lesser 
capacity than the real hard disk. T he Corvus software lets one user in the 
network set up the basic structure of the network system, d eciding how many 
volumes the hard disk will be divided into and hO\v large each one will be. 
(They need not all be the same size.) T his special user, who is called the 
network manager, also tells the system who the authorized users are and to 
what volumes each user should have access. 

One very simple means of ensuring that one user cannot damage another's 
documents is for the network manager to ensure that no volume can be 
accessed by more than one user. This is probably too restrictive a solution for 
most LANs, since one of the justifications for LAN technology is that it 
provides very convenient methods for colleagues to share documents that are 
being co llaboratively developed. A better approach is to give each user at least 
one private volume, to which the other users do not have access, and also to 
give the user access to a number of shared volumes on the disk. If necessary, 
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certain users can be given only limited access to certain volumes. It is possible 
in the Corvus system to give a user the right to read material from a particular 
volume, but not to write to it. If the user wants to alter a document, he or she 
must send a copy to a volume for which the user has write access. 
Collaborators can actually do most of their work on private volumes. Then, 
when they want to turn over their most recent revision of a working paper, a 
spreadsheet, or a project chart, it can simply be transferred to a volume shared 
by a colleague. 

A second means of communica tion provided b y Omninet is electronic 
mail. Users can send documents direc tly to other users in the network, whether 
they are currently using the sys tem or not. The recipients can then decide 
whether to keep the received d ocuments in their private volume space or to 
put them in the trash after reading them. Other options include forwarding 
copies of the messages to still other users on the network. 

Probably the greatest advantage of the Omninet system is that it permits 
computers d eveloped by different manufacturers to share the same hard disk 
drive. ·when the computers share the same operating system (such as the 
widespread p -System from Softech Microsys tems) , they can share almost 
every kind of file on the disk. When the computers use different opera ting 
systems, they can still share text documents . With Corvus networking 
products, users of the IBM PC, the Macintosh, the Apple lie, and other 
computers can all make collaborative use of the same Omnidrive hard disk 
drive. 

In addition to file sharing and electronic mail, Omninet makes it possible 
for all the users of a network to share printers. Without the use of a LAN , the 
only way that different computer workstations can share a printer is by 
physically disconnecting and reconnec ting cables whenever a new user wants 
to use the printer. With Omninet, a node in the network can be the network's 
PRINT SEHVEH, a computer or a spec.ialized hardware d evice that dumps text 
fil es to a printer connec ted to the print server. lf several network users request 
that new fil es b e printed while the print server is printing another user's text, 
then the server will que11 e those reques ts and perform each printing job in turn. 
Check with your d ealer to de termine the current fea tures of Omnine t print 
serving for Macintoshes if this aspect of network support is especially 
important for your work. 

Apple's local area network, AppleTalk, lets members of the Apple32 
family of computers share devices such as Apple's file server and print server 
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systems. The file server features permit several ~1lacintosh or Lisa-2 users to 
share the Apple hard disk drive. The print server software, used in conjunction 
with a file server, le ts more than one computer use the Apple laser printer 
without go ing to the trouble of checking with other users and changing cables 
whenever you want to print from yo ur system. A laser printer makes an 
especially good printing d evice for a LAN sys tem. It is more expensive than 
many other printer technologies-an expense that pays off in high-quality 
output and enough speed to handle the printing requirements of many users 
without imposing an undue wait on any of them. 

If you are in the position of having to select a LA N for your 'Nork 
environment , cons ider your needs in making the choice. If it is important tha t 
you connect computers from a number of manufacturers, consider the Corvus 
Omninet system. Omninet is a mature, well-debugged technology. On the 
other hand, add-in AppleTalk interfaces for computers such as the Applelle 
and the IBM PC can bring these systems into Apple's network. 

If you want to get the most out of a network that does not include a variety 
of microcomputers but instead fully utilizes the Macintosh and Lisa technolo
gies, then AppleTalk is probably the right system for you. Per-station costs are 
very low. T o add aM acintosh to an existing AppleBus network, all you need to 
purchase is some cable and the inexpensive connection module, a box about 
the size of a mouse. This box has an 18-inch drop cable that connects it to the 
Mac's serial communications port-the one with the telephone icon. Installa
tion is as easy as " installing" the cable that connects a Mac to an Imagewritcr 
printer. 

AppleTalk permits up to thirty-two devices to communicate directly, 
including computers, fil e servers, printers, modems, and other peripherals. 
The two most obvious services provided by AppleTalk are file sharing and 
electronic mail. Other networking applications, such as shared data base 
systems, are likely to come from third-party software developers. 

App leTalk was designed to permit access to other netvvorks, including 
more expensive, high-speed networking systems. AppleTalk is a work area 
network- a Very Local Area Network. It w ill soon be possible to com
municate w ith Backbone Networks, those that can communicate over greater 
distances and at higher speeds, including those supported by IBM, from 
AppleTalk. It's a good bet that Apple Computer will put its technological 
resources to work to make continuing contributions to the AppleTalk LAN 
system. 
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TWO STYLES OF MACHINE COMMUNICATION 

Local area networks and terminal emula tion represent two quite different 
styles of machine communication. LA Ns presup pose very rapid transfers of 
information , while terminal emulation commonly uses speeds as slow as 30 
characters per second (300 baud) and sometimes even less. As their name 
implies, LANs can be used only for computers that are quite close together, 
usually in the same building, while terminal emulation plays a role in linking 
computers that can be on opposite sides of the earth. LANs also require a 
significantly larger financial commitment, since hard disk drives are an 
essential part of most LAN implementations. Terminal emulation requires 
only a program such as MacT erminal and, if the communicating machines are 
not directly linked by a cable, a modem-some of which are quite inex
pensive. 

On the Macintosh, both types of communication system typicall y make 
use of the Mac's high-speed serial interface, the one that has a 9-pin connector 
with a telephone icon. Does this mean tha t you can't use both communica tion 
modes at the same time? Is it impossible to use a hard disk system and a 
modem together? Some hard disk systems, such as the T ecmar MacDrive, 
provide a 9-pin connector that functions as your remote serial port while the 
hard drive is hooked up . If you are using a hard disk that doesn't bring out the 
telephone connector on its cabinet, you may be able to deal with the problem 
in software. If your terminal emulation program supports the use of the printer 
port (as M acT erminal does) , you can use tha t connector for your telephone 
communications while preserving the high-speed port for LAN usage. Of 
course, you w on't be able to use a printer from that port while the modem is 
connected there, but with luck you will have access to a print server through 
the LAN. 

Despite the differences in communicating w ith other computers through 
the two different methods, they have important features in common. Both can 
be used to send simple messages to users of other computers. :\11 ore significant, 
both can be used to improve your productivity by letting you share work with 
colleagues at the Macintosh document (file) level, ra ther than just through the 
medium of printed output. 
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HELP WITH MACP AINT 

A number of prod ucts have emerged to help MacPaint users in the 
development of graphic d isplays. Some of these are separate applications that 
can use MacPaint d ocuments or tha t produce documents you can elabora te 
further with M acPaint. 

There is one way tha t any other Macintosh application can b e used to 
produce a MacPaint document. You can always create a MacPaint "snapshot" 
of the current screen sim ply b y typ ing Comrnand-Shift-3 with the Caps Lock 
key d own. T his puts a copy of the current screen display on the disk and labels 
it " Screen 0 " (or "Screen 1" if there is already a "Screen 0," and so on). You can 
la ter give these graphic images more meaningful names and, if you choose, 
edit them using M acPain t. 

Products that can b e used to produce Yf acPaint-type documents include 
d igitizing tablets and video digitizers. A D IGITIZ ING TABLET is a device that can 
be used to trace drawings or to map points on a printed surface into a graphic 
representa tion of tha t surface. The mouse is a wonderfully easy-to-use in put 
d evice for graphics work tha t is essentia lly freehand. If a tracing must be d one, 
a true d ig itizing tablet provides a much more effec tive method for entering 
the elements to b e traced than does the mouse. It is possible to treat the mouse 
as a pretend digitizer b y taping a pointing element, such as a bent paperclip, to 
it. T hen use the po int of the paperclip as the tracing pen. T he results w ill 
require a lot more editing than would b e the case if a digitizing tablet were 
used. 

A VIDEO DIGITIZER is a video camera with supporting interface electronics 
that lets a user make a v ideo image of anything he or she p oints the lens a t. Such 
systems usually take a number of seconds to store an image, so they are best 
used to make graphic images of still ob jects ra ther than moving ones . These 
graphic images can la ter b e edited using MacPaint. 

Koala MacVislon 
Koala Technologies Corporation 
31 00 Patrick Henry Drive 
Santa Clara, CA 95050 

Micron Eye Video Digitizer 
Micron Technology, Inc. 
2805 East Columbia Road 
Boise, ID 83706 



ThunderScan 
Thunderware, Inc. 
44 Hermosa Avenue 
Oakland, CA 94618 
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These digitizers cost only a few hundred d ollars, and they let you capture 
anything you can photograph in a MacPaint document. 

Other products simply provide ways to use MacPaint more easily or more 
effec tively. One such class of ancillary produc ts is clip art portfolios. A CLIP 

AnT POHTFOLIO is a disk with a number of MacPaint documents with potentially 
useful drawings or patterns. Such portfolios include: 

ClickArt 
T/ Maker Graphics 
2115 Landings Drive 
Mountain View, CA 94043 

Mac the Knife 
Miles Computing, Inc. 
7136 Haskell Avenue, Suil~ 300 
Van Nuys, CA 91406 

McPic 
Magnum Software 
21115 Devonshire Street, Suite 337 
Chatsworth, CA 91311 

and 

daVinci Graphics Packages 
Hayden Software 
600 Suffolk Street 
Lowell, MA 01853 

The images in such portfo lios are created b y professional artists. Many users 
will decide that the expense for such samplers is well invested, given the time it 
would take the m to replica te the included artwork on their own. Figure 10.1 
was created with MacPaint by combining a number of separate clip art 
images from ClickArt. 
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Figure 10.1 A MacPaint document composed with CllckArt, a graphics sampler 
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To use clip art, you simply copy symbols, patterns, pictures, or whatever 
into your own MacPaint documents from the clip art documents, using the 
usual Macintosh cut-and-paste techniques. A number of specialized clip art 
disks are available, each appropriate to the needs of different groups of users. 
Theda Vinci series from Hayden, for example, includes separate packages for 
landscape design, building design, and interior design. If you keep abreast of 
clip art developments, you may find that a portfolio that meets many of your 
own graphics needs is available. C heck with your dealer and scan the 
advertisem ents in magazines like MacWorld. 

A special case of clip art is PATTER:-.J ART, files tha t consist of sets of patterns 
that you can copy into the pattern pale tte at the bottom of the MacPaint 
screen. One source for pa ttern art is 500 M em1 Patterns, from 

FingerTip Software 
3327 East 14th Street 
Long Beach, CA 90804 

You can p ut any pattern you like into a pa ttern slot on the MacPaint pattern 
palette. The only requirement is that the pattern must exactly fill a square 
sixteen dots on a side. To paste a pattern from the graphics editing window 
into one of the pattern slots, first click the pattern you want to rep lace in the 
pattern palette. Then choose the Edit Pattern option in MacPaint's Edit menu. 
(As an alternative, you can just double -click on the pattern box you want to 
replace w ith the new pattern.) Click the pattern area you like in the editing 
w indow. After you click the OK button, the new pattern will be installed in the 
pattern box you selected . If you save the MacPaint document, it w ill have that 
pa ttern choice available until you choose to re place it. 

CREATING GRAPHICS WITH A WORD PROCESSOR 

A kind of graphics construction is possib le from within a word processor, 
such as Mac\Vrite or Word. Fonts are not limited to containing letters of the 
alphabet as symbols. F or example, Apple's Cairo fon t can be used to create a 
REBUS , a combination of words and pictures that can be read as words or 
syllables. 
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To use a graphics font effectively, you have to know where the p ictures 
are on the keyboard. One way to keep track of this is to construct a keyboard 
map. I made the keyboard map shown in Figurel0.2 using MacPaint, labeling 
each key both with its conventional alphanumeric character-in N ew York 9-
point font-and with its 18-point Cairo character. 

INTRODUCING MACDRAW 

MacPaint is an application for creating pixel-oriented graphics. Every dot on 
the screen is under your control in MacPaint, and the stored MacPaint 
documents consist of patterns of dots. MacDraw is not a pixel- orien ted 
graphics system. Instead of creating documents that record the placement 
of every dot in a drawing, MacDraw remembers its documents as collections 
of objects such as rectangles, arcs, lines, and text. Such objects appear on the 
screen as collections of pixels. MacDraw does not remember them as 
collections of pixels, however, but as a set of codes that specify the type of the 
object and such features as its height, width, and so on. When you move an 
object on the screen, MacDraw does not move the pattern of dots, but rather 
erases and 1·edraws the object, using this underlying abstract representation. 

Another object-oriented graphics system is Filevision from Telos, 
covered in Chapter 7. Filevision lets the user store data forms that include 
extensive information about the represented objects. MacDraw does not have 
this capability, but it does offer a more extensive repertoire of drawing tools 
than Filevision, and it lets you make larger drawings. If your drawing 
requirements do not include storing alphanumeric data about graphic objects, 
then you may prefer MacDraw to Filevision. 

What advantages does MacDraw have over MacPaint? One advantage is 
that MacDraw documents are in some ways much easier to edit than MacPa int 
documents. In MacDraw, you can edit a stored document with overlapping 
objects and decide to spread them apart from each other in the drawing. 
Because MacDraw stores the scene as a collection of objects rather than as a set 
of pixels, if one object overlaps another, the obscured portions are not lost. 
You can ordinarily rearrange the elements of a drawing much more easily if it 
is done in MacDraw than if it is done in MacPaint . 
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An advantage of MacDraw over both Yl acPaint and Filevision is that it 
le ts you draw much larger documents than either of those applications does. 
With the current version of Filevision, you are limited to drawings that fit in 
the Filevision d rawing window. With MacPaint, you can crea te and edit 
images about three times the size of the screen-images as large as 8-by -10J~ 
inches. MacDraw lets you work with much larger drawings. I t provides both 
horizontal and vertical scroll bars that le t you move over the entire surface of 
your drawing, from the top left to the bottom right portion of yo ur draw ing. 
Figures 10.3 and 10.4 show two parts of an organization chart. The drawing 
was completed simply by clicking on tools such as the Rounded Rectangle and 
dragging out the shapes on the display. 

The se t of tools available for crea ting images in MacDraw is more 
comprehensive than in Filevision. A glance a t the menu options reveals tha t 
many more fill patterns are available than in Filevision. Other special features 
include control over line thi ckness and a special line type with arrowheads. 

M acDra w documents can get very large indeed. The printed output from 
a single MacDraw dra,ving can cover up to sixty printed pages (Figure 10.5 ). 
When all the pages have been pasted together, you can have a composite 

Fill Lines Pen 

Figure 10.3 The top left portion of the Organization Chart drawing 
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' • File Edit Style Font Loyoul Arronge Fill lines Pen 

Figure 10.4 The bottom right portion of the Organization Chart drawing 

Oro wing Size: 8" H I 0 " 

OK ( Concel J 

Figure 10.5 The drawing size dialog box 
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MacDraw document to tack to your wall tha t is 8 fee t wide and 4 feet high. 
Tha t's enough room for a detailed organization chart for a sizable compa ny. If 
you prefer, you can have a large-scale landscaping or architectural plan, or 
any other structured drawing for which it makes sense to consider the pictured 
elements as separate objects ( for example, F igure 10.6). 

You might think tha t the object status of everything in a drawing would be 
a disadvantage when you want to move a group of drawn elements toge ther. 
Suppose you wanted to reposition the box labeled " Clerk Levl " in the 
organization chart in Figure 10.4. It would be awkward if yo u had to selec t 
each object and move it separa tely- two rounded rectangles (one filled with 
black, the other with white) and two tex t elements ( in different fonts and 
styles). You don't have to make four separate moves. You can bind these four 
objects together into a single object, using the Group option in the Arrange 
menu. First drag through the whole set of objects, b eginning well above and to 
the left of all of them. All the objec ts w ill be simultaneously selected (Figure 
10.7 ). In Yl acDraw, as in Filevision, you can tell tha t an object is selec ted when 
its small rectangular " handles" are present. At this point, if you invoke the 
Group option, the four sets of handles will be replaced by one se t of handles 
that includes the entire group . You can now rep osition the entire group as 
though it were a single objec t (Figure 10 .8). La ter, if yo u want to edit one of 
the components of the group, you can use U ngroup to separa te the collec tion 
back into separately selectable components. 

MacDraw provides many fea tures to give you fine control over the 
placement of objec ts in a draw ing. T he Show Rulers option in the Layout 
menu will bring up both a horizontal ruler, along the top edge of the drawing 
window, and a vertical ruler, on the left side of the w indow ( Figure 10.9). As 
you move the mouse pointer in the drawing window, tiny tic marks on the 
rulers follow your movements. By pointing the hot spot a t a particular point on 
your drawing, you can read both its horizontal and vertical values on the 
rulers. 

You can even use the C ustom Rulers ... option to bring up a dialog box 
that le ts you choose units of measure for your rulers (Figure 10.10 ). Your 
control over the placement of objects is further enhanced by MacDraw's grid, 
similar to the F ilevision grid . In the screen prints in Figures 10.3-10.5 and 
10.7 -10.9, the grid was visible. In addition to le tting you turn the grid on and 
off, MacDraw gives you the capability to have the grid on but invisible ( Figure 
10.11 ). 
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Figure 10.7 Several objects selected at the same lime 
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Figure 10.8 A moved group 
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Figure 10.10 The custom rulers dialog box 
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Frequent users of MacPaint have often wished for some way to 
manipulate a reas of the pic ture that are too large to fit in the M acPaint 
window. MacDraw gives you a way to edit drawings that are too la rge for the 
MacDraw window. More accurately, MacDraw le ts you shrink your drawing 
to fit more in the window as in F igure 10.12. This makes it possible to select 
large chunks of drawing by dragging over them with the mouse and then 
copying, cutting, or m oving the entire assemblage. Naturally, you can always 
use the Enlarge option to res tore the drawing to its normal size once you have 
completed the operations that require working with the reduced versions. 
MacDraw's many capabilities are reflected in a large number of menu options 
(Figure 10.13 ). 

HELP WITH MACWRITE 

I ust as software and hardware firms have produced aids to productive use of 
MacPaint, so, too, secondary products in support of Mac Write have emerged. 
One example of MacWrite add-on products is software that le ts Macintosh 

Fill lines Pen 
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Figure 10.11 The organization chart without a visible grid 
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Figure 10.12 The Reduce option shrinks your drawing 

owners print with full y-formed-character printers, commonly called letter
quality printers. (I'\ ow that laser printers provide another way to get letter
quality printing from the Mac, the daisy wheel printers are not the only letter
quality game in town.) Fully-formed-character printers, although slower and 
less flexible than laser printers, are somevl ha t less expensive, and they produce 
the typewriter-like text that many business people fee l is essential for their 
correspondence. 

The Mac Daisywheel Connection is a product from Assimilation Process 
( 151 Eastridge Drive, Los Ga tos, C A 95030) tha t le ts the Mac talk to a fu lly
formed-character printer. Assimilation provides both the necessary interface 
cable and a program tha t le ts the Mac use daisy wheel printers. Other 
manufacturers also produce cables and software to support Macintosh letter
quali ty printing. 

TTX, Inc. , produces a 64K-byte printer buffer called the MACpac for use 
with the Macintosh. It can b e used either with the Imagewri ter printer or with 
TTX's own letter-quality printer, the TTX 1014. Using a printer buffer is one 
way to get to use your Macintosh more of the time. Instead of waiting for the 
printer to finish before you can use the Mac, you can let the Mac send all the 
printing instructions quickly to the printer buffer, which then passes them on 
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to the printer at its own, much slower speed . O nce the Mac has finished 
sending to the b uffer, you can use it again, even though the printer may 
continue fo r another hour. 

O ther p roduc ts that w ork with MacWrite include separate applications 
tha t use Mac Write files. MegaMerge (from MegaHaus, 5703 Oberlin Drive, 
San Diego, CA 92121) lets you use Mac Write to crea te a fo rm le tter, which 
MegaMerge can then merge with a mailing list you create to print hundreds of 
individualized letters in sequence. MegaMerge can also b e used to print otit a 
series of MacWrite documents as though they form a single long document. 
This is a useful feature for Mac Write users who must produce long d ocuments. 

WORD PROCESSING WITH MULTIPLAN 

You can use Multip lan to create tables of purely textual ma terials. In many 
cases, you will find that it is easier to format a table of text elem ents using 
Multiplan than using MacWrite . In MacWrite it is all too easy to backspace 
past the tab position w hen you delete an element at a tab , making your table 
reformat itself in an unexpected fashion. In Multiplan, you can trea t the 
columns as tab stops, making it easy to place tabular data wherever you want. 
If it turns out that your table has some numeric elements that are related to 
each other, as in Figure 10.14, you can set up the form ulas to compute 
w hatever portions are computable. Whether or not your table includes 
formulas, you will find that it is easy to p roduce simple text tables using 
Multiplan (Figure 10.15). 

AD VANCED WORD PROCESSING 
WITH MICROSOFT WORD 

Microsoft \Nord is a powerful word processing p rogra m tha t offers many 
capabilities that MacWrite d oes not have. Befor~ consid ering some of these 
fea tures, it makes sense to consider the advantages YlacWrite has over Word . 
First, ivl acWrite is easier to learn. In part b ecause it has fe wer capabili ties, you 
will need significantly less time to fully master MacWrite than to master Word. 
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Figure 10.14 Using Multiplan for simple tables 

Second, MacWrite is faster than Word at doing a number of word processing 
tasks. 

There are a number of reasons for the speed difference. Some of them 
have to do with the \vay the two applications were implemented. MacWrite's 
application code is all in the form of native machine instructions for the Mac's 
68000 processor, but Word's code has two levels-a set of "p-code" 
instructions that are more compact than the corresponding 68000 code would 
be, and an interpreter to convert those instructions into real 68000 cod e as 
required. This approach was dictated by Microsoft's desire to incorporate 
significantly more functionality into Word than could fit in an application 
program d esigned for a 128K Mac. 

Another reason for the speed difference is that Word's program code 
must be divided up into a num.ber of semi-independent segm ents, chunks of 
program that won't all fit in the Mac's memory a t the same time. When you ask 
Word to perform a function tha t uses a segment not currently in RArvf, you 
have to wait briefly while that segment is loaded from the disk with the Word 
application on it. Owners of 512K Macs will find that Word runs a bit quicker 
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on their machines, since each code segment will have to be loaded only once 
from the disk. Thereafter, when you use a Word option that requires a new 
segment, Word will find that the segment is already in memory. 

Another delay that Word sometimes imposes on the user is that of waiting 
for new portions of the text to be loaded from RAM. Like the newer, disk
based version of MacWrite, Word keeps only a portion of its documents in 
memory. When you scroll to a different portion of the document, you 
experience a delay while the new section of the document is read from the 
disk. 

Any delays due to disk-accessing time can be greatly reduced if you are 
working with a hard disk drive (see Chapter 12). Some users who find Word's 
delays annoying when working from micro-floppies say that Word is a delight 
when used with a hard disk system, such as Tecmar's MacDrive or the Corvus 
Omnidrive. 

A simple glance at Word's menus (Figure 10.16 ) does not reveal this 
application's extra power and flexibility. Many of vVord's features are 
accessible only through dialog boxes that are brought up w hen certain of these 
options-the ones with the trailing " ... "-are chosen. 

Word's many enhancements and extra features fall into two general 
ca tegories . Some fea tures are ones that almost everyone will agree are very 
nice to have but would not in themselves justify a switch to a new word 
processor. An example of such a feature includes the Glossary option in the 
Edit menu. The Word glossary is a list of correspondences between very 
simple abbreviations and longer phrases. Rather than retype a frequently used 
long phrase every ti me it must appear in the text, the author can simply type its 
abbreviation, followed by Command-Backspace. When Word sees the 
Command-Backspace keypress, it finds the translation for the abbreviation in 

THINK TANK WINDOW CAPACITY 

Font Size Characters/ lines/ Characters/ 
(Points) line Window Window 

9 82 25 2050 
12 70 17 1190 
18 41 13 533 
24 35 9 315 

Figure 10.15 The printed Multiplan text table 



232 MORE PICTURES, MORE WORDS 

New agN 
Open.. . ago 
Close agw 
Saue ags 
Saue As ... 
Poge Setup .. . 
Print... 3€P 
Print Merge .. . 
Printer Setup .. . 
Quit agq 

Chara£. ter 

Plain teHt 
Bold 
llolic 
Underline 
mmaoom@J 
~UJGlc!lWlm 
Smoll Cops 
Superscript 
Subscript 

F ormots ... ago 

Undo Copy agz 

Cut agH 
Copy age 
Paste agu 
Clear ago 
Show Clipboord 
Show Glossary 

Show Ruler agn 
Show 'fl agy 
Preferences ... 

Normal 

..l'l eft 
Centered 
Right 
Justified 

..~'Single Spoce 
Double Space 
Open Space 

Formats ... 

lobs... agy 

Find... ~F 

Change ... agH 
Go to... ~G 

Do£ument 

Diuision layout .. • 

Footnote... ag( 
Running Head •.. 

Repogina~e 3€J 

Figure 10.16 The Word menus 
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the glossary and inserts that phrase in place of the abbreviation. In the glossary 
associated with the Word document being edited in Fig. 10.17, the phrase 
"Object-Oriented Graphics Construction Systems" will appear when the 
abbreviation "OCS" is followed by the Command-Backspace keypress. 

Adding new elements to the Word glossary is an easy matter. You first 
copy a phrase to the C lipboard fr.om your document. Then choose Show 
Glossary from the Edit menu, type in the name of the new item, and type 
Command-V to paste the C lipboard contents into the glossary. 

Another Word feature is the set of enhanced selection methods it 
provides. If you move the pointer just to the left of the left margin, it suddenly 
changes orientation, pointing to the upper right instead of to the upper left. 
·when you now click, the entire line of text at that point is selected (Figure 
10.18 ). If you double-click, the whole paragraph is selected. A third new type 
of selection available is the selection of vvhole sentences \:v ithout dragging 
through the entire sentence. To select a sentence, position the text pointer 
anywhere in the sentence and then click while holding the Command key 
down. 

• File Edit Seorch Chorocter Porogroph Document 

DbjS ys 

• Better pro ~0 Glosso ry 
argument. the 
programmers 

' languages to 
fl'a tures or m 
ma ke c1a1ms r 
Loops/ lnterh 
prOVIded With 
extensiOns. an 

Nome of qloss11r4: 

Object - Orie nted 
Grophics Construction 
Systems 

poge 
footnote 
BTl 

c1a1ms r or lear\-ren:mTn"-mT~~""""..-t:~!!TTIT"T"'!,..,.,.,.,~----1 

thiS 

• Construction s ystems, not programming, will provide the 
solutions . The fourth group holds that users must be g1ven a good 
deal of control over lhe1r computer systems, but that they do not 
need as much control as IS prov1ded by a conventional programmmg 
language Accordmg to thlS v1ew. the reason that spreadsheet 
apphcauons (tor example) have been so successful IS that they g1ve 

Figure 10.17 The glossary window 
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'" 41 Fi le Edit Seorch Chorocter Porogroph Document 

1m ObjSys 

' Object-Oriented Graphics Construction Systems 

The computer mdustry faces a cns1s m software productivity 

t computer usability, access1bhty. and the performance/cost ratio, ever 
l more powerful systems can be made available to la rger numbers of 

users The problem IS, What Will those users do With these powerful 
computer systems Recent expenence has shown us that users Will 
not program their computers 

In the early stages of the personal computer phenomenon, 
most computer owners were perforce programmers Smce there 
were VIrtually no application programs available for PCs, users had 
to wnte the1r own programs or do nothmg With the machmes The 
programs were small and primitive, and real computer programmers 
scornfully referred to them as toys · · wllen they thought about them 
a t all 

Figure 10.18 Selecting a line 

Every word processing user can appreciate these kinds of improvements, 
but Word offers many more significant enhancements- including features 
that many will agree fully justify the additional effort of learning a new and 
more complex applica tion. 

Long Documents 

With Word , the maximum size of your documents is de termined not by the 
capacity of memory but b y the capacity of disk. This advantage is most easily 
realized by users w ith ex ternal disk drives, including hard disks, but even 
single-drive Yfac owners can crea te long documents with Word. 

Wide Documents 

MacWrite limits you to documents that have up to 7J~ inches of text per line. 
With Word, you can crea te wider text documents. A horizontal scroll bar a t the 
bottom of the text w indow le ts you look at e ither end of a long line on your 
screen. 
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Paragraph Formatting 

Word makes it easy to forma t separa te paragraphs differently, without 
inserting new rulers wherever you want to make a forma t change. You simply 
selec t the paragraph to be reformatted and choose the option you want from 
the Paragraph menu ( Figure 10.19). 

Automatic Footnotes 

Word lets you enter footnotes as you write or edit a text. You simply select the 
point at which you want to enter a new footnote and then choose Footnote 
from the document menu. A dialog box gives you the option of numbering the 
footnote yourself or le tting Word do so automatically. The footnote entry area 
is opened as a separate pane at the bottom of the text window-much like the 
:V1ultiplan panes d iscussed in Chapter 4 ( Figure 10.20 ). You can choose 
whe ther to have the footnotes appear on the same page in which they are 
referenced or at the end of the document. 

th1s environment, users 
from undertakmg sen ous program 
Modern commercia l appllcatJons set\,-,;,;;;:..;.;n,.,.,..,.....,:,.;~l"rrl 
excellence. both 1n lunctJonahty and m ease-or -use, lor 1udgmg 
programs A programmmg effort by a non -professional --or even 
by a professional or small group of professiOnals With 1nadequat 

cannot measure the new standards 

Figure 10.19 Reformatting a paragraph 
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Working with Two Parts of a Document at Once 

Word's ability to displa y two portions of the same document is not limited to 
footnotes . .f ust as in the Multiplan, you can in Word use the split bar to create 
separate panes in an editing window. 

Editing More Than One Document at Once 

·word will let you have several open text documents on the screen at one time 
(Figure 10.21 ). At any moment only one window can be active-ready to 
receive text or scroll to a new location. T o activate another, just click on it. It is 
an easy matter to compare part of one tex t document with another in the midst 
of an editing session. As you can imagine, it is also easy to cut or copy from one 
document and paste into another. 
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Figure 10.20 Entering a footnote In Word 
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1nto useful new compos1tlons Second, the 
descnbe (and prescnbe) the ,offrN.<- of the 
compos1tlon 

A deta1led example helps to make clear 
what IS meant by an object-onented 
constructlon system Our r esearch team has 
designed such a system for equ1pment 

Print Merging 

------
-~ - -- ----------

program Kmet.lc, 
const 
UtterMax • 20), 
type 

Coord • (xI , y I , x2, y2 ), 

Figure 10.21 Two open documents in Word 

Finally, Word gives you mail-merging capabilities that :VfacWrite does not 
provide direc tly (although M egaM erge can be used to provide similar features 
with Mac'Nrite). Print merging can be used to automatically generate 
individualized le tters b y merging list data with a form letter. It can also be 
used to chain several documents together wi th sequential page numbering. 

Whether Word's extra features are worth the extra learning time and ex tra 
ex pense to acq uire is a matter for your own judgment. If your text efforts are 
limited to short documents such as le tters, notes, and memos, you will 
probably d ecide to stick with MacvVrite. If you spend a lot of time writing or if 
you prepare long documents, however, Word merits serious considera tion. 
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Many different programming languages are available for the Apple 
Macintosh computer. You can program in Microsoft BASIC, MacBASIC, 
FORTRAI\ , MacFORTH, Modula-2, LISP, Logo, C, Assembly Language, or 
UCSD Pascal. One of the programming languages best suited to the 
Macintosh's capabilities is Macintosh Pascal. 

INTRODUCING MACINTOSH PASCAL 

Pascal is an excellent language to learn because its design reflec ts many 
modern concepts about programming. Until Macintosh Pascal, however, it 
was very hard for people who were not already experienced programmers to 
teach themselves how to program in Pascal. For beginners, Pascal was harder 
to deal with than interactive languages like BASIC. Unlike most other Pascal 
imple mentations, Macintosh Pascal is interac tive. This makes it a very good 
imple mentation for Mac owners who want to teach themselves how to 
program in Pascal. 

Macintosh Pascal-often called MacPascal by its friends-is a full 
implementation of American National Standard Pascal (ANS Pascal). A 
number of extensions that take advantage of special Macintosh features are 
included. MacPascal is a programming environment. Like Multiplan or 
Filevision, Macintosh Pascal is a Macintosh application-quite an elaborate 
application for the development of documents that are not text files or 
spreadsheets or drawing fil es, but Pascal programs. As a full Macintosh 
application, it offers a special set of programmer's tools that make Pascal 
programming a lot easier and more productive than with conventional 
microcomputer Pascals. 

Macintosh Pascal is not, at present, a full Macintosh development 
language. That means you can't write programs that make the MacPascal 
environment disappear, letting you create your own menu bar, your O\.vn 
windows, and so on. It would probably be a mistake to plan to write a major 
application in Macintosh Pascal. Complex applications are b etter developed 
on a Lisa -2/10 computer, using the Lisa Pascal \'\' orkshop. 

\ 'lacPascal is very useful as a tool for the self-directed study of Pascal 
programming, but this is not its only use. Many significant programming tasks 
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can b e accomplished with Macintosh Pascal. It just isn't the right language in 
which to develop large -scale applications that must take over the whole 
computer. 

STRUCTURED PROGRAMMING AND 
THE REALITIES OF PERSONAL PROGRAMMING 

Different programming languages have different design goals. BASIC was 
designed to make it easy for people with little or no mathematical training to 
begin programming quickly. LISP was built to develop programs that 
manipulate complex data structures . The design of the Pascal programming 
language is quite simple, and its structures help ensure the reliability of its 
programs. T hese a ttributes make it both a good language for learning mod ern 
programming concepts and a good language for very large projects. 

Pascal is a good language to Jearn because of its simplicity. In ANS Pascal, 
there is a limited vocabulary of control structures, standard data types, and 
standard procedures to learn. It is a good language for writing large programs 
because it promotes stmctured programming methods. Structured program
ming makes programs much easier to understand and there fore much easier to 
fix or modify, even long after they were first written. 

In struc tured programming, parts of a program responsible for different 
actions are separated into partially independent modules (Figure 11.1 ). 
Modules can contain other modules, but strict rules of module accessib ili ty 
prevent one part of a program from interfering with data that is supposed to 
b elong to a di fferent module. Structured programming helps prevent 
unexpected interactions between unrelated parts of a program . This makes 
programs more reliable; there are fev,rer unexpected behaviors in highly 
structured programs than in less structured ones . Struc tured programs are also 
usually much more readable, and tha t helps make them a lot easier to correct 
or add new fea tures to. 

The basic laws o f modern programming are three: 

1. Plan, plan, plan. 

2. Design completely, in advance of program ming. 

3. Code in a top-down, structured fashion. 



Structured Programming and the Realities of Personal Programming 241 

M . p 810 ro..!l.rom 
I nitioliza tion Section 

I 
ln(!ut lnitioli z otion 

I 
OutD.u.J lnitiolizgtioo 

I 
Main Bod_y_ 

I 
User O(!tions 

I 
Com(!utotion Methods 

I II II I 

I 
S(!eciol O(!tions 

I 
Figure 11.1 Structured programming's modules 

The term TOP DOWN means that you should first think about how a program 
will work globally (a t the top level ), then how each of the components of the 
global des ign w ill work, then how each of those components will work, and so 
on. In terms of Figure 11.1 , you first think about the outermost module, the 
main program, then you think about the next highes t level, the initializa tion 
section and the main body. You begin b y planning the outermost modules and 
work d own to the innermost ones. 

·when you design a program in this fashion, you eventually get to a level 
where all the components a re terms a lready d efined in Pascal. You have then 
completely d esigned a program, starting a t the to p , a very general statement 
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of the program's function, and working down to the bottom, the sequence of 
Pascal statements that make up a program. 

A form of program development much less favored b y programming 
experts is called BOTTm1-UP programming. When you program in a bottom-up 
fashion, you first d efine all the smallest pieces of a program, then string them 
together to make a complete program. Experience has convinced most 
experts that this is an unreliable way to program. With top-d own d esign 
methods, a programmer is much more likely to write simple, logical coding 
that does the job in a straightforward and logical way. 

Top-down coding doesn't always appeal very much to inexperienced 
programmers. Part of the problem is that novice programmers tend to be a bit 
less certain of the effects of the programming language statements they use. 
They want to test the effects of each programming language statement or 
small group of statements on the machine. For a novice or intermediate 
programmer, it is frustrating to have to write an entire program before being 
able to see how any part of it works. 

Even professional programmers find it useful to build major program 
modules separately from each other and to test them independently. This can 
be d one by writing simple test programs that use these modules in a way that 
checks how they will perform in the larger program. This approach is called 
I CREMENTAL PHOGRAMMINC, and when used in conjunction with top-down 
design, it can help to assure rapid development of correct code. The method is 
usually not as practical for the less -experienced programmer, for whom a new 
module may be onl y a single statement. A beginner would like to simply type 
in a statement and see what it does. 

Programming languages are a medium of communication be tween 
human programmers and machines. The native language of a central 
processing unit (such as the Motorola 68000 processor chip that is the brains of 
the Macintosh) doesn't look anythi ng like Pascal or any other high-level 
programming language. It is closest to Assembly language, but Assembly is a 
difficult way for most people to program. It forces thinking about problems at 
a very detailed level from the start, distracting you from the structure of the 
problem itself. It is also much further removed from natural languages ( like 
English) than a high -level language like Pascal. 

Because a computer cannot understand programming language state
ments directly, they must somehow be translated into the machine's native 
language- its primitive instructions- b efore such statements can be carried 
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out by the computer. T his translation process is performed by the computer 
itself under the control of a translation program. 

There are two major types of translation programs that convert high- level 
language statements into machine instructions. They are called interpreters 
and compilers. I NTERPHETEHS transla te language statements into computer 
actions one line at a time as the program runs. A CO MPILER translates all the 
sta tements of a program after it is typed in, in advance of the program's being 
run. 

Compilers and interpreters have different advantages and deficiencies. 
Compiled programs usually run more quickly than interpreted languages on 
the same machine. But interpreted languages are usually easier to develop in , 
particularly for less-experienced programmers. With an interpreted language, 
it is possible for a programmer to type in a single line of cod e and ask to have it 
translated and executed on the spot. Interpreters typically provide much more 
highly interac tive programming environments than d o com pilers. 

Interactive languages are be tter designed to serve programmers with a 
bottom-up progra mming style. T his is proba bly one of the reasons that the 
BASIC and Logo languages have been very popular on personal computers. 
Both are typically implemented as interpreters and can therefore support the 
b ottom- up methods that appeal to novice programmers. 

Most Pascal implementations are compilers. Pascal meets the needs of 
experienced programmers, who want to use top -down d esign, but most 
implementations p rovide unfriendly environments for novice programmers. 
Macintosh Pascal provides a highly interactive environment for program 
development. It can therefore sa tisfy the needs of users with different 
programming styles. 

HOW MACP ASCAL FILLS 
APPARENTLY COMPETING REQUIREMENTS 

T he conflict between the advantages of top-down methods, which have 
been shown to promote program correc tness and reliabi lity, and bottom-up 
methods, which seem so well suited to non-professional programming, is 
largely resolved in Macintosh Pascal. H ere is a language in which expert 
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programmers can feel comfortable but which novices can also use to learn the 
programming art. Macintosh Pascal is an interpreted Pascal, and one that 
provides a number of special fea tures for interactive programming. 

These features-including instant execution of one-line sta tements, 
stepping through a program a line a t a time, examining stored data values 
while a program is running, and others-are provided through special 
windows and menu options. Macintosh Pascal provides up to six windows to 
give the programmer many different views of the progra m. When you first 
open the Macintosh Pascal icon, you are presented with three windows 
(Figure 11 .2 ). The program tex t window is on the left and is labeled with the 
name of the program under development- in Figure 11.2 it is called 
"Untitled ." The other two windows are output w indows for the program, one 
for graphics, labeled " Drawing," and one for text, labeled "Text." There are 
ways to make text appear in the Drawing window, but tha t is another matter. 

r • File Edit Search Run Windows 
., 

:o Untitled TeHt 

progrom Untitled; ~ 
vor 

(Your variab le dec laralionsl 
begin t-

I Your progrom stotements} Orowing 
end. 

I 

0 
¢1 10 f2l 

Figure 11.2 The three standard windows 
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USING MACP ASCAL TO PROGRAM KINETIC LINES 

I wanted to write a program like those I'd seen on other computers that 
produce a continuously changing pattern of line segments. The basic me thod 
for the program is to paint a number of lines on the screen, each a bit different 
from the one next to it. Before drawing a new line, the oldest line of the set 
should be erased. If the computer can produce new lines fast enough, the 
whole set gives the appearance of a moving, organic system. Figure 11 .3 shows 
three "snapshots" of a kinetic lines drawing, taken about two seconds apart. 

To begin with, I used the standard tex t-editing techniques to change the 
Pascal program code in the" Untitled " window. I replaced the program na me 
"Untitled" in the first line with " KineticLines." In Pascal, identifiers-names 
for things-cannot have spaces in them. For the body of the program, I se t up a 
repeat ... until structure (Figure 11 .4 ). In Pascal, all the statements be tween 
the words repeat and until are done over and over again, in sequence, until the 
condition described after the word until becomes true. 

The HESERVED wonos of Pascal, key words such as program, begin, end, 
repeat, if, and then, appear in Chicago font, and the other words appear in 
Ccncva. Macintosh Pascal does this automatically as it analyzes each line when 
it is typed. Reserved words are so called because their use is reserved for 
specia l purposes in Pascal. You can' t create a new variable or procedure and 
name it "program" or "if." The automatic font changes seem to help make the 
meaning of a program clearer to the read er, and even to its author. If you 
accidentall y type in "repeet" when you mean "repea t," you become aware of 
your mistake very soon because the system d oesn' t put the word into the font 
that indicates it is a reserved word. 

In Figure 11.4 , the begin and end are followed by the comment 
"{KineticLines}." A comment is anything enclosed between a set of curly 
brackets, { }. Comments have no effect on the way a program runs, but they 
help the programmer remember wha t the program is supposed to do. 

The main body of the KineticLines program is b etween the begin-end 
pair. When the program is run , this sequence of commands is what will 
happen. To make it work , the system must be told the meanings of each of the 
undefined procedures such as EraseOldLine and DrawNextLine. 

In my first, top-level version of Kine ticLines, I assumed that the program 
would display some fixed number of straight lines. At any moment the 
program should erase the oldes t line. How it does this would be fully specified 



246 PROGRAMMING WITH MACPASCAL 

Figure 11.3 A sketch of a sample kinetic 
output 

in the procedure EraseOJdLine. Then it should draw the next line ( in the 
manner prescribed by DrawNextLine) and then go on to the next line number, 
in procedure SetNextLineN um. The process should repeat indefinitely or until 
the user wants to quit- when UserWantsOut becomes true. 

For now, I decided that I probably didn't want to worry about when 
UserWantsOut should become true . Since a l\tlacPascal user can always stop a 
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running program by pulling down the Pause menu to Halt, it isn't really 
necessary to put a method for user escape into a program like KineticLines. So 
I made UserWantsOut a constant whose value is always False. 

A constant is a name that always represents the same value. Nothing in a 
program can change the value of a constant. Some constants are numbers, 
others have a character value like "A," and others have the value True or False. 
Some programmers use strange names like HellFreezesOver for the constant 
False. This makes the meaning of the program structure: 

repeat 

until HeiiFreezesOver 

intuitively clear. 

r • File Edit Search Run Windows 

:o Untitled Teut 

progrom Kineliclines; IQ 
begin {Kineticlines} 

repeot 1-

EraseOidL i ne(L i neNurn); Drowing 
DrawNextL i ne(L ineNurn ); 
SetNextLineNurn 

unti I UserWent sOut 
end. {Ki neticli nes} 

r 

lo 
101 IG I2J 

Figure 11 .4 Global structure for Kinetlclines 
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The few lines o f code, mostly em pty procedure names, that Kine ticLines 
consists of at this point constitute a top- level design for the program. By the 
generally accepted rules of struc tured progra m development, the next step 
would be to write the declarations of the empty procedures. Instead, I wanted 
to make sure I knew how to draw a line in Macintosh Pascal. In effect, I wanted 
to suspend top-down design and do a little bottom-up coding. 

From the Windows menu, I chose Instant to open a w indow that lets users 
enter single statements for immediate execution (Figure 11.5). I guessed that 
there might be a MacPascal procedure named DrawLine. I imagined that 
DrawLine would draw a line from the point specified by its first two 
parameters ( 5 and 5 in Figure 11.6 ) to the point determined by the second two 
parameters ( 20 and 100 in Figure 11 .6). After I clicked the Do It button in the 
Instant window, a line appea red in the Drawing window. The top left corner 
of the Dra·wing window is 0, 0. I had thought that the order of parameters in 
DrawLine would be " top, left, bottom, right" (y,, x~, y2, x2), just as it is in 

progrem Kineliclines, 
const 
UserWentsOut =Fal se; 

procedure EroseOidUne 
begin {K ineliclines} 
repeet 

EroseOidl i ne(L ineNum); 
DrawNextl i ne(L ineNum); 
SelNexl l ineNum 

unti I UserWenlsOul 
end. {KtnellcUnesl 

Figure 11.5 Pulling down the Instant menu 
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r a File Edit Search Run Windows 
., 

Untitled TeHt 

program Kineticlines; 
const 

Userwant sOut =Fal se; 
1-

procedure EraseOidline 
begin {Kineticlines) Oro wing 
repeat 

EraseD ldL i ne(L i neNum); 
§0 Instant 

( Do It ~ Q 

e Drowline(S, 5, 20, 100); 

~ 
fQI L~ 121 

Figure 11.6 Experimenting In the Instant box 

Macintosh Pascal graphic procedures. such as FrameRec t and FillOval. 
Instead, the order is "left, top, right, bottom," or "x~, y ~, xz, ljz." 

Other Pascal implem entations do not have the Instant window feature. 
This option makes it possible to do a little bottom-up coding just to make sure 
you are on the right track. In this case it helped me to understand better how 
the lower- level code I planned to use ( the DrawLine procedure) really 
worked. Without the Instant option, I would have either had to stop my •.vork 
on the KineticLines program and write a small complete program to test the 
workings of DrawLine, or not find out my misconception until I tested a 
larger, finished program, one in which it would probably be harder to figure 
out the exact cause of an unexpected effect. 

Knowing how DrawLine works, I felt I was ready to flesh out Kinetic
Lines just a bit and run it. The first running version would be a far cry from the 
final version I wanted to create, but it would be reassuring to have something 
working at an early stage of program development. The process of producing 
a series of programs, each of which is closer to your final goal, is called 
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STEPWISE REFI NE ME NT. In a step-by-step fashion, you modify and elaborate a 
program that is initially simple to get to the final result you want. 

In the stepwise refinement technique, you are creating a sequence of 
programs where each is not very different from the one before. This means 
that when something doesn't work as you expected it to, the possible sources 
of the problem are limited. You have a similar version of the program that did 
work as you expected, so you can focus on the differences between the two 
versions as the probable source of the error. 

MacPascal encourages stepwise refinement m ore than most Pascal 
systems do. In many Pascals, the process of compiling a version of the 
program is so time- consuming that users are tempted to make great leaps from 
one version to the nex t, just so they won't have to spend so much time waiting 
for compilations to end. MacPascal is virtually an "instant Pascal." Once you 
have entered a few new lines, you can quickly see the behavior of the new 
version of the program by choosing one of the options from the Run menu. 

To put the stepwise refinement technique into practice, yo u have to begin 

,. • file Edit Seorclllll!l!l Windows 

~ The procedure or function being called doesn't eHist. 

Drawllne(5, 40, 170, 40) [ I 
end; 1Erase01dl1nel ! H 

I!!!• ·Lr-------------------~~ 
procedure DrawNextllne (L : integer):: :: Drawing 
begin 1··!.· !Fil f--------....::..;...::.=..:..:..:.:>!'--------..-1 

PenMode(patCopw); : i 
Drawline(5, 40,-170, 40) 

end, (DrawNextline} 

begin {Kinet.iclines) 
Li neNum ·= 1; 
repeot 

Erese01 dl i ne(L i neNum); 
DrewNextLl ne(L i neNum), 
5e tNextlineNum .~ 

~ unti I User\A/antsOut 
end. {Kineticlines} 

Figure 11.7 The undefined procedure bug 



begin 
PenMode(notPatCopyl; 
Drawline(5, 40, 170, 40) 

end; {EraseOidlinel 
procedure DrowNextline (L 
begin 

PenMode(potCopy), 
Drawline(5, 40, 170 , 40) 

end; (OrawNextlinel 

begin {KlnetiCLl nesi 
LineNum ·= I ; 
repent 

EraseD ldl ine(L ineNw11) . 
DrawNextL ine(LlneNum), 

(5e tNextl i neNum ~ 
unti I UserV/ontsOut 

end 
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Figure 11.8 The very simple program working 

by writing very simple versions of programs- ones that don't really attempt to 
produce the desired final result. Instead of first crea ting a program that really 
draws a kinetic ljne pattern, I w rote one that repea tedly draws and erases the 
same line on the screen. Even though it was very simple-only a few lines 
long-it turned out to have an error. When I tried to Run it, I got a display that 
showed the program had a bug. My program referred to something I hadn' t 
yet defined, the procedure SetNextLineN um (Figure 11 .7). 

The littl e dialog b ox with the bug icon in it told me that the procedure 
didn't exist, and a Hne pointer in the form of a thumbs-down hand showed 
which line the dialog box was referring to. C licking in the dialog box made it 
go away. I found a temporary solution-! changed the procedure call into a 
comment b y enclosing it in curly brackets, since I didn' t want to bother 
defining the procedure yet. When I ran this slightly altered version of the 
program, it worked. A flashing line appeared in the Drawing window (Figure 
11 .8). It flashed because it was continuously being drawn and erased by the 
repeated calls to DrawNextLine and EraseOidLine . 
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program Kineticlines; 
const 
UserWantsOut = False; 
MaxNumlines = 205; 
Scrollbar = 16; 

type 
Coord= (xl, yl, x2, y2); 

var 
LineNum, NumSize, Numlines : integer; 
Kln : array[O .. MaxNumlines, Coord] or Integer; 
Max, StepSize : array[coord] or integer ; 
DrawW: Rect; 

procedure lnitKinetic; 
var 

c : Coord; 
LL : integer; 

begin 
GetOraw i ngRect(OrawW); 
Max[x 1] := <DrawW.right- OrawW.Ieft- ScroliBar); 
Max[y I] := (DrawW.bottom- DrawW.top - Scro iiBar); 
Max[x2] := Max(x I]; 
Max[y2] := Max[y I]; 
Numlines := Max[y I] dlv 2; 
ror c := x 1 to y2 do 
Kln[O, c] := Random mod Max[c]; 

for LL := I to Numlines do 
for c := xI to y2 do 
Kln[LL, c] := 0; 

LineNum := I ; 
NumSize := 0; 

end; 

procedure SetNextCoords; 
var 

c: Coor d; 
begin 
If NumSize <= 0 then 
begin 
ror c := x l toy2 do 

StepS ize[cJ := Random mod 13 - 6; 
NumSize := 5 * I • Random mod 12 

end; 

Figure 11.9 A complete version of Klnetlc lines 



ror c :=x l to y2 do 
begin 
KLn[LineNum, c) := KLn[LineNum - I, c)+ StepSize(c); 
If (KLn[LineNum, c) < 0) or (Kln[LtneNum, c) > Max[c)) then 
StepSize(c) := - I * StepSize[c) 

end; 
end; (SetNextCoords) 

procedure EraseOidline (l : integer); 
begin 

PenMode(notPatCopy); 
Drawl ine(Kl n[l, x I ], Kln[L, y II, Kln[l , x2], Kln[l, y2)) 

end; [EraseOidllne) 

procedure DrawNextline (l : integer); 
begin 

PenMode(patCopy); 
Drawl ine(Kln[l, xI], Kln[l, y II, Kln[l, x2), Kln[l, y2)) 

end; (DrawNextllne) 

procedure SetNextl ineNum; 
var 

c : Coord; 
begin 

LineNum := succ(LtneNum); 
NumSize := pred(LineNum); 
ir LineNum > Numlines then 
begin 
ror c :=xl toy2 do 
Kln[O, c) := Kln[Numlines, c); 

LtneNum := 1; 
end 

end; (SetNextlineNum) 

begin (Kinetlcl ines) 
lnitKinetic; 
repeat 

Eraseo 1 dl i ne< ll neNum); 
SetNextCoords; 
DrawNextl ine(L lneNum); 
Se tNextl ineNum 

unt i I UserWantsOut 
end. (Kineti clines) 

Figure 11.9 (continued) 
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The fact that I could get a very simplified version of the program to work 
helped convince me that my top-level design for the program was a 
reasonable one. Now I had to fl esh out that design in a series of stepwise 
refinements, adding only a few lines to a procedure and introducing only one 
or two new variables to each revision of the program. At each stage, I could 
test the results of my revisions w ithout waiting for a lengthy compile process to 
complete. 

If you have Macintosh Pascal, you might like to type in the version of the 
KineticLines program given in Figure 11.9. It came out of a series of revisions 
of the original design, all based on the successive refinement principle. An 
interesting characteristic of the final version of the p rogram is that it works 
correctly with Drawing windows of different sizes. 

AM acintosh Pascal user can use the title bar and size box of the displayed 
windows to reposition and resize them. The version of KineticLines in Figure 
11.9 checks to see how large the Drawing window is and uses that information 
to decide how many lines to draw and to avoid drawing lines outside the 
visible area. 

As you explore programming with Macintosh Pascal, stay alert to 
opportunities to modify portions of your old programs for new uses. Building 
on your previous work is an important part of productive programming in 
MacPascal or any other programming language. 
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THE STANDARD MACINTOSH USER INTERFACE 

All the major applications covered in this book have made consistent use of the 
standard Macintosh user interface. The standard interface makes user- entered 
data available in w indows. It provides pull-down menus for the selection of 
options in an essentially modeless environment-one in which most of the 
options are available most of the time. When an application must limit the user 
to a small set of choices, a dialog box provides those choices. In the standard 
interface, the most frequently used menu options have Command key 
equivalents. The data tha t the user edits can be cut or copied to the Clipboard 
and later pasted into the same or a different document. Finally, the Apple 
menu gives the user access to the Desktop Accessories. This interapplication 
consistency makes it very easy for an experienced Macintosh user to learn how 
to use new applications. 

The major applications exhibit even greater standardization than this. For 
example, they provide a number of similar menus 'vvith similar choices. A File 
menu provides options for opening, closing, and saving data, for printing, and 
for quitting the application. An Edit menu provides the Cut, Copy, Paste, and 
Show Clipboard functions. 

The reasons for the standardization are twofold. First, Apple used a carrot 
rather than a stick to encourage applications developers to employ a consistent 
user interface. Instead of trying to artificially impose standards, they gave 
developers the sophistica ted user interface methods in a way that cost the 
developers virtually no machine resources. Apple developed all the program 
code required to present menus and detect menu choices, to use dialog boxes, 
to make Command keys work, and to make it possible to use the Clipboard. 
The Mac's designers put almost all that code into ROM, memory that could not 
be used for anything else and that was always present. It was all there for free, 
and it didn't require that the developers devote any of their precious RAM 
space to provide such functions. ot having to write their own user interface 
rou tines not only saved time but also meant that more of the Mac's RAM could 
be devoted to prdgram code and to storing the users' data. 

The second reason for the consistent user interface is that developers 
recognized that users appreciate consistency. The more nearly standard an 
application's ways of interacting with the user, the less the user will have to 
learn anew after purchasing a new application. An experienced Mac user who 
wants to quit or to print or to close a document always pulls down the File 
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menu first to look for those options, because that's where he or she has found 
them in the past. Developers have, on the whole, been quite consistent about 
the use of menus in order to help users cash in on their expectations. 

Mac user interface standards will sometimes be violated. It is possible for 
developers to depart radically from the standard Mac modes of interaction, 
and some may find compelling reasons to do so. Rather than finding 
applica tions that completely abandon the Mac philosophy-although it 
certainly is possible to do so if a developer tr ies hard enough-you are more 
likely to find some applications that interpret it in unexpected ways. 

An example of a somewhat unorthodox approach to Mac software can be 
observed in DB \!laster, a personal data base system from Stoneware. Like 
most o ther data base systems, DB Master le ts the user de fine a format for 
storing d a ta of a particular type of data . The user can then store informa tion in 
records of that format, sort and retrieve the in formation, print it, and so on. 

O ne unusual aspect of the DB Master im plementation is tha t it makes use 
of two applications, one for defining the form of the records in a data base, the 
other for entering and manipulating information in that format. The first 
application, called Create File, is somewhat unorthodox in its menus. It 
provides four of them , none labeled " Edit." These are the menus shown above 
the line in Figure 12.1. 

The second application, called Use File, is the one tha t le ts you enter, edit, 
recall, and print information , using the forms you defined in Create File. The 
use of two separate applications makes more memory available by freeing 
RAM that one applica tion requires to use another. The structure of the Use 
application is unusual in its use of special screens and dialog boxes. 

When Use File is first opened, it presents a dialog box that asks you to 
choose the data base you want to work w ith. You are given this choice even if 
you open a particular DB Master document (data fil e) by double-clicking on 
it. In Use File there are again four menus, which are different from those of 
Create File. They are presented at the bottom of Figure 12.1. Unlike many 
other Macintosh applications, DB f'.1Iaster often takes away the background 
screen display when it brings up a new dialog box. In Figure 12.2 the display 
presented when you select Design New . .. is shown. The data display that 
was on the screen just before has been removed. 

Applications tha t use the standard Mac menu style have several benefits. 
They can help the user in the first few minutes of learning a new application, 
and, if you are an infrequent user of certa in applications, you will probably 
find it easier to return to them after an absence if they are closer to the 
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Soue... :JCS 
Redesign .. . 
Quit ... 

Cut Field agH 
Copy field age 
Poste field agu 

Uiew file Design 

Undo ag;z 

Cut agH 
Copy :ICC 

Fteld OptiOn\ 

set field Type... an 
Set field Length... agl 
Enter formula... agf 
Chonge Key... agl( 

Design New .. . 
Chonge Old ... 
Delete ... 

Print... 
I ····················································· 

Paste :JCU 
Erose ~E 

Rdd New Records ~R 

Set Field Oefoults 
. ............................................................................................... ! 

Select Rll Records 
Set Selection Crlterio 3Cf 

find NeHt Record 

Delete Record ... 

Ulew Computed Results X= 

Figure 12.1 The major menus ot DB Master 
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' • l·i l <! Edit Report fl<!< 1>r 1l Options 

Set Report Formot 

CURA£NTL Y: CHANG£: 

Print 23 Fiel ds ( Fields ) 

Prin t All Records ( Select ) 

Print in File Order ( Sort l 
90 Wide, Dote, Poge# ( Poge l 
No Title Lines ( Title l i 

Current Setting ( Printer) 

l 

~ Soue Report~ ( Concel ) 

Figure 12.2 The set report format dialog box 

standard. This doesn' t mean you should ignore any application whose user 
interface diverges in any way from the standard. You should examine the 
application for yourself; you may find you like its style even better. I have to 
admit that DB Master was surprisingly easy to learn to use, despite its unusual 
structure. 

MORE PROGRAMMING LANGUAGES 

When this book was written, MacPascal was by far the best-structured 
programming language available for the Macintosh. It is, however, far from 
the only Macintosh language. Two BASICs, a version of Forth, two imple
mentations of FORTRAN, at least one Logo, a LISP, an assembler, two 
implementations of the Modula-2 language, and at least three versions of C 
should be available for this time. The focus of this book is using applications 
productively, not programming, but many useful programming language 
options are also available for the Macintosh. 
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Microsoft BASIC 

The first release of this BASIC implementa tion is not very impressive. It 
provides three windows, one with your program listing-the text of your 
program-one for the output of the program, and one for entering new lines 
into the program ( Figure 12.3 ). The program listing windovv cannot be used 
for editing, an awkwardness that seems to have no inherent justification. The 
speed with which Microsoft BASIC programs are executed on this system is 
not very satisfactory. Many 8-bit microcomputer BASICs do as well or better. 
Perhaps Microsoft will improve its BASIC in the future. 

Despite its faults, Microsoft BASIC is being productively used by many 
Mac owners. A movie producer uses Microsoft BASIC for the Mac to compute 
moments of force for constructing camera scaffolds and cranes. Complete 
communications systems, such as MacTEP, have been created in this 
programming language. Because it was the first language available for 
programming on the Mac, mos t users' groups have more extensive libraries of 
programs in Microsoft BASIC than in any other language. 

• * File Edit Control 

Vtew of Bn dge from ( 
Watt 
Br eak m )2 go 
LI ST 

REM ••• M S-BASIC Progr am " 
REM •** Draws a bndge from 

I 10 DEFSNG A ·Z 
120 DIM XP%(220). YP%(22 0 ). T( 4,4), 
1.30 P1=.3 14 I592 o5' 
140 XCENT =PI /2 YCENT =O· ZCENT =- 1 
150 CLS 
l oO XVIEW =RND•o0 -.30 YV IEW=RND• 
170 PRINT " Watt .. 
180 GOSUB )000 'l m t 3D 
190 1P=0 
00 RESTORE 

Figure 12.3 Microsoft BASIC 
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MacForth 

MacForth is an implementation of the programming language Forth fo r the 
Macintosh. Many uncomplimentary things have b een said about Forth by 
people who are not Forth programmers. Forth is supposed to be very difficult 
to read (it has been called a "v•.'rite-only" language). This makes it difficult to 
maintain large programs written in Forth. On the other hand, Forth code 
typically runs much more quickly than the equivalent p rograms written in 
BASIC. 

F orth achieved great popularity a number of years ago when memory 
limits for small systems \vere much lower than now and programmers were 
looking for methods that required very little RAM. Serious Forth program
mers seem to profess the language like a religion and to produce numerous 
puns about setting forth , starting forth, and so on. 

Macintosh BASIC from Apple 

Fortran 

Macintosh BASIC from Apple looks like a winner. Whether it is really a 
conventional microcomputer BASIC is another question. Like Pascal, it 
encourages structured programming practices . If this is so, it may be a terrific 
marketing coup on Apple's part. Although Pascal is a much better pro
gramming language than BASIC (especially for large projects), its pre
Macintosh implemen ta tions have terrified novice p rogrammers, in part due to 
a number of good reasons discussed in Chapter 11. If Apple has created a 
friendly Pascal disguised as a BASIC implementation in order to reassure 
novices, they may have performed a fundamental service to the future of 
personal computer programming. 

FORTRAN was the first higher level programming language, and it shows its 
primitive origins in its design. Still, many engineers are much more familiar 
and comfortable with FORTRAJ\' than with ·other programming languages, 
and it is to be hoped that they w ill be pleased with one or more of the 
implementations of this language on the Mac. 
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LISP 

Logo 

Pascal 

LISP is a very odd language, one in which a great many parentheses are used, 
as in this statement: 

(CDR (CDR (CDR (CDR X)))) 

When this statement is executed, LISP responds with the list " X", minus its first 
four elements. It is an old language; older than any of the others listed here 
except FORTRAN , but it is still in high favor in academic computing circles, 
which is much more than can be said for the next most ancient language on this 
list, BASIC. LISP is the most w idely used computer language in the fi eld of 
Artificial Intelligence, the study of methods for producing apparent intel
ligence in machines. 

Logo is sometimes thought of as a graphics programming language for 
children, but it is really much more than that. Logo is more closely related to 
LISP than to any other programming language, and it is possible to create 
quite sophisticated programs in the language. Many educators believe that 
Logo is a much better first programming language than BASIC. 

The MacAdvantage from SofTech Microsystems is a Pascal-based develop
ment system for the Macintosh. 

Modula-2 

c 

The inventor of the Pascal programming language introduced Modula-2 as the 
successor to Pascal. It has many of the virtues of Pascal and corrects some of 
Pascal's faults. Whether it is a good language on the Macintosh will depend on 
the quality of the implementations, which are not ye t available at this writing. 

C is a less structured language than Pascal or Modula-2, but it makes it easier 
for the programmer to make use of machine-level details than do those 
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programming languages. C is a ttaining increasing popularity at many 
universities that have minicomputers from DEC (Digital Equipment Corpo
ration ) equipped with the UNIX opera ting system. Most of UNIX is written in 
the C language, and C is usually the best- sup ported language on a machine 
tha t uses UNIX. As a result, many computer science graduates have become 
fervent proponents of C. 

UPGRADING YOUR MAC 

There are many kinds of peripheral devices tha t will help to make your 
Macintosh much more useful, but the most obvious Macintosh upgrade is the 
conversion of a 128K-byte Mac to a 512K-byte machine. While there are a 
number of substantial advantages to making the upgrade, many users will 
decide that they can get along very well on the originall28K- byte system. 

A Fat Mac Upgrade 

The conversion is accomplished by replacing the entire main logic b oard of 
the Mac. T he most obvious difference be tween the 128K and 512K systems is 
that they use different RA:\1 chips to supply the Mac's memory. The 128K Mac 
uses 64K- bit RAM devices. These integrated circuits each provide a little more 
than 65,000 bits, enough storage for 8,192 characters. Since there are si.xteen 
RA:\1 chips in a Mac, the 64K-bit devices provide a total of 128K bytes. In a 
512K Yfac-affectionately dubbed the " Fat Mac," although it weighs no more 
than the original version-the RAM chips are all 256K-bit chips, each 
providing enough memory for more than 32,000 characters. Sixteen of these 
integrated circuits p rovide 512K bytes, storage for 524,288 characters. 

Why a 512K Mac? 

Moving up to a 512K Mac is essential only for those Macintosh users who 
want to use larger programs that require more memory. One such program is 
ThinkTank512. This program lives up to the "idea processor" label to a much 
greater extent than does ThinkTankl28 (described in Chapter 6) . Think
T ank512 permits the development of much larger outlines. More importantly, 
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however, the lowest nodes in an outline can be small bodies of text, or even 
pictures. T hinkTank512 is not only a tool for developing ideas but also for 
presenting them, through the use of a "slide show" option built in to the 
application. I ust as you might use a slide projec tor to p resent a set of slides 
during an oral presenta tion, you can use the Mac to present a series of text or 
graphic displays on the Macintosh screen, advancing from one to another at 
the click of a mouse b utton. It is even possible to present animated sequences 
of graphics in ThinkTank512. This applica tion is a good example of how the 
Mac's power can be even more fully exploited in a Fat Mac application. 

Another reason for purchasing a Macintosh-512K or an upgrade to 512K 
bytes is that it enables you to ru n major applications like Lotus I azz. I azz is one 
of the highly integra ted applications available for the Mac. Lotus and Ashton
Tate are two companies that have a good deal of expertise in producing 
comprehensive applica tions that include many of the capabilities provided by 
separate applica tions of the type d escribed in this book. A single such 
integrated applica tion may include w ord processing capabilities, spreadsheet 
fea tures, data filing, charting, and communications functions. 

Integrated application packages, such as Lotus Symphony and Ashton
Tate's Framework, have been very popular for computers with conventional 
user interfaces, such as the IBM PC. These applications provide even more 
ap plication functions in a single package than does Lotus 1-2-3, the very 
successful product for the IBM PC that played an important role in 
establishing the integra ted software concept . The Mac achieves a high degree 
of integration across different applications, thanks to the consistency of the 
user interface and to the transferability of data among applications through 
the Clipboard. Will the additional advantages provided by a single integrated 
ap plication lure Mac owners into using such systems in preference to separate 
applications? 

Jazz, previewed as this b ook was nearing completion, offers a number of 
worthwhile fea tures. For users who must frequently move back and forth 
among spreadsheets, word processing documents, structured data files, 
charts, and com munications w ith other computers, Lotus I azz offers great 
increases in speed and convenience, compared to the use of separate 
applications. The speed enhancements are due to two factors. One is that more 
than one of the J azz functions can be resident at once on the Mac. For example, 
you can have both a spreadsheet and a repor t that refers to the spreadsheet 
open at the same time. Going back and forth between them can be as quick as a 
mouse click. The second speed factor is due to the execution speed of the 
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separate function modules themselves. Each was hand-crafted in assembly 
code for speed and economy. 

Speed is not the only reason and perhaps not even the major one for using 
J azz. Perhaps its greatest strength is a capability called HOT VIEWS. Jazz 
supports conventional cutting, copying, and pasting from the C li pboard. Hot 
Views is a new fea ture that allows you to link a portion of one document to 
another. F or exa mple, you can first create a bar graph that represents a portion 
of a spread sheet, and then p ut a Hot View copy of the graph in a wor d 
processing report. Once this is done, you can make changes to the spreadsheet, 
and they w ill automatically b e reflected, not only in the chart, b ut also in the 
text report. In fact, Hot Views are upd ated instantly even in closed documents. 

One of the nice aspects of using H ot Views is that it results in a much more 
natural-looking display on the screen. For example, you can get mail merge 
fu nctions (such as those described for Microsoft Word in Chapter 10 ) by 
having a H ot View in a le tter from a data base. In the conventional approach to 
mail merging one uses unnatural- looking commands, such as "<<DATA 
b ranch managers>> <<name>> <<ad dress>>" in a word processing d oc
ument to describe wha t data fields are to be used . In J azz, the H ot View 
automatically pastes actual text from the data base source into the letter. 

Macintosh users who need all or several of the five J azz fu nctions- word 
processing, spreadshee t, d atabase, graphics, and communica tions-w ill ap
p reciate having one consistent user interface for all five functions. I n addition, 
the spreadsheet is particularly large ( 8192 rows b y 256 columns) , fas t, and 
well-designed . .Ytany business users of the .Macintosh will find that they can 
often keep Jazz load ed all day on their machines , going back and forth quickly 
among tasks that req uire its different func tions, without ever having to take 
the time to quit an application. 

If the components of the integrated application are not truly competitive 
w ith their stand- alone counterparts from other software companies, the 
integrated applications packages may make a much smaller impact in the 
Macintosh world than they have in the IB.\1 PC world. Mac users are in a 
position to demand very high quali ty in each applica tions area, since they 
already ha ve a high degree of integration thanks to the .\tfacintosh user 
interface. 

While a 512K Mac is not essential if you don't need the ap plications that 
d emand its capabilities, it does have a nu mber of advantages in working with 
conventional ap plications. Most substantial ap p lications, such as those d is
cussed in this book, make extensive use of memory overlays or code segm ents. 
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This means that when an application is programmed it is divided up into 
different pieces tha t can function somewhat independently. Not all the pieces 
of a program are loaded from disk into the Mac's RAM a t one time, in order to 
leave memory fr ee for user data. When a new code segment is brought into the 
memory of a 128K Mac, there usually isn' t enough room to keep the earlier 
cod e segment, so it is purged. When its func tions are called for again, it must 
be read from the disk again, a process that results in a delay before the 
application can go on. O n a 512K Mac, code segments are much less likely to 
be purged, so large applica tions will run significantly faster, particularly after 
each code segment has been used at least once, and therefore loaded from disk 
into RAM. 

You must be the judge of the value of the 512K Mac for your own work. 
Try the applications you actually p lan to use on a Fat Mac at your dealer's to 
d etermine whether the price differential is worthwhile for you. In the long run, 
when RAM prices have declined, probably most active Mac users will 
upgrade their machines. Doing so is likely to be less expensive later on, ·when 
Apple can purchase 256K-bit chips less expensively. 

Whatever you d o, d on't try to upgrade yo ur 128K Mac to 512K b y 
yourself. It is more than a matter of desoldering the 64 K- bit chips and 
soldering in 256K- bit chips in their place. For one thing, that is likely to result in 
the d estruction of one or more traces on the board itself, thereby ruining the 
board. Worse, several custom-integrated circuits manufactured by Apple 
must also be replaced, in addition to the RAM chips. T he Mac upgrade is one 
place where do-it- yourself just doesn't pay off. 

A Hard Disk Upgrade 

Most other upgrades to your Mac have to take place outside the box and can 
therefore be thought of as peripherals rather than as upgrades. One very 
special kind of peri pheral addition, however, is a hard disk drive. Working 
with a hard disk can result in such substantial improvements in performance 
that adding one must count as the most significant upgrade poss ible after the 
Fat Mac upgrade. 

The most obvious consequence of choosing a hard disk is the ability to 
store more. Figure 12.4 shows the disk window for a MacDrive disk from 
Tecmar. Tecmar makes a number of hard disk drive models for the Mac. 
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Figure 12.4 An open hard disk 

Some have fi xed hard disks of5 or 10 megabytes (5 or 10 million characters). 
Others have removable 5-megabyte cartridge disks. Such a cartridge is just 
over 4 inches square and less than)~ inch thick. Keep a few tens of these around 
and you can have easy access to hundreds of megabytes of storage. 

The directory window in Figure 12.4 is for a 5-megabyte removable disk 
system. Almost 3 megabytes of storage is in use, most of it documents 
tucked away in labeled folders. This disk has hundreds of documents from 
many applications. A hard disk helps you fully realize the integration 
capabilities of the Mac, because you can easily move from application to 
application, preserving the contents of your C lipboard without having to keep 
reinserting the previous system disk. Copying and pasting between docu
ments, especially between documents from different applications, is much 
easier using a hard disk than with floppy drives alone. 

At least as important an advantage as capacity is disk access speed. 
Despite the many advantages of the Apple floppy system, it has one glaringly 
obvious defect. It is slow. The problem is that the flopp y has to keep changing 
its speed of rotation before it accesses information from different portions of 
the disk, and that takes time. The hard disk doesn't have that problem, and it 
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rotates much more quickly and has much faster head movement than does a 
flopp y drive. It can access information much more quickly. 

Macintosh hard disks can't transmit the information to the rvtac q uite as 
quickly as the floppy drives can, but accessing the information is usually the 
more important de terminant of disk effectiveness. Working with disk- based 
applications such as Microsoft Word or T elos Filevision b ecomes even more 
of a pleasure when new data is brought in so q uickly from a hard d isk. 
Unfortunately, there are some problems in using a hard disk that stores many 
documents. Opening new files and leaving ap plications take a very long time 
when there are many files on the disk. Apple may release a new version of the 
FJ DEn that reduces the severity of this problem. 

Corvus d eveloped software that seems to solve, a t least partially, the 
speed problems that pop up when disks have man y fil es. A Corvus Omnidrive 
disk is separated into a number of volu mes, each of \.vhich is treated as a 
separa te disk by the Mac's applica tions. With an Omnidrive, you can keep 
many documents, distributed among several volumes on the hard disk. 

When you work with a Tecmar hard disk, you must be carefu l to use the 
Finder's E ject option when you have finished working with the disk before 
you turn it off. You have to choose the Eject option even if the hard disk is a 
fixed, non - removable type. It may seem strange to try to eject a disk tha t is 
fixed, but the Directory- tha t part of the disk tha t tells w here all the fi les are 
located, how long they are, and so on-gets updated by the Finder when yo u 
eject the disk. If you forget to do this, your new documents will effectively 
disappear from the disk w hen you turn it off. If your hard disk has a lot on it 
and you are using a 128K-byte Mac, you may get a message telling you tha t 
there isn't enough mem ory to eject your hard disk. Don't worry abou t this. You 
can just click the OK button and turn off the drive and the .\he a t this point. 
T he directory has a lread y b een updated. 

The Tecmar and Corvus hard d isk drives provide additional speed for 
using the Mac in several ways . They load applications and documents more 
quickly than do floppy drives, of course. They also make it faste r to use 
complex applications. Portions of a complex applica tion in separa te code 
segments are swapped into HAM from disk much more quickly with a hard 
disk. In this respect, a hard drive gives yo u some of the advantages of a Fat 
Mac. 

However, having a full y utilized hard d isk drive can im pose serious speed 
penalties as well as provide advantages. O nce your drive has more than 150 or 
so files on it, you w ill notice tha t it takes longer to quit an applica tion on the 
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hard drive than on a flop py drive. Choosing the Open option when there are a 
large number of fil es to choose from is also a time-consuming process . If you 
are a real speed freak, you may find that you p re fer to restrict the number of 
fi les on your hard d isk. 

The Corvus Omnidrive system partially overcomes this problem by 
splitting a hard disk into a number of separate volumes that act like separate 
disks, each w ith a modest number of documents and applications. A 
Macintosh application provided by Corvus called Volume Manager lets you 
partition the disk into volumes. Another application, Mount Manager, is used 
to MOUNT a volume, making it accessible to your Mac. A mounted volume is 
visible as a disk icon on the desktop. By not placing too many files on any single 
volume, you can enjoy the capacity advantages of a hard disk without giving 
up its speed advantages. 

MACINTOSH ACCESSORIES AND PARAPHERNALIA 

The most important accessories for using your Macintosh productively are the 
right applica tions. This book has described some of the most important 
Macintosh applications programs. As developers and users become more 
familiar with the Mac's capabili ties, even more powerful and origina l 
applications will appear. Be on the lookout for new ways to use your i'vlac to 
get things done. 

Magazines 

Early product announcements and reviews can be found in lnfow orld. 
Reviews in Byte magazine are likely to appear much later but are usually 
thorough. In-dep th coverage of ivfacintosh p roduc ts and techniques is 
provided by MacWorld. Additional Mac coverage can be found in a special 
Mac section of the magazine APlus. Since the Mac was undoubtedly w orth 
what you paid for it, you might as well spend a few dollars more and subscribe 
to major l'vlacintosh magazines. 
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Newsletters 

There are a number of Macintosh clubs and newsletters that can serve as 
sources of informa tion abou t the Macintosh, its applications, and its periph
erals. H ere are several: 

Club Mac 
735 Walnut Street 
Boulder, CO 80302 

I CONCEPTS 
916 Bradley Drive 
Athens, TX 75751 

Semaphore Signal 
207 Granada Drive 
Aptos, CA 95003 

ICON 
The Association of Apple 32 Users 
P.O. Box 634 
Santa Clara, CA 95052 

$35/ yr 

$18/ yr 

Free to Mac/ Lisa 
owners or $1 0/yr 

$20/ yr, plus 
1-time $20 

You are also likely to find a local computer club for Macintosh owners or a Mac 
special-interest group in an Apple computer club. For an opinionated and 
unusual perspective on many matters related to the 68000 processor, including 
occasional gibes at the Macintosh, you might enjoy 

Hard disks 

DTACK GROUNDED 
1415 East McFadden Street, Suite F 
Santa Ana, CA 92705 

$15/ yr 

A hard disk drive, I have suggested, is more than an item of peripheral 
equipment in an ordinary sense. It is a significant upgrade to your Macintosh 
system, one that offers addictive speed and capacity. A hard disk makes it 
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much easier to use your Mac as an integrated environm ent in which you pass 
data among applica tions. 

A second floppy drive 

Printers 

A more mod est mass storage add-on for the Macintosh is a second floppy disk 
drive. H aving a second flop py drive offers a number of advantages that 
expand yo ur e ffec tive use of the Mac. Obviously, more storage space is 
available to your applica tions programs. If you are using an application that 
can create d ocuments the size of which d epend on the amount of disk space 
available, you will be able to create much larger Mac documents if you have a 
second drive, since the disk in that drive need not have system or ap plication 
files. Examples of such disk-size dependent applications include Microsoft 
Word and some data base applications. (Other data base applications, such as 
DB Master, can make use of documents that are distributed across several 
disks. ) 

There are other advantages to having a second flopp y drive. One is that 
you can use a sys tem disk that has a very large system folder. You can have a 
large Scrapbook, a full Note Pad, and a large number of fonts installed. Even 
though most of your system disks will be occupied by such support files, you 
can still make use of application functions that require a good d eal of disk 
space b y using disks with only applications and documents-but no system 
files-in the second drive. This makes it possible to have a full system disk but 
still print sizable d ocuments from MacWrite, an application that temporarily 
needs lots of disk space for a print document. 

Probably one of the most important reasons for investing in a second 
floppy drive, however, is that it will encourage you to back up your 
documents more often. If you make regular backups, some day something will 
happen that w ill make you glad you do (see chapter 3). 

Printers are another major kind of peripheral equipment. The three major 
types of printers for the Mac are high-resolution dot matrix printers (like the 
Imagewriter) , laser printers, and fully-formed-character printers. Laser 
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printers can b e used both for graphics and to produce letter-quality text, so 
they can take the place of both the dot matrix and the fully- formed-charac ter 
printers. Because of the expense of laser printers, some lvlacintosh-equipped 
offi ces may choose to get by w ith a combination of the two less -expensive 
types of printers. 

Graphics Peripherals 

Voice 

Graphics peripherals offer special features for users of graphics composition 
applications. Graphics in put d evices include digitizing tablets and video 
digitizers, discussed in Chapter 10. Peripheral graphics output devices include 
pen plotters and screen p rojection systems. A PEl\ PLOTTER draws lines on 
paper w ith colored pens under the control of computer software. A SCH EEl\ 

PROJECTION SYSTEM, such as the ones from Professional D ata Systems (220 
Redwood Highway, Suite 120, Mill Valley, CA 94941 ), can be used to display a 
giant Mac screen for presentations to large groups. 

Voice input and output devices are two more typ es of peripherals that can be 
added to the Mac. Voice output d evices usually sound a little odd, but w ith 
half an hour's experience, most people find that they are quite easy to 
understand . 0 f course, the Mac has built- in sound produc tion capabilities that 
can match most inexpensive add- on speech synthesizers fo r comprehen
sibility. SmoothTalker from First Byte, Inc. provides this capability. 

Vo ice in put systems do not yet recognize human speech accura tely 
enough for many practical purposes. C laims of 95 percent and 98 percent 
accuracy should b e examined very skeptica lly. Find out whether the 
conditions under which these accuracy rates were obtained are at all similar to 
the conditions under which you would like to use the system. Be aware that 
even li mited accuracy usually requires using very small sets of words to be 
recognized. If possible, try the sys tem using the vocabulary you plan to use. 
Finally, ask yourself whether you are willing to put up with an in put device 
that misunderstands your input a t least 2 percent of the time. Would you use a 
keyboard that got one out of every fift y keys trokes wrong? 
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Modems are another major peripheral category. If you can afford it, a modem 
with higher speed capabilities is preferable. When your time is of va lue, it 
doesn't make sense to idle at the keyboard, waiting patiently for the screen to 
fill vvith input from a re mote computer. On the other hand, having a 1,200/ 300 
baud modem doesn't necessarily mean tha t you should always use the higher 
speed. If your usage of a remote time-sharing computer involves long periods 
of thought while you examine information on the screen and consider what to 
do next, yo u should check out the struc ture of the time-sharing system's rates. 
Some such computer systems charge four times as much for connect time on 
the higher speed lines, or more. If you are not transmitting in either direction 
for a good part of the ti me that you are hooked up to a system, there is no po int 
in paying a premium for that "dead time." 

Media and Supplies 

"Media and supplies" is a fancy name for disks, ribbons, and paper. Floppy 
disk manufacturers, observing the success of the Mac, have jumped on the3.5 -
inch disk bandwagon. At the time I wrote this, Mac-size micro-floppies were 
available from Apple itself, BASF, H ewlett-Packard, Maxell, Sony, and 
Verbatim. \fany more sources have undoubtedly appeared on the scene by 
now. 

Continuous-form printer paper is available from many sources. Since 
your Mac is an ideal system for constructing presentation-quality printed 
documents, you may want to buy boxes of20-lb. paper with micro-perforated 
edges (sometimes called " laser cut"). At first and even second glance, sheets of 
such paper, once separa ted , are not distinguishable from ordinary 20-lb. 
bond. It gives your printed documents a more professional look than the 
some\.vha t less expensive papers. 

Disks and paper are one area in which prices greatly vary, to all 
appearances without regard for quality. If you use the Mac a lot, you will 
prob ably wind up buying a great number of blank disks and a good deal of 
paper in the long run. When you encounter a good buy, consider purchasing in 
large quantities . 
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Mac Support Stuff 

Skim through one of the major Macintosh magazines and you will find 
advertisements for carrying cases, printer stands, mouse pedestals, furniture, 
and all manner of other objects customized to support your use of the Mac. 
One of the most useful such items is one or more high-capacity disk cases. 
They provide dividers that le t you separate your Mac disks into lab eled logical 
groups . Vendors include Evco (100 West North Street, Box 70, Deforest, WI 
53532). 

A catalog of Mac support materials and just plain fun stuff-clothes, 
coffee cups, je,:velry, and office accessories-for fans of Ap ple Computer is 
available from T he Apple Collec tion (P.O. Box 306, Half Moon Bay, CA 
94019}. 

FUTURE MACINTOSHES 

Apple does a good job of keeping its Macintosh secrets, but a survey of recent 
technology trends suggests some interesting possible futures for the Mac. 
Some of these advances are unlikely to occur before 1986, and some will come 
much later, if at all . It is nice to know, however, tha t the Mac's design is one 
that should adapt well to a number of expected advances in technology. With a 
bit of luck, your next computer will be one that fits snugly into the Apple 32 
family, giving you an upgrade path that le ts you take your hard -earned Mac 
docu ments along with you. 

The first type of advances to expec t in Macintosh technology should be 
more of the same. T hat is, the next generation of Macs may have even more 
memory and access to higher- capacity, faster d isk drives. A rviac with a 
megabyte of RAM and a 50-megabyte disk drive is a very achievable d esign 
goal. 

Watch for progress in the size of future Macs, as well . The biggest 
consumer of space in your Mac's case is the display tube. If it could b e 
replaced by a flat panel display, similar to the optional liquid crystal display 
available for the Apple I I c, then the Mac could be much smaller. In addition to 
eliminating the relatively large and heavy monitor, many of the functions of 



Future Macintoshes 275 

the analog circuits card vvould be replaced b y the liquid crystal component of 
such a "Fla t \lac." \\'hen I'm hurrying through airports w ith m y Mac case 
slun g over my shoulder and my attache case in the o ther hand, I fantasize 
about the clay when I can leave the old Mac on my desk and just slip a Flat Mac 
into the briefcase when I leave on a trip. 

!\I any users of color computers have asked w hen a color Mac will come to 
be. Color is likely to be available through an external monitor sometime soon. 
More memory is required to support co lor, so the color Macs will probably 
also b e Fat Macs. It may be a long time b efore color display technology 
catches up to \t!acintosh standards for the in- the-box monitor, however. The 
!\lac was mad e to be a machine tha t you can sit and stare a t all day long. Its 
crisp, rock-steady display d oesn' t tire your eyes the way any current 
technology color d isplay does. When color monitors can d eliver the kind of 
per formance the Mac demands, Apple will be ready to produce Macs with 
that capability. The low- level Q uickdraw graphics primitives are a lread y 
prepared to hand le color. An external color monitor wou ld make it possible to 
use color w hen necessary, w ithout relying on it as your primary display device. 
A color-onl y \tfac is still going to take som e time. 

Another trend to look for som e years from now is "supercharged Macs." 
Motorola has just begun producing the 68020 chip, a processor with even more 
power than the 68000 but one that is software-compatible with it. Further
more, it consumes even less e lectrical power, making it a strong contender for 
the brains of a b attery- p owered Flat Mac. 

Enjoy yo ur l'vlac with confidence. You are riding the wave of a powerful 
new technology that hasn' t even b egun to crest. 
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INTRODUCING THE FIVE MOUSE SKILLS 

Pointing 

T o make effective use of your Macintosh, you must learn how to use the 
mouse, since m ouse actions are used to do almos t everything but enter text. 
The physical skills involved are very simple. T here are only five: pointing, 
clicking, double -clicking, shi ft-clicking, a nd dragging. T he effects of a ll 
five of these actions depend on the location of the mouse pointer. 

Usually the mouse pointer looks like a slanted arrow on the screen, like 
this: 

b ut it often takes on other sha pes as well. The sha pe of the mouse pointer tells 
you what kinds of things you can d o with objects you are pointing to. \i\' hen the 
p ointer is the slanted arrow, the mouse is usually pointing in an area in which 
there are icons yo u can select. 

The mouse pointer takes on d ifferent shapes in other environments. For 
example, when the mouse is pointing at text that can b e edited, the shape of the 
pointer is an !-beam. 

I 
When the p ointer is an I -b eam, you can click the mouse bu tton to select a new 
point for text insertion or b ackspacing. 

O ther pointer shapes are used by particular applications. The MacPaint 
ap plication, for example, has a large set of different mouse pointers tha t are 
used when the mouse takes on different func tions. Thus, when you are using 
the mouse to select an object of interest, the mouse p ointer is a small lasso-

p 
When you use the mouse to click d ots on or off in Y1 acPaint, the mouse pointer 
is a p ic ture of a pencil-

and so on. 

What could b e simpler? T o point with the mouse, simply move the mouse on 
your desktop until the pointer rests on the object you want to p oint to. The 
symbols used for mouse pointers-the slanted arrow, the 1- beam, the lasso, 
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Clicking 

and so on-each have a single dot that specifies where the symbol is really 
pointing. T his dot is the pointer's HOT SPOT. F igure A.l shows the hot spots of 
some common pointers. 

To click the mouse, you simply depress and release the mouse button. The 
only aspect of clicking that may require some practice is learning not to move 
the mouse as you click. Beginning yfac users sometimes accidentally move the 
mouse while releasing the button. This can result in a wrong selection-a 
choice just above or b elow the one you actuall y wanted . If this happens to you, 
just make the selection over b y repositioning the mouse pointer and clicking 
again. 

I 

Hot Spots for Five Pointer Shapes 
Figure A.1 Hot spots for five pointer shapes 
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Double-Clicking 

A double-click is just what it sounds like. T o double-click, you simply click 
twice in rapid succession, without moving the mouse between clicks. The 
:\ifacintosh can be set to require any one of three different minimum intervals 
between clicks in order for the two clicks to be counted as a double -click. This 
option is available from the Control Panel accessory in the Apple pull-down 
menu-the leftmost object at the top of your screen. As you gain some 
expertise with your Mac, you may want to use the control panel to set the 
double-click interval to the shortest value (Figure A.2) . This will make it easier 
for you to click something and then click it again without having the system 
erroneously interpret the two clicks as a double-click. 

Shift-Clicking 

Dragging 

Shift-clicking is used to select more than one object at a time. For example, 
you can point to an icon and click the mouse button to select it, then point to a 
different icon and shift-click to select that one too. You don't have to have the 
Shift key down when you select the first item, only when you want to add to 
your selection. 

To shift- click, point the mouse and click while holding either shift key 
down. You have to push the shift key down before you press the mouse button 
in order for the Mac to see the action as a shift-click. Aside from the fact that it 
is a two-handed operation, shift-clicking is not more difficult than ordinary 
clicking. 

Dragging is used to move objects on the screen. You point to the object, 
depress the mouse button, and then slide the mouse to a new location, without 
releasing the mouse button. When the mouse pointer (or the object) gets to 
where you want it, release the button. 

These five simple mouse skills are used in many different ways . Turn on 
your Macintosh now, and let's explore some of them. 
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Control Panel 

3/03/84 

Figure A.2 The control panel, with short double-click seHing 

SELECTING AND UNSELECTING 

If you've used the Macintosh at all, you've probably often selected items by 
pointing and clicking the mouse. Turn on your Macintosh now and insert a 
system disk, such as the Write/Paint d isk. C lear the desktop by clicking in the 
Close Box of any open window. This is the small empty square at the left end 
of a w indow's title bar. Note the position of the pointer in Figure A.3. After 
you've closed the disk w indow, only the disk icon-usually in the upper right 
corner of your screen-and the trash icon remain, along with the menu bar at 
the top of the screen. See Figure A.4. 

SELECTING an object te lls your yfac that you want to do some work with 
tha t object. You can select disks, applica tions, and documents, as well as many 
special objects available through various applications. On this bare desktop, 
the Write/Paint disk is the currently selected item. Its dark appearance m eans 
that it is the selected icon. 

Because it is currently selected, you can perform certain actions on 
Write/ Paint. To see what those actions are, select the File menu from the menu 
bar. Move the mouse until its pointer rests on the word "File" in the menu bar. 
This is the title of the File menu. T o select the File menu, press down on the 
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Figure A.3 Clicking the Close Box of the Write/ Paint window 

~ e5 File Edit Uiew 5petiot 

Figure A.4 The bare desktop 
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mouse button. As long as you hold clown the button, the Fil e menu is displayed 
(Figure A.5). Note that the File menu choices appear in two different 
intensities . Currently available choices appear in solid black letters, while 
unavailable options are words in gray. These dimmed commands are ones that 
cannot apply to the currently selected item. ln this pichtre, only the Open, Get 
Info, and Eject commands can apply to the currently selected d isk. 

Release the mouse button while it isn't pointing to any command in the 
menu , and the File menu disappears. Now L' i\SELECT the currently selected 
disk by pointing anywhere on the desktop where there is no object-no icon or 
menu item-and click the mouse. You've just selected nothing, and thereby 
unselecled the disk. A glance at the screen shows that the disk is not currently 
selected (Figure A.6 ). It now appears as a white icon against the gray 
background of the desktop, rather than as a black disk icon. (O n your display 
the slanted arrow pointer will be in a d ifferent position that reflects the 
position of the mouse on your desktop. ) 

Figure A.S The File menu choices available when a disk Is currently selected 
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r • File Edit Uiew Sp etial 

Figure A.6 The desktop with nothing currently selected 

Pull d own the File menu again and observe that all the commands are 
dimmed . This shows that none of the File commands can currently apply, 
since nothing has been selected for them to apply to (Figure A.7) . Release the 
File menu. 

Some day you may try to apply a command and find that nothing 
hap pens. C heck whether the item you want the command to ap ply to has 
actually been selected. 

CHOOSING FROM MENUS 

The concept of choosing from a menu is something like the concept of 
choosing an objec t. In both cases, you use the mouse to point to a selec tion, but 
in the case of a menu ite m yo ur choice is a command. The physical action of 
choosing from a menu w ith the mouse is very similar to dragging. 
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Figure A.7 The File menu choices when nothing is selected 

A PULL-DOW:--/ ~.-IE!'\U is a list o f choices that is ordinaril y hidden except for 
the title of the menu. The top line of your Macintosh d isplay has a number of 
pull-clown menu titles. The le ftmost one is a picture of a small app le \vith a bite 
out of it. Pu ll clown the Apple menu by pointing to the apple icon and holdin g 
clown the mo use button. Again, d on' t just click it and le t it go. Hold it clown. 
The menu tha t appears lists the set of standard applications ca lled the Desk 
Accessori es (figure A.8) . 

Still holding dow n the button, drag the mouse clown slowly . Notice tha t 
each menu item "l ights up"--appears in inverse video-as yo u point to it. 
:VI ove th e mouse cursor to th e Alarm C lock option and fina lly release the 
button. Two things happen now. First the Apple me nu disappears. Like a 
w indow shade that won't stay down if you stop holding it, it pulls back up 
under its title, the little apple icon. Second, a small window appears o n you r 
screen with the c urrent tim e (Figure /\ .9). 

You have used the manse to choose the Alarm C lock fro m th e Apple 
menu. The apple icon is a lways the le ftmost menu title in the menu bar. Each 
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Figure A.8 The Apple pull-down menu 

Figure A.9 The Macintosh c lock window 
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word or symbol in the menu bar is the title of a pull-down menu. All the pull 
down menus are used the same way. You have to drag the mouse pointer down 
to the selection you ·want to make from the menu. 

DRAGGING 

Place the mouse p ointer on the trash can icon, hold down the button, and slide 
the mouse to the left a bit. A dotted -line rectangle about the size of the icon 
moves along with the mouse pointer. Now release the button, and the trash can 
will snap from its old location to the new one marked off b y the rectangle. Y au 
dragged the icon to a new position. 

N ow point to the clock window you just opened . Put the point of the 
mouse arrow inside the clock window . D epress the button and, holding it 
d own, drag the clock to a new position on the screen. If you now put it to the 
right of the trash, your screen looks something like Figure A.lO. N ov,r point to 
the close box fo r the Alarm Clock window and click it to put it away. 

The dragging skill has many uses in addition to choosing commands from 
pull -down menus and moving windows and icons around on the desktop . 
Dragging can be used to pull a copy of a document from one disk to another, 
for example. In some applications, dragging techniques are even used to 
change the shape and size of objects. 

WINDOWS 

WINDOWS are so named because they provide you with a view of your fil e 
much like the view that you would get by looking through the window of a 
house into the interior. If the window is too small to display everything inside, 
the user can increase its size by dragging the size box in the lower right corner . 
If there is still too much to display in the larger box, you can use a scroll bar to 
display the hidden information. A Sc ROLL B AR le ts you slide the information 
around under the window. Think how convenient it would be to be able to 
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It f 11e !. ull 111ew ) JH•c I ill 

Figure A.10 Repositioned clock window 

slide a window around the surface of the house to see everything inside. 
Macintosh windows work something like this. Instead of moving the windows 
around, however, you use scroll bars to move information behind the window. 

Scroll bars can be found at the right of a w indow, or at the bottom, or 
sometimes in both locations. A scroll bar at the right is used to move the 
information up and down behind the window. A scroll bar at the bottom has 
the function of moving the informa tion to the left and right. See Figure A.ll . 

There are three different ways to use a scroll bar to change what is 
displayed in a window. C licking an arrow will scroll the disp lay one line in the 
direction of the arrow. Clicking in the gray area of the scroll bar will replace 
the current windowful of information with the next one- or the previous one. 
The direction of the scroll depends on which side of the scroll box you click. 
The ScROLL Box is the white box in the scroll bar. It marks the relative location 
of the present ·windowful in the information source. Finally, you can scroll to a 
particular point in the informa tion by dragging the scroll b ox to a new location 
in the scroll bar. 
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\tll\ile s research scientist at the Xerox Falo Alto Research Center 

or experien.ce in Uu.> use of computers . The g_oal was to create a ~ 
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Figure A.11 Moving a document behind a window 
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Windo·ws are very fl exible. Their size and position can usually be 
determined by the user ra ther than being fi xed b y the ap plication. T his makes 
it possible to display more than one window a t a time on the Mac screen. T o 
move a window on the screen, simply drag the window's title bar. That is, 
point to the title bar , d epress the mouse button, and then roll the mouse to a 
new location, releasing the mouse button when you've lined up the window 
outline where you \Vant it. When you release the mouse bu tton, the old 
window will b e erased and then reappear in the new loca tion. Using this 
technique, you can position two windows on the screen so that there is room 
for both. If one is too large or not large enough, yo u can change its size with the 
size box. 

Opening Windows 

In order to b e able to use an object such as an applica tion or a document, you 
must first open a window for tha t object. If you want to work with the contents 
of a disk and there is no w ind ow open on the desktop for that disk, then you 
must open it. T o open a disk, you first select the disk b y clicking the disk icon, 
and then choose the Open option from the File menu. Drag open the me1111 , 

and release the mouse button w hen the pointer is on the Open option. See 
Figure A.l2. 

Once a window for the disk is open, it is easy to selec t an application or a 
document within the disk and open it. An appli cation is a computer program, 
such as a word processor, a game, or a spreadsheet program. A document is a 
file of information tha t yo u create using an app lication. Macintosh documents 
are ver y clever in that each one knows what application mad e it. When you 
open a d ocument, the application you must use to work w ith the d ocument is 
automatically opened at the same time ( if it is on one of the d isks whose icons 
are on the d esktop ). 

You can easily open a d ocument in the same way you just opened the disk. 
Select a d ocument from the open disk window, and then choose Open from 
the File menu. Figure A.l 3 shows the Mac Write Sample .\ll emo being op ened . 
After you release the mouse button with the pointer on Open, MacWrite is 
loaded automa tically, along with the selected document, the Sample Memo 
(Figure A.l4 ). C lick the close box to get out of the Sample Memo. 

Using Open is only one way to open a window for an object. A shortcut is 
also available. Simply point to the object you w ant to op en and double-click. 



Figure A.12 Opening a window for a d isk 

Figure A.13 Opening a document 
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~ a Fi le Edit Search Format Font Style 

;;;o Sample Memo 

. '··'-•·!• ·t.. .. J? .... l. • .!; • 1, 13 •.. L • . I , ', t4 • . ._, I, 1 , J5, '-•-.!;•· ' •.. 16 •. 1... I ' · '·:J..· t7g 

~~ ~~El ~~~~ ': 
I 

Date july 16, 19M 
To Robert 
From: EllzaMUl I 
Re Finance Meeting Agen(la 

Here are my comments on your proposed agenda for the Ftnance 
group meeting next week 

I. Moving Date Let's v.ait aWhile Dts<.Usstng the moving datE> 
seems premature, since there are so many unknowns. 

. . 

Figure A.14 The opened document 

.;:: 

;:: 

T he double- click method can be used to open disks, applications, and 
documents. For example, point to the Sample Memo icon in the disk window 
no,v, and double- click it. Double- clicking is a much quicker way of opening a 
d ocument than first selecting and then using Open from the File menu. Even if 
an object has already b een selected , you can still double- click it to open it. 

In many applica tions, it is also possible to open documents from ·within the 
application. To do this, you first use the F ile menu to C lose the current 
document yo u are working on. Then select Open from the same menu. A list of 
the available documents w ill appear in a sm all scrollable w indow. You can 
select which document to open from this w indow by clicking the name of the 
document you want and then clicking the Open box that appears next to the 
window of na mes (Figure A.l 5) . To open a d ocument more quickly, you can 
simply double-click the name. 
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Figure A.15 Opening a document fro m within an application 

Closing Windows 

Just as there are two ways of opening windows-using Open or double
clicking-so there are also two '"'ays of closing windows. Again, one is easier 
than the other. The hard way, which still isn't very hard, is to pull d own the File 
menu and choose C lose (Figure A.l6). C hoosing this command closes the 
currently active window. You can always tell which window is currently 
active by the title bar. The window that has the band of tight horizontal lines 
on either side of its title at the top of the w indow is the active one . . one of the 
other windows can overlap the active window, except for pull-dovvn menus. 

The easier way to close the currently active w indow is to click its close box 
in the upper left corner (Figure A.l7). Try both methods for closing your disk 
window now. 
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Figure A.16 Closing the disk window from the File menu 

" File Edit Uiew Special 

Figure A.17 Closing the disk window with its close box 
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DIALOG BOXES 

D IALOG BOXES are special temporary windows that appear on top of other 
windows to present choices to the user. Double-click the Sample Memo 
document to get in to MacWrite with the Sample Memo text. Add one line at 
the beginning of the memo by positioning the insertion point there-put the !
beam pointer there and cl ick-and typing the Return key. Now click the close 
box in the Sample Memo title bar. The window that appears, asking whether 
to "Save changes before closing" is a dialog box (Figure A.l8 ). 

Three choices are presented in this box, and you must pick one of them. 
None of the normal commands is available until you make one of the choices in 
the dialog box. In this box," Yes" causes your revised version of the d ocument 
(with the extra line at the beginning) to be saved in place of the old version. 
"No" closes the document, leaving the previously saved version intac t. 
"Cancel" means that you want to cancel your previous command, namely, to 
close the window. If you choose this option, you will be able to go on editing 
the Sample Memo. 

The user picks one of the three options by pointing and clicking one of 
them. As an alternative, the defau lt choice- the one that has a double-walled 
box around it-can be selected simply by typing the Return key. Typing 
Return, in this case, would select "Yes" and would save the change. For now, 
though, just select "No"-point to and click the "No" box. 

Some dialog boxes ask you to enter or ed it some words in addition to 
choosing among boxed options. To see an example of this, choose the New 
option from the File menu in Mac\Vrite. You now can enter some text in a 
MacWrite document window entitled "U ntitled." Enter a word or two of 
blather, and then click the close box. You will again be presented with the 
MacWrite dialog box that asks whether you want to save your changes, as in 
Figure A.l9. C hoose "Yes" this time. r\ ow a new dialog box appears (Figure 
A.20). This one wants you to type a name for the new document. A vertical bar 
at the b eginning of the little input window-the rectangle just below the" Save 
current document as"-marks the insertion point. As soon as you type a bit 
here, the dialog box activates the Save option, which was previously dimmed 
(Figure A.21) . Now that your blather has a name, it can be saved as a new 
document. Alternatively, you can choose to eject the disk in order to store 
BLATHER on some other disk. For now, un less yo u've developed a great 
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Sample Memo 

' 

j 
Soue thongl's- before t lo sing? 

1( Ves )1 
[J, ~~~~'~ 
T. ( No ~~..] Cancel 
Fr ~ 

Finance Meetmg Agenc!a 

Here ar'i' my comm0\1nts on your proposed agenda for the Finance 
group meeUng next we91< 

Movmg Date· Let's ..... r-ut awhtle Dtscussing the moving date 

Figure A.18 A MacWrite dialog box 

fondness for the blather you typed in, just click the "Cancel" box and proceed 
to get out of the application without saving the text, as you did before. 

You will frequently encounter d ialog boxes in your use of Macintosh 
applications. When they appear, you will usually have to make some choice 
before you can p roceed. 

KEYBOARD COMMANDS 

The standard way of issuing commands is by means of the pull -down menus. 
As you've seen already, however, there are shortcuts to the pull-down menus. 
Double-clicking an icon is a shortcut to choosing the Open command from the 
File menu. Clicking the close box is a shortcut to close a window. 
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Figure A.19 The "Save Changes" dialog box 
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Figure A.20 The "Save As" dialog box 
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Figure A.21 The "Save as BLATHER" dia log box 

There are keyboard shortcuts for many other menu commands. Key
board commands require that you type some le tter tvhile holding down the 
Command k ey. The Command key is the one with the clover- like symbol on 
it, just to the left of the spacebar. T o issue a command from the keyboard, you 
hold this key down like a Shift key and type another key. It won't take you long 
to learn the most common keys, and a littl e effort now will repay you in time 
savings later. While it is possible to get b y using the pull-down menus, you 
might as well learn the keyboard commands too. 

Most of the keyboard commands are easy to remember. In the File m enu 
( Figure A.22) , Command-O will duplicate a selected item; Command-I will 
bring up an information window about a selected ite m; and Command-E will 
ejec t the disk if it is the currently selec ted item . In the Edit menu (Figure A .23 ), 
Command-C \Viii copy the currently selec ted item to the Clipboard. The 
CuPBOARD is a part of memory reserved as a special buffer for moving 
information be h-vcen applications or documents, or even from one part of a 
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Close 
Close All 

font f•iov•r 

Figure A.22 The File menu keyboard commands 

document to another. The Copy command d oes not copy information directly 
to its final destination. It just puts the informa tion to b e transported onto the 
cli pboard. T he cl ipboard is only a temporary buffer. When your lvl ac is turned 
off, whatever is on the clipboard is w iped ou t. 

Command-X is an instruction to cut the selected material. If you are 
imaginative, you might think of an X as having a shape like an open pair of 
scissors. Whatever is cut is deleted from its current position, and a copy is 
placed on the clipboard so that it can be pasted in elsewhere. 

Some of the editing commands, such as Command-V for Paste, are a bit 
harder to remember. Command-V pastes the contents of the clipboard at the 
currently selected locati on. Perhaps the letter V is meant to remind us of a 
caret ( A ), which is used in proofreading to ma rk an insertion point. Users of 
the WordS tar word processing program are already familiar w ith the use ofV 
for pasting. 



Multiple Selects 299 

MULTIPLE SELECTS 

It is often useful to be able to select more than one objec t at a time. Sometimes 
you want to print more than one document. At other times you want to copy 
more than one document or applica tion to another disk. 

There are two ways to select mu ltiple objects. If the objects to be selec ted 
are contiguous, you can just drag a box over the area that contains the fil es. In 
Figure A.24 , three applications were all selected by dragging the mouse from a 
point just above and to the left of the tvlac\.Vrite icon down to a point just to the 
right and below the Font Mover icon. All three could now be simultaneously 
removed, for example, b y dragging any one of them down to the trash icon. 

Suppose you want to select two or more items that are not contiguous. 
Dragging a selection rec tangle over the items would include some items that 
are not desired . H ere a different me thod can be used, shift-clicking. To select 
more than one item using shift-click, for every item to be selected after the 

r 
Uiew Spetial 

Figure A.23 The Edit menu keyboard commands 
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, 

Figure A.24 Selecting contiguous items 

first you must hold down one of the shift keys while you point to the item and 
click the mouse button (F igure A.25). Shi ft-clicking makes it possible to selec t 
two or more items separated by items you don't want to select. In this example, 
the MacWrite application and the Sample Ylemo document have been 
selected b y shi ft-clicking. T hey can now be dragged as a unit. Give it a try. 

If you type Command-1-for information-with these two objects 
selected, two information windows will open up on your screen, one for each 
of the selected objects (Figure A.26). C lick the close box on the top window, 
and it w ill close up, revealing the second information window below (Figure 
A.27). 

MANIPULATING WINDOWS 

Almost everything you see on the Macintosh screen is presented in a window. 
Windows p rovide a very fl exible approach to the presentation of informati on. 
Most windows can be manipulated in a variety of ways. You can change a 
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Figure A.25 Selecting separated objects 

Sample Memo 

Kind: MocWrite docum ent 

Size: 2737 bytes, accounts for 3K on disk 

Where : Wri te/ Paint, internal driue 

Cr ea ted: Tuesday, January 24, 1984 ot I 0:30 AM 

Modified: Tuesdoy, Jonu ory 24, 1984 ot 10:30 AM 

0 Locked 

The MacWrite tutorio l uses this mem o to teach bosic 
word proce~~ing s kill~. 

Figure A.26 Multiple information windows 
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Scrolling 

MacWrite 

Kind: application 

Size: 53248 bytes, accounts for 53K on disk 

Where: Write / Point, internal driue 

Created: Tuesday, January 24, 1984 at 10:05 AM 
Modified: Tuesday, January 24, 1984 at 5:33 PM 

0 Lo cked 

~he Macintosh word processor. 

Figure A.27 The next information window 

window's size, its location on the screen, and which part of its document it 
presents. 

Most windows have a Size Box in their lower right corner. By dragging 
this b ox, you can move the window's right and bottom edges, making it 
smaller or larger (Figure A.28). Try dragging the size box of your disk windo·w 
up and to the left to make the window smaller. Point to the size box, hold the 
mouse button down, and ro ll the mouse pointer up and left. A set of dotted
line window borders shows the new window size. When it looks right, release 
the button. The w indow now has a new size (Figure A.29 ). 

When a disk window is not large enough to show all the information that is 
available to you, you can use scrolling methods to get to the info rmation you 
want. Recall the image of the information as a parchment scroll. To see 
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Figure A.28 Dragging a window's size box 

Figure A.29 The smaller disk window 
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something not currently in the window, one should scroll the document 
underneath the window. This is made possible on the .\!t ac through Scroll Bars. 
A ScnOLL BAn is either a horizontal bar at the b ottom of the window or a 
vertical bar a t the right. The scroll bars represent the length of a d ocument . If a 
scroll bar of an active window is white, the entire document is displayed in the 
w indow. If the scroll bar is gray, then the window is currently displaying only 
part of the in formation available. You can use the scroll bar to sec more. 

Move yo ur mouse pointer to the area of the vertical scroll bar just below 
the white Scroll Box on the right of the small disk window now open. C lick the 
Scroll Bar here, and observe that the window scrolls to the next windowful 
b elow (Figure A.30). 

You can also use the scroll bar to scroll the window just a little bit at a time. 
Point a t the rightward-pointing arrow a t the right of the horizontal scroll bar, 
a t the bottom of the d isk windovv. C lick here, and note that the window moves 
the displayed d irectory just a bit to the right, rather than by a whole windowful 
(Figure A.31 ). You can also move the window part of the way through the 

Figure A.30 Clicking the Scroll Bar 
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Figure A.31 Clicking a scroll arrow 

information, by dragging the scroll box. The length of a scroll bar represents 
the length of the information. If yo u want to display something abo ut halfway 
through, d rag a scro ll box to the halfway p oint of the scroll b ar. 

Play around with scroll bars until you are comfortable with them. You 
won't damage yo ur doc uments by experimenting with scroll bars. 

Moving Windows 

You can put w indows an yw here you -.vant them on the screen by dragging 
their T itl e Bars. Simply point to a w indow's title bar, hold d own the mouse 
button, and roll to a new location (Figure A.32). As yo u drag the window, its 
outline moves to the new position. When you release the button, the w indow 
appears in the new location on the screen ( Figure A.33) . If yo u start to drag a 
window and change your mind, it isn't necessary to try to carefull y reposition 
the rectangula r outline back over the window. Instead, just p ush the po inter up 
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Figure A.32 Dragging a window 

in to the menu b ar a t the top of the screen. Windows can' t b e moved up to 
obscure the menu b ar, so if you release the button here, the window will just 
stay in its original position. 

Overlapping Windows 

When several windows arc on the screen, they some times overlap each other 
and part of the information is obscured (Figure A.34 ). T o see an example of 
overlapping windows, choose the Calculator option from the Apple menu. As 
the currentl y active w indow, it will res t on top of the other w indows in the 
same screen area. In o rd er to make a window active, and thus make it overlap 
the others, a ll you have to d o is click somewhere in the visible part of the 
partia lly obscured window ( Figure A.35). Do this to the overlapped disk 
window, and it w ill pa r'lia ll y obscure the calculator. 
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Figure A.33 The relocated disk window 
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Figure A.34 Overlapping windows 
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.J File Edit Uiew Special 
., 

Figure A.35 Making the disk window overlap the calculator 

If you want to move a window that is partiall y overlapped by another 
window, yo u can do so without makin g that window the ac tive window. 
Simply hold d own the Command key while you drag the partially obscured 
window by its title bar. The window will move w ithout coming to the fore and 
obscuring any part of the active window. 

You use the same mouse skills-pointing, clicking, shift-clicking, double 
clicking, and dragging-in all your work with the Mac. 

PROBLEMS AND TECHNIQUES 

Ejecting a Disk 

New Mac users sometimes get the impression that the keyboard commands 
don't always work . For example, Eject seems to work only some of the time 
for them. Be fore a disk can be ejected, it must be the currently selected item. 
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Pay attention to the appearance of the disk icon, which is d ark when it is 
selec ted. If some object in the disk directory window, such as a document or 
ap plication, is currently selected, then the disk icon will be w hite and the disk 
can't be selected . C hange the selection to the disk by clicking in the directory 
window, not pointing to any of the disk contents. Alternatively, you can click 
the disk icon itself. The icon w ill now be dark, and you should be able to ejec t 
it. 

The Programmer's Switch 

Everyb od y makes mistakes, and sometimes the only way to restart is to make 
the Mac HE BOOT-start up all over again, just as it does when you turn it on. F or 
example, if you turn on your Macintosh and insert a non-system disk, the Mac 
will spit the disk back out and the screen w ill show a sick Mac (Figure A.36) . 
You can now insert a good boot disk, but the M ac won't do anything. The only 
way to get going again, if you d on' t have the programmer's switch installed, is 
to turn the computer off w ith the power switch in the back, then turn it on 
again . This is fine for every once in a while, but turning comp uters on and off is 
hard on them. Leave the Mac running if you plan to come back to it in a few 

Figure A.36 A Moe unhappy with its boot disk 
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hours. If you have the programmer's switch installed, you can use the Reset 
button to make the Mac reboot without turning the machine off and on. 

Invisible Icons 

Some users find that after they try to drag document icons to the trash the 
documents are not always thrown away. T hey no longer appear in the disk 
window, but the disk space available doesn't change, and when they eject the 
disk they see the documents appear for a second on the d esktop. What's going 
on? 

These d ocuments didn't quite make it to the trash. Instead , they were 
somehow misplaced under your disk window. Try dragging the window to 
one side to see whether you have some d ocuments stranded on your desktop 
(Figure A.37) . After you find them in this way, you can drag them to the trash 
or put them back in the disk directory. Remember that it is the position of the 
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Figure A.37 Documents stranded on the desktop 
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Figure A.38 Dragging Into the trash window 

pointer's h ot spot- the tip of the slanted arrow- tha t d etermines what you are 
pointing at w hen you release the mouse b utton. Make sure it p oints inside the 
trash icon when you are throwing something away. You know you're on target 
when the trash icon turns black, showing that it is currently selected. 

D ragging Accurately 

Not everyone fi nds using the mouse completely na tural. Try to pay attention 
to where the mouse pointer is located when you release the mouse bu tton 
when you fi nish d ragging. It is the position of the pointer, not the outline of the 
dragged object, that determines the destination. If you are still having trouble, 
try to make larger targets for the destina tions of your drags.lf you want to put 
something in the trash, first do uble-click the trash icon to open a trash w ind ow 
(Figure A.38 ). Then you can drag items from a disk window into the trash 
window, w hich is a lot easier to hit with the pointer than the trash icon itself. 
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Room for Mouse Moves 

Some users find that operations that call for mouse movements are difficult 
because there isn't much free space on their desks . A common error is starting 
over when the mouse runs up against an obstacle. Suppose you start to drag 
something and your hand runs up against some object in your path. Just keep 
the mouse button depressed and lift the mouse up in the air. Move it back in the 
direction you came from, set it back on your d esk, and continue rolling it in the 
direction of the drag. It may take a few attempts to get used to picking up the 
mouse while keeping the button held down, but you'll find you can do it easily 
with practice. 
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Add another function, 165 
Add New Records option, 2.57 
Alarm C lock option, 284, 286 
Align Center (Middle) option, 23, 84 
Alphabets, foreign, 50-51 
APlus, 269 
Appearance, control of, 150. See also Fonts; 

Formatting 
Apple, 12 

languages, 261. See also specific languages 
Apple Bus System, 209-211 
Apple Collection, 274 
AppleLine, 196, 199, 200 
Apple Macintosh, 2-10 
Apple menu, 7, 284, 306 
Apple Pascal operating system, 202. See also 

Macintosh Pascal 
Apple 32 system , 197 
Apple II, 5, 201, 202 
Apple lie, 210, 211 
Applications, 9-10, 2.57 

defined, 66 
pixel-oriented , 42 
word processing, 39-41. See also Word 

processing 
see also specific applications 

Archive disk. See Disks, archive 
Arrange menu, 222 
Art 

analysis, 160 
pattern, 217 
see also Drawing; Graphics 

Assembly language, 239, 242, 2.59 
Atkinson, Bill, 12 

Backup disks 
importance of, 69-71 
techniques, 72-77 

Backspace key, 44, 45, 47-48 
Bar, vertical, 134 
Bar Graph option, 106 
BASIC, 42, 240, 243, 259 

Macintosh, 261 
Microsoft , 239, 260 

Baud rates, 205-206 
Brush Mirrors option, 16 
Brush Shape option, 30 
Budget summary example, 99-103 
Byte, 43 

C language, 239, 259, 262-263 
Calculator, 7, 92 
Calendar option , 183, 306 
Cancel box, 294, 295 
Cash now, 188 
Central processing unit (CPU), 2, 4 
Change to Milestone option, 177 
Characters, special, 50-51 
Chart (Microsoft), 9, 12, 30, 104 

application, 111, 120, 122 
menus, 128, 188 
and Multiplan, 127-129 
project managing, 175 
references, 129 
size changes, 191-192 

Charting in Multiplan, 104-106, 127-129 
Charts, 110, 120-127 

with MacPaint, 31 
with Multiplan and Chart, 127- 129 
pic, 111- 119 
resizing, 122, 124 
resources on, 129 

C lear, 163 
ClickArt, 215, 216 
Clicking, 277, 278. See also Double-clicking 
Clip art portfolio, 215, 217 
Clipboard, 23, 25, 26, 264, 297 

in charting, 27, 129 
Macintosh, 8 
using, 46-47 

Close box, 280, 281, 291 , 292, 293, 300 
Close option, 47, 57, 291, 292 
Club Mac, 270 
Color (Mac), 275 
Column width option, 86, 87 
Command ke)'S, 49-50, 65, 84 

equivalents, 256 
Multiplan, 107, 108 

Command-A, 124 
Command-B. 49 
Command-Backspace, 48, 231, 233 
Command-C. 26, 46, 88, 142, 297 
Command-O, 53, 93, 178, 297 
Command-E, 297 
Command-F. 84, 106 
Command-G. 84, 90 
Command-H. 83, 84 
Command-1, 49, 76, 297, 300 
Command -L, 135 



Command-M, 177 
Command-R, 84, 135 
Command-Shift-4, 79 
Command-U, 50 
Command-V, 26, 47, 142, 298 
Command-X, 46, 88, 136, 180, 298 
Commands, keyboard, 25, 61, 86, 87, 295-298 
Commas option, 91 
Comments, 245 
Communication 

electronic, starting, 197- 199 
methods 

local area network (LAN), 195, 196-197, 
209-211 

local serial connect, 195, 196 
micro-floppy disk, 195, 196 
telephone connection, 195, 196, 197, 199, 208 

types, 212 
Communications ... command, 206 
Compiler, 243 
Computer-to-computer communication, 194-212 
Computers, desktop, 4 
Concepts-The Magazine, 43 
Control Panel accessory, 279, 280 
Copy option, 25, 26, 46-48, 53, 142, 298 
CoreEdit, 44 
Corvus, 73, 268 
CP/M operating system, 203 
CPU. See Central processing unit 
Critical path, 176, 187 
Custom Rulers ... option, 222 
Cut option, 25, 46-48, 136 

Data disk, 27, 36 
Data menu, 111 , 117 
Data form, 167, 170 
Data series, 111 
Dates menu, 183, 184 
DaVinci Graphics Packages, 215, 217 
DB Master, 257-259 
Definition form, 165, 167. 168 
Delete 

Backspace key, 47-48 
Cut, 47-48 

Desktop Accessories, 6-7, 256, 284 
Desktop Accessory Calculator, 92 
Dial option, 208 
Dialog boxes, 56, 72, 75,111,113,256,257,294-295 

Cancel, 294-299 
communications, 206, 207 
customs rulers, 222, 225 
drawing size, 221 
footnotes, 235 
Format Values, 114, 115 
phone, 208 
print setup options, 140, 143 
Save As, 296, 297 
Save changes, 296 
Set Report format, 259 
terminal settings, 206, 207 
text options, 124, 125 
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Digital Equipment Corporation (DEC) VT100 
terminal, 200, 201 

Digitizer, Thunderware, 215 
Digitizers, video, 214-215, 272 
Digitizing tablet, 214, 272 
Directories 

disk, 64-67, 268 
mini, 78 
printed, 78-79 

Disaster, 59-61 
recovering from, 36-37 

Disk copying, 71-72 
Disk directory, 64-67, 268 

damaged, 65 
views of, 68-69 
window, 84 

Disk drives, 4 
hard, 209-212, 231 

Disks 
archive, 78 
backup application, 69-77 
boot, 65, 75, 76 
data, 27, 36 
document storage, 73, 74 
ejection, 308-309 
floppy, 4, 70, 71 
hard, 69, 71, 270-271 
hard upgrade, 266-269 
managing, 62-79 
micro-floppy, 71, 73, 195, 196 
mini-floppy, 63 
working application, 73, 77 
Write/Paint, 35, 280 

Documents 
archiving, 103 
defined, 66 
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Documents, continued 
editing with Word, 236 
long, 43, 234 
making room for, 35-36 
multiple, 37-38 
opening, 289-290, 292 
short, 43 
transferring material between, 23-26 
wide, 234 

Dollar option, 91, 92 
Dot matrix printers, 40, 271, 272 
Double-clicking, 65, 277, 279, 291 
Dragging, 277, 279, 286, 299 

accurate, 311 
with formulas, 93-94 
outline heading, 139-140 
to select, 45, 58-59, 127 
size handles, 124- 125 

Drawing, 7-8, 11-38 
menu, 248, 254 
with mouse, 15 
technical, 31, 32 

Drawing files, 147, 149, 161-173 
DTACKCROUNDED.~O 
Dummy text documents, 5.'3-55 
Duplicate option, 53, 178, 179 

Edit menu, 16, 19, 25, 30, 231, 233, 256, 297, 299 
Edit Pattern option, 217 
Editing, 43- 45, 111 
Element, 163, 165 
Enlarge option, 226 
Eject, 268, 308 
Equal(=) symbol, 91, 92, 93, 99 
Errors, 36, 250-251 

Fat Bits, 14, 18, 21 
shortcuts, 27-29 

Fat Mac, 263, 268 
Fields, 154, 166 
File menu, 27, 37,118,150,280,282,283,289,291, 

292, 298 
File Server systems, 209 
File transfer process, 202-205 
Files, 63-64 

drawing. See Drawing files 
sharing, 210 

stored pictures, 147 
sy·stem, 66 

Filevision (Telos), 9, 12-14, 71, 218, 220 
draw ing files, 161- 173 
features, 147- 150 
menus, 147, 150, 151 
printing lists, 154- 157 
range of uses, 157-161 
Symbol Edition, 163-167 

Fill Down option, 99 
Fill Right option, 84 
Filled Rectangle tool, 30, 33 
Filled Rounded Rectangle tool, 23 
Fill-in Oval tool, 20 
FillOval option, 249 
Financial statements, 80, 106, 108 
FingerTip Software, 217 
500 Menu Pallems, 217 
Flat Mac, 274 
Floppy disks. See Disks, floppy 
Floppy drive, second, 271 
Folders, 52, 53, 66-69, 73 
Footers, 48, 53 
Footnotes, automatic, 235, 236 
Footprint , 4 
Font !\•lover application, 52, 65-66 
Fonts 

Cairo, 12, 217-218, 219 
changes, 49, 124, 127, 245 
menu, 177 
Monaco, 131, 134 
removing, 52 
sizes and styles, 40-41, 49-50, 134, 142, 177 

FontSize menu, 131 
Foreign alphabets, 50-51 
Form le tters, 229 
Format changes, 48 
Format menu, 56-57, 84, 106, 124 
Format window, 111 
Formatting, 111, 154-156, 235 
Forms, creating with MacPaint, 34 
Formula bar, 92, 93 
Formulas in Multiplan, 91-99, 103- 104, 105 
FORTRAN, 239, 259, 261 
FrameRect, 249 
Freehand Line tool, 163 
Fully-formed character printers, 271-272 

Callery menu, 114, 116, 122 



Games, 5, 12, 13 
George Graphics, 38 
Get Info, 76 
Glossar>' option, 231, 233 
Goodies menu, 16, 18, 30, 31 
Graphics, 11-38 

peripherals, 272 
services, 214-217 
with word processing, 217-218 
invisible, 177 

Group option, 222 

Halt option, 247 
Handles, 124- 125, 147 
Hard ware, 2-4 
Headers, 48, 53 
Hide These option, 150, 152 
Highlight Some option, 152, 153, 171 
Highlighting, 150- 154, 157 

1-beam pointer, 44, 45, 47, 277, 294 
IBM mainframe computer, 196, 199 
1MB PC, 202, 204, 210 
!CONCEPTS, 270 
Icons, 16, 68-69, 72, 131, 163, 270, 310-311 
Illustrations, intelligent, 158-159 
Imagewriter printer , 8, 40 , 227, 271 
Information, 63, 149, 300-303 

exchange, 195, 197, 212. See also Computer-to
computer communication 

manipulation, 150-154 
ln foWo rld, 43, 81, 269 
Insert Ruler , 48 
Insertion point, 44-45, 134-136 
Instant menu, 248, 249 
Inverse video, 45, 46, 58-59, 284 

Jazz (Lotus), 264, 265 
Justification, 57-58, 84 

Key Caps, 51 
Koala Video Digitizer, 214 

Laser printer, 8, 40, 227, 271-272 
Lasso tool, 20 

Layout menu, 177, 222 
Letterhead text, 53, 54, 55 
Link func tion, 171, 172, 265 
LISP, 239, 240, 259, 262 
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List-formatting options (Filevision) , 154, 156 
Lists, p rinting, 154-157 
Local area network (LAN), 195, 196-197, 209-211 
Local serial connect, 195, 196 
Logo, 239, 243, 259, 262 

~lacBASIC, 239 
MacCats ... 99 W ays to Paint a Cat with 

MacPaint (Flanagan), 38 
Mac Daisywheel Connection, 227 
MacDraw, 9, 12, 14, 149, 218-226 

menu, 228 
p roject managing, 175 

MacDrive (Tecmar), 73, 212 
!vlacForth , 239, 259, 261 
Macintosh 

accessories and paraphernalia, 269- 274 
clubs, 270 
future tren ds, 274-275 
graphics, 11 -38 
operating system, 63 
upgrading , 263-269 

Macinto sh Pascal, 9, 42, 239-240, 244 
programming w ith, 238-254 
reserved words, 245 

Macintosh techniques, 308-312 
MACpac, 227 
MacPaint, 7-8, 12- 14, 16,25- 26, 27, 28, 42, 73 , 147, 

149, 175, 218, 220, 268 
aids to use, 38, 214- 217 
menus, 17 
problems, 30-38 
shortcuts, 27-30 
techniq ues, 15- 23, 30-38 

MacPascal. See Macintosh Pascal 
MacProject, 9, 143, 175-188 

menus, 178, 180 
MacProject schedule, 188-192 
Mac the Knife, 215 
MacTEP, 197, 260 
MacTerminal, 9, 197, 200-205 

customizing, 205-208 
menus, 201 

MacWork/ MacPlay (Poole), 38 
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Mac\Vorld, 43, 217, 269 
Mac Write, 6-8, 12, 42-53, 230, 231 

aids to use, 226-229 
menus, 60, 61 
techniq ues, 51- 61 

Magazines, 269. See also individual titles 
Mail, electronic, 210 
Mail merge func tion, 265 
Mailing labels, 147, 158 
Maps, 147-148, 160- 161 

intelligent , 157- 158 
Mathematical characters, 50 
McPic, 215 
~lcdia and supplies, 273 
Mega~1erge, 229, 237 
Memo writi ng, 8 
Memory, 4, 257, 263, 256-266. See also Handorn 

access memory (RAM}; Head-only 
memory (ROM } 

Menus, 283-286. See also specific menus and 
applications 

Micron Eye Video Digitizer, 214 
Microsoft , 12, 43, 111. See also C hart; Word 
Milestone, 177 
Minus sign, 131, 135 
l'vlodcm, 196, 199, 273 
1\lodem7 option, 204, 205 
Modula-2 language, 239, 259, 262 
Mouse, 3, 312 

drawing with, 15, 29, 214 
in formula writing, 81 
moving objects with, 147, 149 
selecting objects with, 84, 86 
see also 1\louse pointer; ~l ouse skills 

Mouse pointer, 3, 277- 278, 311 
shape, 44, 84 , 277 

Mouse skills, 276-312 
clicking, 277, 278 
double-clicking , 277, 279 
dragging, 277, 279 
pointing, 277-278 
shift-clicking, 277, 279 

Multip lan, 9 , 73, 81- 108, 127- 129, 175 
books on, 108 
command keys, 107, 108 
Disk Director)' , 84 
word p rocessing, 229, 230 

Multiplan Models for Business (Cobb. Cobb, 
Henderson ), 108 

Multip lication sign ( • ), 92 

:-Jew option, 294 
Newsletters, 270 
:-Jote Pad option, 200, 271 

"OK" button, 117 
O mninct (Corvus) , 209-211, 268, 269 
Open option, 47, 57, 65, 67, 269, 289. 291, 295 
Option key, 51, 65 
Option-key combination, 51 
Outlines, 131- 140 

printing, 140- 141 
in text documents, 142- 143 

Paintbrush tool, 15 , 16, 30 
Pascal, 9, 12 

American National Standard (ANS}, 239, 240 
UCSD, 239 
see alsu Macintosh Pasca l 

Paste option, 25, 26, 47, 48, 53, 57, 89, 137, 142, 
298 

Pattern art , 217 
Pattern menu, 23, 30 
Pause menu, 247 
Pen plotter, 272 
Pencil tool, 27-29 
Percent option, 90 
Peripheral equipment , 270-274 
Phone option, 208 
Pictorial d nta bases. See Filevision 
Pie charts, 111- 119 
Pixels, 5, 14 
Plot Series box, 117, 118 
Plus sign, 131, 135 
Power of Multiplan, Tl1e (Williams), 108 
Presentation Graphics on the Apple Macintosh 

(Lambert), 129 
Print Catalog option, 27, 79 
Print Draft mode, 38 
Print Final mode, 37-38 
Print In fo options, 154, 156 
Print Labels option, 158 
Print nwrging, 237 
Print option, 37, 55-56,57, 118, 140, 142 
Print server, 210-211 
Print buffer. 227 
Printers. See Full)•-formed character printers; 

lmngcwriter; Lnser printer 
Printing, 8, 37-38, 55- 56, 154- 157 
Progrnmming. 240-242, 2-15-254 



Programming languages, 238-254, 259- 263 
Project managing, 174-193 
Project Table option, 191 
Protocol converte r, 196, 19B, 200 
PTc rm program, 202, 203 
Pull-down me nus, 256, 284, 285, 286 

Q uickdraw, 12-13 

R:\1\1. See Handorn access me mory 
Random access me m ory (RAM) , 2, 43, 6 1, 63,256, 

257. 266 
Read-on ly me mory (ROM ), 2-4, 65, 256 
Hebooting, 309-3 LO 
Hectang lc, 177. 178, 181 

rounded. 177, 220 
Reduce option, 226, 227 
Hepcat unt il s truc ture. 245 
Reserved words (Pascal), 245 
Reset key, 75 , 310 
Hesourec cos t, 188 
Resource T imcline option, 188, 189, 191 
Restore optio n, 35 
1\e turn ke)' , 86, 131, 294 
ROivl. See Read-only me mory 
Ro tate option. 30 
Rulers, 48 
Hun menu, 250 

Save As o ption, 35, 54. 117, 203,205 
Save option , .57, 59, 61, 294 
Scatter Plot option, 122 
Schedule charts. 175- 188 
Scrapbook option, 6, 200 , 271 
Screen projection S)'Stc m, 272 
Scroll areas, 137, 138 
Scroll bar, 88, 179, 220. 286, 287, 304 
Scroll box, 287, 304 , 305 
Scrolling , 29, 2.'31, ~02-305 
Search optio n, 139, 141 
Select All m e nu, 124 
Selecting, 45, 47 , 84-86, 182, 280-283, 299-300 

accidental, 58- 59 
Send File option. 202 
Settings menu, 206, 208 
Shi ft-clic king, 47, 277, 279, 299, 300 
Shift-dragging, 182 

Shift-Return, 86 
Shift-Tab , 86 
Size box, 302, 303 
Size handles, 124-125 
SmartCable, 198. 199 
Software, 2-4 
Sort option, 139 
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Speed e nhancement, 264-265, 268, 269 
Spilling Paint Can tool, 20 
Spread sheets , 80-108 
Stepwise refine ment technique, 250- 251, 254 
S ty le m enu, 177 
SU~·I funct ion, 93 , 94 
Symbol tool, 163, 165 
Symbols, special, 50-51 

Tah key, 48-49, 84, 86. 185, 229 
Tasks, 177- 180, 184-187, 189 
Task Info window, 184-185 
T elephone connect, 195, 196, 197 , 199, 208 
T elos Soft ware Products, 12, 147 
T e rminal Settings option, 206, 207 
Text, 40-42, 53-55, 56-58 

accidental selection, 58-59 
dummy, 53-55 
moving. 57 
selected, 45- 46 
sty les a nd sizes, 8, 35 

Text O nly button, 203 
T ext optio n, 111, 117, 124 
Text tool, 23, 163, 165 
Text transfer method, 205 
ThinkTank, 9, 74, 128, 131-140, 143-145, 175, 

263- 264, 265, 512 
ThinkTa nk Extra menu, 139 
Time-sharing system, 204-205, 206 
Tinker menu , 150, 170, 171 
Title boxes, 23, 25 
T ools me nu, 18 
Transferring material, 23-26 
T ypesetting, 40 

Undo, 30, 35 
Ungroup option, 222 
UN IX operating system, 263 
U nselect ing, 280- 283 
Untab , 48 
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User interface, 2, -1 
nonstandard , 10 
standard, 256-259 

Video d igitizer, 214-215, 272 
View menu, 68 
Voice peripherals, 272 

Windowing, 6, 8 
Windows, 6, 29-30, 68, 134 , 167, 286-289, 

301-308 

closing, 292-293 
directory, 56, 65, 66, 84 
menu, 248 
moving, 302-306 
opening, 289-291 

Word (Mic rosoft) , 9, 43, 71, 229-237 
mem1s, 232 

Word processing 
applications, 39-61 
and graphics, 12, 217-218 
with ~1 ult iplan, 229 
with Work, 229-237 

Write/Pa int disk, 35, 280 
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